ArcGIS® 9

Using ArcCatalog™
Contents

1 Introducing ArcCatalog  1
   What can you do with ArcCatalog?  2
   Tips on learning ArcCatalog  6

2 Quick-start tutorial  7
   Exercise 1: Building a catalog of geographic data  8
   Exercise 2: Exploring data and adding it to a map  12
   Exercise 3: Managing shapefiles  29

3 Catalog basics  37
   Starting ArcCatalog  38
   The ArcCatalog window  39
   Browsing through the Catalog  40
   Repositioning the Catalog tree  43
   Getting help  45
   Stopping ArcCatalog  49

4 What's in the Catalog?  51
   Folders and file types  52
   Maps, layers, and graphs  53
   Shapefiles, dBASE tables, and text files  54
   Coverages and INFO tables  55
   Geodatabases  56
   Raster data  58
   TIN datasets  60
   CAD drawings  61
   VPF data  62
   SDC data  63
   XML documents  64
   Address locators  65
   ArcIMS servers  66
   ArcGIS servers  67
5 Building the Catalog  71
   Adding folder connections  72
   Adding spatial database connections  73
   Adding OLE DB connections  75
   Working with database connections  76
   Connecting to GIS servers  78
   Hiding folders and items  81
   Changing a data format’s properties  82
   Adding file types  84

5 Managing the Catalog’s contents  87
   Viewing an item’s contents  88
   Working in Details view  90
   Changing the columns you see  92
   Exploring an item’s properties  95
   Organizing your data  96
   Converting data to a different format  98

7 Exploring an item’s geography  99
   Previewing an item’s geographic data  100
   Exploring geographic data  103
   Creating thumbnails  106

8 Exploring the values in a table  107
   Previewing the values in a table  108
   Changing how tables look  109
   Calculating statistics  113
   Sorting records in a table  114
Finding values in a table  116
Adding and deleting columns  118
Creating new data sources from the values in a table  120

9  Working with metadata  123
Exploring an item’s metadata  124
Changing the default stylesheet  127
Creating and updating metadata  128
Importing and exporting metadata  130
Writing documentation  132
Editing metadata  134
Using the FGDC metadata editor  135
Using the ISO metadata editor  137
Adding enclosures  138
Requirements for publishing to an ArcIMS Metadata Service  140
Preparing metadata for publication  144
Publishing to an ArcIMS Metadata Service  149
Managing published documents  150
Changing a published document’s properties  151

10 Searching for items  153
Searching for items  154
Searching with geographic criteria  156
Searching with temporal criteria  158
Searching with keywords  161
Exploring the results of your search  162
Modifying the search results  163

11 Working with maps and layers  165
Opening a map  166
Adding data to maps  167
12 Working with shapefiles  177
   Creating new shapefiles and dBASE tables  178
   Adding and deleting attributes  180
   Creating and updating indexes  182
   Defining a shapefile’s coordinate system  184

13 Working with coverages  191
   Creating a new coverage  192
   Creating a new INFO table  193
   Generating topology  194
   Defining a coverage’s coordinate system  196
   Modifying a coverage’s tics and extent  200
   Setting a coverage’s tolerances  203
   Maintaining attributes  204
   What is a relationship class?  210
   Creating a coverage relationship class  212

14 Working with rasters  215
   Raster dataset properties  216
   Exploring geodatabase raster catalogs  217
   Changing raster properties  220
   Choosing which raster dataset formats appear in ArcCatalog  221
   Defining a raster dataset’s coordinate system  223
   Creating raster dataset pyramids  227
   Creating raster dataset statistics  229
   Additional raster file information  230
15 Customizing ArcCatalog 233

Basic user interface elements 234
Customizing toolbars 235
Changing a toolbar’s contents 238
Changing a command’s appearance 243
Creating shortcut keys 246
Creating and running macros 248
Creating custom commands with VBA 251
Working with UIControls 253
Adding custom commands 254
Updating the ArcID module 255
Changing VBA security 256
Using the ArcObjects Developer Help system 257

Glossary 259

Index 283
In THIS CHAPTER

- What can you do with ArcCatalog?
- Tips on learning ArcCatalog

Welcome to ESRI® ArcCatalog™ software, which makes accessing and managing geographic data easy. First, you add connections to the geographic data you work with to the Catalog. You can connect to folders on local disks, to shared folders and databases that are available on the network, or to geographic information system (GIS) servers.

After building your Catalog, you can search for the data you need and explore the search results using the different views that are available. In ArcCatalog, you can work with all data the same way regardless of the format in which it is stored. Several tools are also available to help you organize and maintain your data. For a cartographer, it’s never been easier to ensure you’re adding the right data to your maps. And, whether you’re an analyst managing your personal data holdings or an administrator managing those of a large organization, ArcCatalog simplifies the job.
What can you do with ArcCatalog?

After connecting to a folder, database, or GIS server, you can browse through its contents with the Catalog. You can look for the map you want to print, draw a coverage or page using the values in a table, find out which coordinate system a raster uses, or read about why it was created. Accessing and using information in ArcCatalog is a simple process.

When you’ve found the data you want to use, add it to a map in ArcMap™ or analyze it using the tools in ArcToolbox™. You might find data that you don’t need any longer or that must be altered. The Catalog makes it easy to reorganize your data and modify its properties.

Browse for maps and data

Select a folder, database, or GIS server in the Catalog tree, then examine the list of geographic data it contains in the Contents tab. You can change the appearance of the Contents list using buttons on the Standard toolbar. Switch your view from large icons to small icons, or list properties and metadata for each item to help you decide which is the right one to use. Thumbnail view lists snapshots illustrating the geographic data contained in each item in the folder, database, or GIS server.

Explore the data

Thumbnails give you a quick look at the contents of an item, but you may want to check whether or not a specific feature in a coverage has been updated. Select an item that contains data in the Catalog tree, then examine its data using the Preview tab. Look at geographic data with Geography view. Buttons and tools on the Geography toolbar let you zoom and pan to explore the features in a computer-aided design (CAD) drawing, cells in a

Thumbnails provide an overview of data in the selected folder.

Explore an image before adding it to a map.
raster, or triangles in a *triangulated irregular network (TIN)*. The Identify tool lets you click a feature, cell, or triangle and see its attributes.

With Table view, you can see the attributes of a geographic data source or the contents of any table in a database such as inventory or billing data. Explore the table’s contents by rearranging its columns, sorting its rows using the values in one or more columns, or searching for specific values.

**View and create metadata**

Before deciding to use a data source in a map, you may need more information. In the Properties dialog box for a data source, you can find its coordinate system and the data type of each attribute. However, for information, such as why the data was created, the appropriate scale at which to use the data, a data accuracy report, or a description of what an attribute name means, you must look at its metadata.

**Metadata can help you decide whether or not to use the data.**

ArcCatalog comes with metadata editors that you can use to document your data. The Catalog will fill in as much information as it can using the data’s properties. When the data changes—for example, when a new attribute has been added—the next time you look at the metadata, the Catalog automatically updates it with the new information. Metadata is an integral part of the data and will follow when the data is copied or moved to a new location.
Search for maps and data

If you know something about the data you are looking for, but you don’t know where it is located, ArcCatalog can help. The Search tool will look on disks, in databases, and on GIS servers for data that satisfies your criteria.

You can search for specific data formats and for maps covering a defined geographic area. You might look for rasters that were published before a given date and that have less than 10 percent cloud cover. Your search is saved in the Catalog. As data is found that satisfies your criteria, shortcuts to those data sources are added to the search’s list of results. Later, you can modify the search’s criteria and run the search again.

The Search tool uses metadata to evaluate whether a data source satisfies your criteria. Having excellent documentation will be essential for people to be able to find the data they need using the Search tool. This is when metadata is especially important.

Use data in ArcMap and ArcToolbox

After finding the map you want to use, double-click it to open it in ArcMap. Add data to the map by dragging it from the Catalog—for example, dragging it from your search results and dropping it on the map. In addition to creating printed maps, ArcMap is where you go to edit geographic and tabular data.

Instead of adding the data to a map, you may want to convert the data you’ve found to a different format or buffer its contents. After opening a geoprocessing tool in ArcToolbox, you can drag the data source from the Catalog and drop it onto the tool. The Toolbox automatically fills in as many options in the tool as possible.

Manage data sources

After looking at the contents of a data source and reviewing its metadata, you might want to modify it to better suit your needs. You can manage the structure of a data source using the Properties dialog box. For example, the Properties dialog box can be

Add an attribute to a shapefile.
used to define a shapefile’s coordinate system, generate a coverage’s topology, or add an attribute to a table. You can also create a relationship class that defines the relationships between the features in coverages and attributes in INFO™ tables.

The Catalog makes it easy to organize your data. Delete a selected coverage by pressing the Delete key on your keyboard. Rename shapefiles and copy tables to another geodatabase just as you would rename and copy files with Windows® Explorer. ArcCatalog makes it easy to start consolidating your spatial data into a coherent library that’s distributed across the network.

If you’re a data administrator, the Catalog can help you create an environment in which geographic data can be easily used by everyone in your organization. Layers include a shortcut to the data and additional information such as symbology, percent transparency, queries that select specific features, and joins or relates that link attributes in external tables to the spatial data. You can create layers in ArcCatalog and place them in a shared folder on the network where everyone can access them. Others can add those layers to maps without having to know how to access the database, how to classify data, or even the format in which the data is stored.

Similarly, you can customize metadata in the Catalog to include information that’s specific to your organization such as whether or not new coverages have passed quality assurance tests. You can also customize how metadata is displayed so the right information is presented to the right people in your organization.

Overall, ArcCatalog will revolutionize how you do your work. It makes accessing and managing geographic data so easy that before long it will be a constant companion on your desktop.
Tips on learning ArcCatalog

This book introduces ArcCatalog and its capabilities. The topics covered assume you are familiar with the fundamentals of geographic information systems. If you’re new to GIS or feel you need to refresh your knowledge, please take some time to read Getting Started with ArcGIS, which you received in your software package. It may not be necessary to read it in its entirety before continuing, but you should use it as a reference if you encounter tasks with which you are unfamiliar.

You don’t have to know everything about the Catalog to get immediate results. To begin learning ArcCatalog, read Chapter 2, ‘Quick-start tutorial’; there you’ll see how easy it is to locate and manage your maps and data. ArcCatalog comes with the data used in the tutorial, so you can follow along at your computer. You can also read the tutorial without using your computer.

This book is designed so that when you have a question, you can get the answer quickly and complete your task. Although you can read this book from start to finish, you’ll likely use it more as a reference. When you need to know how to do a particular task, such as defining a shapefile’s coordinate system, look it up in the table of contents or index. You’ll find a concise, step-by-step description of how to complete the task. Some chapters also include detailed information that you can read if you want to learn more about the concepts behind the tasks. Refer to the glossary if you come across unfamiliar GIS terms.

Getting help on your computer

In addition to this book, the ArcCatalog online Help system is a valuable resource for learning how to use the software. To learn how to use the ArcGIS Desktop Help system on your computer, see ‘Getting help’ in Chapter 3, ‘Catalog basics’, of this book.

Contacting ESRI

If you need to contact ESRI for technical support, refer to ‘Contacting Technical Support’ in the ‘Getting more help’ section of the ArcGIS Desktop Help system. You can also visit ESRI on the Web at www.esri.com and support.esri.com for more information on ArcCatalog and ArcGIS.

ESRI education solutions

ESRI provides educational opportunities related to geographic information science, GIS applications, and technology. You can choose among instructor-led courses, Web-based courses, and self-study workbooks to find education solutions that fit your learning style. For more information, go to www.esri.com/education.
ArcCatalog lets you explore and manage your data. After connecting to your data, use the Catalog to explore its contents. When you find the data you want to use, you can add it to a map. Often, when you get data for a project, you can’t use it right away; you may need to change its projection or format, modify its attributes, or link geographic features to attributes stored in another table. When the data is finally ready, you should document its contents and the changes you have made. These data management tasks can all be accomplished using tools that are available in the Catalog.

The easiest way to find out what you can do with ArcCatalog is to complete the exercises in this tutorial.

- Exercise 1 shows you how to build your own catalog of geographic data by adding data to and removing data from the Catalog.
- Exercise 2 illustrates how to explore and search for data and how to add it to a map.
- Exercise 3 shows you how to define a data source’s coordinate system, modify its contents, join attributes in another table to the data, and symbolize features based on the joined attributes.

This tutorial is designed to let you work at your own pace. You’ll need between two and four hours of focused time to complete the tutorial. However, you can also perform the exercises one at a time if you wish.
Exercise 1: Building a catalog of geographic data

When you build a catalog, you’re choosing the data you want to work with. You might use several folders of data to complete your project, while someone else might use data stored in a geodatabase. For this tutorial, you’ll be working with data from Yellowstone National Park, which is located in the northwestern part of the United States.

In this exercise, you’ll add the folder containing the tutorial data to the Catalog. Because you modify this data in later exercises, you’ll create a working copy of the folder, then remove items that you don’t need from the Catalog.

Start ArcCatalog

Before you can complete the tasks in this tutorial, you must start ArcCatalog.

1. Click the Start button on the Windows taskbar.
2. Point to Programs.
3. Point to ArcGIS.
4. Click ArcCatalog. The ArcCatalog window appears.

What’s in the Catalog?

On the left of the ArcCatalog window, you see the Catalog tree; it gives you a bird’s-eye view of how your data is organized. On the right are tabs that let you explore the contents of the selected item in the Catalog tree.

The first time you start ArcCatalog, it contains folder connections that let you access your computer’s hard disks. The Catalog also contains folders that let you create and store connections to databases and GIS servers as well as manage search results.
When you select a connection, you can access the data to which it’s linked. Folder connections let you access folders, or directories, on local disks or shared folders on the network. Database connections let you access the contents of a database. When you remove folder or database connections from the Catalog, you are only removing the connection, not deleting the data.

Together, your connections create a catalog of geographic data sources. Individual folders and data sources are items in that catalog. If you use ArcInfo Workstation, you’re accustomed to using the term “item” when referring to a coverage’s attributes; in this book, “item” refers only to an element in the Catalog tree.

Look in a folder connection

When you select a folder connection in the Catalog tree, the Contents tab lists the items it contains. Unlike Windows Explorer, the Catalog doesn’t list all files stored on disk; a folder might appear empty even though it contains several files. Folders containing geographic data sources have a different icon to make your data easier to find.

Look in a folder connection in your catalog.

1. Click a folder connection in the Catalog tree. The items it contains appear in the Contents tab.

2. Double-click a folder in the Contents list. That folder is selected in the Catalog tree, and the Contents tab lists the folders and geographic data it contains.

Using this method, you can browse through the contents of disks looking for geographic data.

Locate the tutorial folder

Before you can start exploring the data for this tutorial, you must select the folder where the tutorial data is located. In the Catalog, you can quickly select any folder on your computer or on the network as long as you know its path.

1. Click in the Location text box.

2. Type the path to the ArcGIS\ArcTutor folder on the local drive where you installed the tutorial data; for example, type “C:\ArcGIS\ArcTutor”.

If the data was installed by your system administrator in a shared folder on the network, the path to the tutorial folder includes the names of the computer and the shared folder through which the folder is accessed; for example, “\dataserver\public\ArcGIS\ArcTutor”.

3. Press Enter. The folder is selected in the Catalog tree.
When the Catalog already contains a folder connection that can access the ArcGIS\ArcTutor folder, that connection expands, and the tutorial folder is selected in the Catalog tree. Otherwise, a new folder connection is added to the Catalog that directly accesses the ArcGIS\ArcTutor folder.

The path you typed above is added to the Location list after you press the Enter key. To access the ArcGIS\ArcTutor folder again in the future, you can choose its path from the list by clicking the Location dropdown arrow.

**Create a working copy of the tutorial data**

In Exercises 2, 3, and 4, you will create new items and modify the data provided for this tutorial. When processing data, it is best to work on a copy so that your original data will remain unmodified. To prepare for those exercises, use ArcCatalog to copy the ArcTutor\Catalog folder to a location where you have write access. You will need 15 MB of free disk space to store the tutorial data.

1. If the Catalog doesn’t have a connection to the place where you want to store the tutorial data, type its name into the Location combo box and press Enter; for example, type “C:\”. A new folder connection will be added to the Catalog. Substitute the name of your folder connection for “C:\” in the following steps.
2. Click the ArcGIS\ArcTutor folder or folder connection in the Catalog tree.
3. Click the Catalog folder in the Contents tab.
4. Click the Copy button.
5. Click the C:\ folder connection in the Catalog tree.
6. Click the Paste button. A new folder called Catalog will appear in the Contents list for the C:\ folder connection.
7. Click the new Catalog folder in the Contents tab.
8. Click the File menu and click Rename.
9. Type “Cat_Tutorial” and press Enter.

If you type another name for the folder, that name must have 13 characters or less and cannot use spaces. Because the tutorial data includes coverages, the folder’s name must satisfy these requirements for ArcInfo workspaces. For the rest of the tutorial, substitute the name of your folder for “C:\Cat_Tutorial”.

Now that you have a working copy of the tutorial data, you can connect directly to it in the Catalog.

**Connect directly to your copy of the tutorial data**

Folder connections in the Catalog can access specific folders on disk. You might establish several connections to different folders on the same disk. You don’t have to see all the data on your C:\ drive, for example, just because you want to use data in two of the folders it contains.

To create a connection that directly accesses a folder, you can use a shortcut provided by the Catalog.

1. Click the Cat_Tutorial folder in the Contents list.
2. Scroll to the top of the Catalog tree.
3. Drag the Cat_Tutorial folder from the Contents tab and drop it on the Catalog at the top of the Catalog tree.

A new folder connection is added to the Catalog.

Creating folder connections using this shortcut is handy when you’re browsing through local disks that contain many folders, some of which contain geographic data.

**Remove folders that you don’t need**

For the remaining tasks in this tutorial, you only need to use the folder connection that accesses your working copy of the tutorial data. You can remove all other folder connections from the Catalog. To hide folders such as Database Connections, you must change the settings in the Catalog’s Options dialog box.

1. Click the C:\ folder connection.
2. Click the Disconnect From Folder button. The connection is removed from the Catalog.
3. Repeat steps 1 and 2, removing each folder connection in turn, except for the C:\Cat_Tutorial folder connection.
4. Click the Tools menu and click Options.
5. Click the General tab.
6. In the top level entries list, uncheck Address Locators, Database Connections, and GIS Servers. Toolboxes and Coordinate Systems and are unchecked by default.

7. Click OK.

Only the C:\Cat_Tutorial folder connection and the Search Results folder remain in the Catalog. Now you can explore the tutorial data without seeing unnecessary folders and data.

You can continue on to Exercise 2 or stop and complete the tutorial at a later time. If you do not move on to Exercise 2 now, do not delete your working copy of the tutorial data and do not remove the folder connection that accesses the working copy of the tutorial data from the Catalog.
Exercise 2: Exploring data and adding it to a map

Each of the Catalog’s three tabs provides a different way to explore the contents of the selected item in the Catalog tree. Within each tab there are different views that let you change the appearance of the selected item’s contents.

The Contents tab lists the items contained by the selected item in the Catalog tree, for example, the items in a folder. When a data source such as a shapefile is selected, the Preview tab lets you see the geographic or attribute data it contains. The Metadata tab lets you see documentation describing the item’s contents.

ArcCatalog and ArcMap work together to make it easy to build maps. For your project you are mapping the forest resources in the southeastern corner of Yellowstone National Park. In the Yellowstone folder is a map of the study area; it is incomplete. In this exercise, after exploring the data in the folder, you’ll add more data to the map.

The Contents tab

When you select items, such as folders or geodatabases in the Catalog tree, the Contents tab lists the items they contain. To change the appearance of the Contents list, use the appropriate buttons on the Standard toolbar.

The Large Icons view represents each item in the list with a large icon. List view uses small icons. Details view shows properties of each item in columns; you can sort the list by the property values. Thumbnails view displays a snapshot for each item in the list, providing a quick illustration of the item’s geographic data.

Items such as maps, shapefiles, and tables don’t contain other items. When you select them in the tree, the Contents tab lists the item’s properties and its thumbnail.

Explore the contents of the Yellowstone folder

Each type of geographic data has its own set of icons in the Catalog. The Yellowstone folder contains a personal geodatabase, coverages, shapefiles, raster datasets, a TIN dataset, a dBASE® table, and an ArcMap map document. Geodatabases let you store spatial data inside a relational database; personal geodatabases can be accessed by only one person at a time. For more information, see Chapter 3, ‘Catalog basics’.

The Yellowstone folder also contains two layers. A layer includes a shortcut to geographic data and information, such as the symbology used to draw geographic data on a map, the query used to select which features the layer represents, and properties defining how those features are labeled.

Use the Contents tab to find out about the data in the Yellowstone folder.
1. Double-click the C:\Cat_Tutorial folder connection in the Catalog tree.
2. Click the Yellowstone folder in the Catalog tree.
3. Click the Large Icons button.
4. Click the List button.

5. Click the Details button. The Type column in Details view will help you learn which icon represents which type of data. You can find more information about data types and their icons in Chapter 4, ‘What’s in the Catalog’.

6. Click the heading of the Type column to sort the items by type.

7. Click the heading of the Name column to sort the items by name. When sorted by name, items that contain other items, such as geodatabases and coverages, always appear at the top of the Contents list. They are grouped by type.

8. Click the Thumbnails button and scroll down through the snapshots. Items that are not geographic data sources, such as the Yellowstone geodatabase, can’t have thumbnails; their icons appear on a gray background.

9. Click the Details button.

10. Double-click the Yellowstone personal geodatabase in the Contents tab. It contains a feature dataset called water and a feature class called roads.

11. Double-click the water feature dataset in the Contents tab. It contains three feature classes: lakes, rivers, and streams.

12. Click the states coverage in the Catalog tree to list the feature classes it contains.
13. Click the tin_study TIN dataset in the Catalog tree. This surface represents the terrain of the study area. Because a TIN dataset doesn’t contain other items, the Contents tab lists its properties and thumbnail instead.

Thumbnails give you a quick look at an item’s geographic data; they’re useful when browsing through folders. However, you must often see the data in more detail to determine whether or not you want to use it.

**The Preview tab**

The Preview tab lets you explore the selected item’s data in either Geography or Table view. For items containing both geographic data and tabular attributes, you can toggle between the Geography and Table views using the dropdown list at the bottom of the Preview tab.

Geography view draws each feature in a vector dataset, each cell in a raster dataset, and each triangle in a TIN dataset. When drawing geographic data, the Catalog uses a default set of symbology. When drawing a layer’s contents, the Catalog uses the symbology stored in the layer. You can explore the selected item’s geographic data using the buttons on the Geography toolbar.

Table view draws all rows and columns and the value for each cell in the selected item’s table. You can explore the values in the table using the scroll bars, the buttons at the bottom of the table, and the context menus that are available from the column headings.

**Look at the Yellowstone data in Geography view**

Use Geography view to look at the data contained by the items in the Yellowstone folder. When using Geography view, the Geography toolbar is enabled. You can use the Zoom In, Zoom Out, Pan, Full Extent, and Identify buttons on the toolbar to explore geographic data.

While you look at the Yellowstone data, you may wish to see the geographic features in more detail using these tools.
For more information about how these buttons work, see Chapter 7, ‘Exploring an item’s geography’.

1. Click the dem30 raster dataset in the Catalog tree. This dataset contains elevation information for the study area within the park.

2. Click the Preview tab. The raster draws using the default grayscale color ramp.

3. Click the elevation layer in the Catalog tree. The raster draws using the symbology stored in the layer—a green to red color ramp.

4. Click the study_area shapefile in the Catalog tree. It represents the study area for this project, which lies in the southeastern corner of the park.

5. In the Catalog tree, click the plus sign next to the vegetation coverage. The coverage’s feature classes are listed in the Catalog tree.

6. In the Catalog tree, click each feature class in the vegetation coverage in turn and look at their contents in Geography view. This polygon coverage represents the different types of vegetation within the study area.

7. Click the Preview dropdown arrow at the bottom of the Preview tab and click Table.

8. In the Catalog tree, click each feature class in the vegetation coverage in turn and look at their contents in Table view. All feature classes in a coverage have FID and Shape columns. They may also have several pseudo items whose names begin with a dollar sign ($), which are maintained by ArcInfo. Because topology only exists for the polygon feature class, it’s the only one that has a feature attribute table and, therefore, additional attributes.

9. Click the Preview dropdown arrow at the bottom of the Preview tab and click Geography.

10. In the Catalog tree, click the minus sign next to the vegetation coverage. The feature classes are hidden and the coverage is selected in the Catalog tree.
coverage’s polygon feature class draws in Geography view.

ArcCatalog draws the first feature class it finds in the dataset with the highest dimension of geometry available. If a coverage contained only line and point feature classes, the first line feature class found would draw in Geography view.

11. In the Catalog tree, click the plus sign next to the water feature dataset in the yellowstone geodatabase. The feature classes it contains appear in the Catalog tree.

12. In the Catalog tree, click each feature class in the water feature dataset, in turn, and look at their contents in Geography view. This feature dataset groups feature classes that contain different types of water features throughout the park: lakes, rivers, and streams.

13. Click the water feature dataset in the Catalog tree. The lakes feature class draws in Geography view.

14. Click the hydrology layer in the Catalog tree. This group layer presents all features in the lakes, rivers, and streams feature classes using symbology stored in the layer. When added to a map, a group layer maintains its grouping in the table of contents.

15. Click the Identify button on the Geography toolbar and click one of the larger lakes in the Preview tab. Its attributes appear in the Identify Results window. Only the larger lakes in this feature class have names.

16. Click the Close button in the upper right corner of the dialog box to close the Identify Results window.

By exploring a data source’s data in Geography view, you can find out if it has the features you need and if those
features have the correct attributes. This information can help you decide whether or not to add the data to a map.

**Explore the contents of a table**

With the table exploration tools available in the Catalog, you can learn a great deal about a table’s contents. You can search for values in the table and sort records according to the values in one or more columns.

The vegetation coverage represents areas with distinct types of vegetation. The vegtype table contains both general information, such as whether or not the area is forested, and detailed information such as which plant species live in each area. Throughout the park, 67 vegetation groups have been defined. Some areas, such as open water or rocky peaks, may not have any vegetation at all.

Use the tools available in Table view to explore the contents of the vegtype table.

1. Click the vegtype dBASE table in the Catalog tree.
2. Explore the table’s values using the buttons at the bottom of the table. Once you click in the table you can also use the arrow keys on the keyboard.
3. Type “10” into the Current record text box and press Enter. The Current record icon appears next to the tenth row in the table. The Object ID value for this record, which is located in the OID column, is nine; the OID values begin at zero.
4. Scroll horizontally through the table until you see the column named Primary.
5. Right-click the heading of the Primary column and click Freeze/Unfreeze Column. The Primary column is frozen in position at the left of the table, and a heavy black line appears to its right.
6. Scroll horizontally through the table. The Primary column stays in place while the other columns scroll normally. Place the Type column to the right of the Primary column.
7. Position the mouse pointer over the right edge of the Primary column’s heading. The mouse pointer changes.
8. Click and drag the edge of the Primary column’s heading to the left. The red line indicates the edge’s original position, while the black line shows its new location. Drop the edge of the column. The column is narrower.
9. Right-click the heading of the Type column and click Freeze/Unfreeze Column. The heavy black line is now to the right of the Type column. Scroll horizontally through the table. Both the Primary and Type columns stay in place while the other columns scroll normally.

10. Click the Type column’s heading. The column is highlighted in light blue.

11. Click and drag the Type column’s heading to the left of the Primary column. The red line indicates the Type column’s new position. Drop the column in the new location.

The Type column now appears to the left of the Primary column, and the heavy black line appears to the right of the Primary column.

12. Hold down the Ctrl key and click the Primary column’s heading. Both columns are now selected.

13. Right-click the heading of the Primary column and click Sort Descending.

The rows in the table are sorted alphabetically in descending order, first by the values in the Type column, then by the values in the Primary column. In this format, the table presents vegetation information from general to detailed as you look at the columns from left to right.

After exploring the contents of the vegtype table, you have a better idea about the forest resources that are available in the study area. However, you may not know what some column names in the table mean. For that information, you must look at the table’s metadata.

The Metadata tab

The Metadata tab shows descriptive information about the selected item in the Catalog tree. Metadata includes properties and documentation. Properties are derived from the data source, while documentation is information provided by a person.

Metadata is stored as extensible markup language (XML) data in a file with the data or in a geodatabase. The Catalog uses XSL Transformations (XSLT) stylesheets to transform the XML data into a hypertext markup language (HTML) page. You can change the metadata’s appearance by changing the current stylesheet using the dropdown list on the Metadata toolbar.
You can browse through the available metadata just as you would browse through any Web page in a browser.

**Explore metadata for the tutorial data**

The metadata for the Yellowstone folder provides an overview of the data it contains. By looking at metadata for the study_area shapefile and vegetation coverage, you can find out when and why the data was created and look at the data’s properties.

1. Click the Yellowstone folder in the Catalog tree.
2. Click the Metadata tab. A metadata HTML page describing the contents of the Yellowstone folder appears.

3. Click the study_area shapefile in the Catalog tree. Metadata is presented with the FGDC ESRI stylesheet by default.

The Catalog automatically adds the item’s current property values to the metadata when you view it in the Metadata tab.

4. Click the Stylesheet dropdown arrow on the Metadata toolbar and click FGDC FAQ. Click the Stylesheet dropdown arrow again and click FGDC. Different stylesheets present the same body of metadata in different ways.
5. Click the Stylesheet dropdown arrow on the Metadata toolbar and click FGDC ESRI.

6. Click the Spatial tab in the metadata.

7. Underneath the name of the coordinate system used by the data, click Details. The coordinate system’s properties appear. Click Details again to hide the information.

8. Scroll down to see the shapefile’s extent. Its bounding coordinates are presented both in the actual coordinates of the data and in decimal degrees.

9. Click the boundary shapefile in the Catalog tree.

10. Click the Spatial tab in the metadata. No coordinate system information is available because the shapefile’s projection hasn’t yet been defined. Scroll down to see the data’s extent in projected coordinates.

Because there is no coordinate system information, the Catalog can’t calculate the data’s extent in decimal degrees. You’ll define the shapefile’s coordinate system in Exercise 3.

In ArcCatalog, metadata isn’t required to meet any standard. By default, when you look at metadata in the Metadata tab, ArcCatalog automatically records the item’s properties following both the Federal Geographic Data Committee’s (FGDC) Content Standard for Digital Geospatial Metadata and the International Organization for Standardization’s (ISO) standard 19115 Geographic Information—Metadata. The hints you see in gray text with some stylesheets indicate the documentation that must be completed to meet the standard’s minimum requirements.

11. Click the vegtype table in the Catalog tree.

12. Click the Spatial tab in the metadata. The table doesn’t contain spatial information. But, because the information it contains only applies to Yellowstone National Park, the extent of the Park has been provided manually. Therefore, the table can be found by a spatial search.

13. Click the Attributes tab in the metadata. All columns in the table are listed.

14. Click the LATIN3 column in the list. You can see a description of its data type and values.

15. Click the Contents tab in the ArcCatalog window.

Now that you’ve familiarized yourself with the data, you can create a map describing the study area within Yellowstone National Park.
Add a layer to a map

The Yellowstone folder contains a map document. The map already has data from the roads feature class and the hillshade raster dataset. You must still add the water features in the park to the map.

Adding data to a map is easy—all you have to do is drag data from the Catalog and drop it on the map. When you drop a layer onto a map, a copy of the layer is created and stored inside the map document. In this way, you can create a layer once and use it in many different maps. Before you can add more data to the Yellowstone map, you must open the map document in ArcMap.

1. Click the Yellowstone folder in the Catalog tree.
2. Double-click the yellowstone map document in the Catalog; it opens in ArcMap.

In the ArcMap window, you see the contents of the Study Area data frame in Data view; the name of the active data frame appears in bold in the table of contents. The map has two other data frames as well: Yellowstone National Park and United States.

3. Arrange the ArcMap and ArcCatalog windows so you can see the table of contents in ArcMap and the Catalog tree at the same time.

Water features must be added to the map; they should draw underneath the park roads layer but above the hillshade layer. The map’s table of contents reflects the order in which layers are drawn.

4. Click and drag the hydrology layer from the Catalog and drop it in the map’s table of contents below park roads in the Study Area data frame’s list of layers.
5. In the ArcMap window, click the Save button.
   The water features draw underneath the road features and above the hillshade image in the map.

**Create layers**

The features in the park roads and hydrology layers cover the entire park, but you only want to map the study area. The mask shapefile represents the area outside the study area. You can create a layer from this shapefile in the Catalog and add it to the map to hide features that extend beyond the study area.

If you add data directly to a map rather than creating a layer first, ArcMap creates a new layer in the map document. After modifying the layer’s symbology and other properties, you can save it as a layer file outside the map document so you can reuse it in other maps.

In this task, you will first save the park roads layer to a file, then create a new layer representing the mask shapefile.

1. Right-click the park roads layer in the map’s table of contents and click Save As Layer File.
2. In the Save Layer dialog box, navigate to the Yellowstone folder. Type a name for the new layer, for example, “park roads”, then click Save.
3. In the Catalog tree, click the Yellowstone folder.
4. Click the View menu and click Refresh. The park roads layer now appears in the Contents list.
5. Right-click the mask shapefile and click Create Layer.
6. Navigate to the Yellowstone folder in the Save Layer As dialog box. Type a name for the new layer, for example,
“feature mask”, then click Save. The layer appears in the Contents list for the Yellowstone folder.

7. Right-click the feature mask layer and click Properties. The Layer Properties dialog box appears.

8. Click the Symbology tab.

9. Click the button showing the current symbol for the layer. A symbol is assigned at random when the layer is created.

10. Click the dropdown arrow next to the Fill Color symbol and click white.

11. Click the dropdown arrow next to the Outline Color symbol and click black.

12. Click OK in the Symbol Selector dialog box and click OK in the Layer Properties dialog box.

Now that you’ve finished creating the feature mask layer, you should document its contents. Before adding it to the map, you can import metadata, which has already been created for the layer.

**Import metadata**

There is a text file in the Yellowstone folder containing metadata describing the feature mask layer. By importing this metadata it will become part of the layer itself; it will be copied and moved with the data and updated automatically by ArcCatalog. This is useful because when metadata is maintained separately, it is easy to let it get outdated.
1. Click the feature mask layer in the Catalog tree. Notice that the layer’s icon appears on a gray background because a thumbnail hasn’t yet been created.

2. Click the Metadata tab. By default, ArcCatalog automatically creates metadata for the feature mask layer. Properties such as the name of the layer file will be added automatically along with hints about the type of documentation you should provide.

3. Click the Import metadata button on the Metadata toolbar.

4. Click the Format dropdown list and click FGDC CSDGM (TXT). Metadata in text files can be imported if the information is structured following the format supported by the FGDC’s metadata parser, mp.

5. Click Browse and navigate to the Yellowstone folder.

6. Click the Files of type dropdown arrow and click All files (*.`). Click the file “feature_mask.met” and click Open.

7. Click OK in the Import Metadata dialog box. The information in the feature_mask.met file replaces the metadata generated by ArcCatalog. Then, properties of the layer are automatically added to it.

Now there is just one thing missing from the layer’s metadata—a thumbnail describing how the layer will appear when added to a map. Creating thumbnails for data sources and layers is a manual process.

8. Click the Preview tab.
9. Click the Create Thumbnail button on the Geography toolbar.

10. Click the Contents tab. You can see the thumbnail both here and in the layer’s metadata.

After adding or removing features from a data source or changing a layer’s symbology, you may wish to update the item’s thumbnail.

**Search for items**

You’ve explored the contents of the Yellowstone folder and created the new feature mask layer, and soon you’ll add it to your map. However, often you know what data you need to use but not where it’s located. The Catalog lets you search for data by its name, type, and geographic location. You can also search for data using dates and keywords that reside in the data’s metadata. When metadata exists, its name, type, and geographic location are derived from the metadata as well.

Suppose you didn’t know the feature mask layer existed. You need to add a data source to the Yellowstone map that shows the boundary of the study area within the park.

1. Right-click the Yellowstone folder in the Catalog tree and click Search. The Search dialog box appears, and the location in which the search will begin looking is automatically set to the Yellowstone folder.

2. Click the Advanced tab.

3. Click the Metadata element dropdown arrow, scroll down, and click Theme Keyword in the list.

4. Click the Condition dropdown arrow and click equals.

5. Click in the Value text box and type “boundary”.

6. Click Add to List.
With this search, ArcCatalog will look in the Yellowstone folder for items whose metadata includes the theme keyword boundary.

7. Click Find Now.

The search is saved in the Search Results folder and is selected in the Catalog tree. As the items are found that satisfy the search criteria, shortcuts to those items are added to the search’s list of results. When a Search is complete, the message “Catalog search finished” appears in the status bar of the ArcCatalog window and the Stop button becomes unavailable in the Search dialog box.

8. Click the Close button in the upper-right corner of the Search dialog box.

The Catalog has found four items in the Yellowstone folder that satisfy the search criteria: three shapefiles and the feature mask layer. Shortcuts to these items appear in the Contents tab. In the Catalog, you can work with shortcuts the same way you would work with the items themselves.

9. Click the shortcut to the feature mask layer in the Contents tab.

10. Click the Preview tab to draw the layer.

11. Click the Metadata tab to see the layer’s metadata.

This is the data you want to add to your map.

12. Click and drag the shortcut to the feature mask layer from the Catalog and drop it in the map’s table of contents above park roads in the Study Area data frame’s list of layers. Now you only see features inside the study area on the map.
13. Click the Save button.

The Yellowstone map now contains all the basic data needed to represent the study area. Now all you need to do is add a few finishing touches to the map’s layout.

**Complete the map**

The purpose of the Yellowstone map is to illustrate the different types of vegetation within the study area. Currently, the Study Area data frame shows most of the park. You need to zoom in on the study area; do this in layout view to make sure you’re zoomed in as far as possible but still able to see the entire study area in the layout. When you switch to layout view, you’ll see the Yellowstone National Park and United States data frames as well.

1. Click the View menu and click Layout view. You can see all the data frames and the map’s title and scalebar in the layout.

In the Yellowstone National Park data frame, there is an orange rectangle representing the area that you can see within the Study Area data frame. Similarly, in the United States data frame, there is a green rectangle representing the area that you can see within the Yellowstone National Park data frame.

When you zoom farther in to the features in the Study Area data frame, the extent rectangle on the Yellowstone National Park data frame decreases in size and the scalebar increases in size.

2. In ArcMap, click the Zoom In button on the Tools toolbar and draw a rectangle around the study area in the Study Area data frame.

If you zoom in too close, you can return to your previous extent by clicking the Go Back To Previous Extent button.
3. When the study area fills the Study Area data frame, click the Save button.

4. Click the File menu and click Exit to stop ArcMap.

In this exercise, you saw how to explore your data in the Catalog, create layers, import metadata, search for items, and add them to maps. In the next exercise, you’ll create a layer illustrating the different types of vegetation that can be found within the study area. This requires changing a data source to a different format and modifying its values.

You can continue on to the next exercise or stop and complete the tutorial at a later time. If you do not move on to the next exercise now, do not delete your working copy of the tutorial data. Also, do not remove the folder connection that accesses the working copy of the tutorial data from the Catalog.
Exercise 3: Managing shapefiles

Assembling data for a project often requires significant data management work. In this exercise, you will create a layer representing the different types of vegetation in the study area and add it to the Yellowstone map. In doing so, you’ll learn how to define a shapefile’s coordinate system, modify attributes, join a table’s attributes to a shapefile, and update metadata using tools that are available in ArcCatalog.

**Define a shapefile’s coordinate system**

In the previous exercise, when you looked at metadata for the boundary shapefile, you found that its coordinate system was not defined. The features in the shapefile are projected, but the Catalog doesn’t know which map projection was used. Without that information, the Catalog can’t determine where on the earth’s surface the features are located.

A shapefile’s Properties dialog box lets you modify its attributes, create spatial and attribute indexes, and define its projection.

1. In ArcCatalog, click the Contents tab and click the Yellowstone folder in the Catalog tree.
2. In the Contents list, right-click the boundary shapefile and click Properties.
3. Click the Fields tab.
4. Under Field Name, click Shape. This column contains the feature geometry. The shapefile’s spatial properties appear in the Field Properties list below.
   At the bottom of the list is the Spatial Reference property. The shapefile’s coordinate system is unknown.

5. Click the ellipses (...) button to the right of the Spatial Reference property.

All data sources in the Yellowstone folder except for the states coverage use the same projection. You can copy coordinate system information from any data source in the folder except states to this shapefile.

6. Click Import in the Spatial Reference Properties dialog box.

7. Navigate to the Yellowstone folder, click the dem30 raster dataset, then click Add. The projection parameters from the dem30 raster dataset appear in the Spatial Reference Properties dialog box.

8. Click OK. The shapefile’s coordinate system appears in the Shape column’s Spatial Reference property.
9. Click OK.

A shapefile’s coordinate system information is stored in a .prj file with the data—for example, boundary.prj. Now you can update the shapefile’s metadata with the new coordinate system information. By default, every time you look at metadata in the Metadata tab, the Catalog automatically updates the metadata with the data source’s current properties.

10. Click the Metadata tab.

11. Click the Spatial tab in the metadata.

ArcCatalog has updated the coordinate system in the metadata and has calculated the shapefile’s extent in decimal degrees.

**Modify attributes in dBASE tables**

A layer can join or relate attributes in a table of any format to its geographic data source as long as they share a column of values. The only requirement is that the columns have the same data type. Land cover information in the vegtype dBASE table can be joined to the vegetation coverage’s polygon feature class to describe the land cover in each area. You must look at the polygon feature class’s attributes and the vegtype table’s columns to see if modifications are required before they can be joined together.

Using Table view, you can see that the “CODE” attribute in the vegetation polygon feature class and the “VEGID” column in the vegtype table look like they contain related values and that the vegtype table has two columns that contain no values. Use the polygon feature class’s Properties dialog box to check the CODE attribute’s data type, then use the table’s Properties dialog box to check the VEGID column’s data type and modify its columns appropriately.

1. Click the Contents tab in the ArcCatalog window.
2. Click the vegetation coverage in the Catalog tree.
3. Right-click the polygon feature class in the Contents list and click Properties.
4. Click the Items tab. The columns in the feature class’s attribute table are listed. You can see that the CODE attribute’s data type is Float.

5. Click Cancel.
6. Right-click the vegtype table in the Catalog tree and click Properties.
7. Click the Fields tab. The table’s columns and their data types are listed. You can see that the VEGID column’s data type is Long Integer.

The VEGID column in the dBASE table contains integers, while the CODE column in the polygon feature class contains real numbers. To join the table to the feature class, each item must have a column containing the same values. Both columns must also have the same data type. Therefore, you must add a floating point column to the table.

8. Scroll to the bottom of the list of column names. Click in the empty row under the name of the last attribute and type “VEGTYPE”.

9. Click under Data Type to the right of the new column’s name, click the dropdown arrow that appears, then click Float.

10. In the Field Properties list below, click to the right of Precision, click again, then replace the zero with “4”.

11. Click to the right of Scale and replace the zero with “1”.

The new attribute has been defined. Now you can remove the empty columns from the table.

12. Point at the gray button to the left of the NAME3 column; the mouse pointer changes to an arrow. Click to select the column.

13. Press Delete. The column is removed from the list.

14. Repeat steps 11 and 12 for the LATIN3 column to delete it from the table.

15. Click OK.

Now that the vegetation shapefile has a new integer attribute, you must copy the values in the original VEGID attribute to the new VEGTYPE attribute. To edit the values in a table, you must use ArcMap.

**Calculate attribute values in ArcMap**

To edit a table’s values you must add the table to a map. With the Editor toolbar visible and the table opened, you can start editing its values. Use the field calculator to copy values from the CODE attribute to the VALUE attribute.

1. Click the Launch ArcMap button in ArcCatalog.
2. Click OK to start using ArcMap with a new, empty map.

3. Drag the vegtype table from the Catalog and drop it onto the table of contents or the canvas in the ArcMap window. The table appears in the Source tab in the map’s table of contents. The table’s data is now available within the map.

4. Click the Editor Toolbar button; the Editor toolbar appears.

5. On the Editor toolbar, click the Editor menu and click Start Editing.

6. Right-click the vegtype table and click Open. The table’s values appear in a table window. The headings of the columns whose values you can change have a white background.

7. Click the heading of the VEGID column to select the column.

8. Scroll horizontally in the table until you see the VEGTYPE column.

9. Hold the Ctrl key and select the heading of the VEGTYPE column.

10. Right-click the heading of the VEGTYPE column and click Freeze/Unfreeze Column. Both VEGID and VEGTYPE are now positioned at the left of the table with a heavy black line to their right.

11. Right-click the heading of the VEGTYPE column and click Calculate Values.

12. Scroll down and double-click VEGID in the Fields list. [VEGID] appears in the text box below VEGTYPE =. ArcMap reads this as VEGTYPE=[VEGID]. This means for each row in the table, the value in the VEGTYPE column will be set equal to the value stored in the VEGID column.
13. Click OK.

As ArcMap calculates the new values in each record, you can see how many records have been completed at the bottom of the Field Calculation dialog box.

14. Look at the VEGTYPE column in the table; its contents are the same as the VEGID column.

15. Click the Close button in the top-right corner of the table window.

16. Click the Editor menu on the Editor toolbar and click Stop Editing. Click Yes to save your changes.

17. Click the File menu and click Exit to stop ArcMap. Click No when prompted to save the map.

**Update the table’s metadata**

In the previous two tasks you removed and added columns from and to the vegtype table, then populated the new column with values. Now you should update information about the table’s columns in its metadata.

1. Click the Metadata tab.

2. Click the Attributes tab in the metadata. ArcCatalog has automatically updated the metadata to remove information about the columns that were deleted from the table.

3. Click VEGTYPE in the list of columns. The data type of this column was added to the metadata automatically.

To describe the data contained in the VEGTYPE column, use the Catalog’s FGDC metadata editor.

4. Click the Edit Metadata button on the Metadata toolbar.

5. Click Entity Attribute at the top of the metadata editor. The editor is currently showing you metadata for the polygon feature class.

6. Within the Detailed Description tab, click the Attribute tab.
The Attribute tab currently shows metadata for the first column in the vegtype table, the OID column. The Definition text box shows that this column contains a unique value for each record in the table.

7. In the toolbar at the bottom of the Attribute tab, click the Move next button. The column displayed in the Attribute tab advances to the next one listed in the table’s metadata—the VEGID column, which contains integers identifying each type of land cover.

8. Click the Move last button to see the VEGTYPE column.

9. Click in the Definition text box and type, “A real number identifying the type of land cover. Use this column to join this table to the vegetation coverage.”

10. Click Save.

11. Click the Attributes tab in the metadata.

12. Click the VEGTYPE column. The description you added appears in the metadata. Anyone who uses this table in the future will be able to find out what data this column contains.

Now that the vegetation coverage and the vegtype table have matching columns, you can create a layer that links the two together.

**Create a layer using the related attributes**

Through a layer you can join the attributes stored in the vegtype table to the vegetation coverage and use the table’s values to query, label, and symbolize the coverage’s features.

1. Click the Contents tab in the ArcCatalog window.
2. Click the Yellowstone folder in the Catalog tree.
3. Click the File menu, point to New, then click Layer.
4. Type a name for the layer such as “vegetation type”.
5. Click the Browse button, navigate to the Yellowstone folder, click the vegetation coverage, then click Add.
6. Check Store relative path name, then click OK.
A relative path specifies the location of the data used by the layer relative to the location of the layer file on disk. Since relative paths don’t contain drive names, they let you continue using the layer even after moving or renaming the Yellowstone folder, without having to repair the layer.

7. Right-click the vegetation type layer and click Properties.

8. Click the Joins & Relates tab in the Layer Properties dialog box.

9. Click the Add button next to the Joins list.

10. Click the first dropdown arrow to specify what you want to join to this layer, then click Join attributes from a table.

11. Under step 1, click the dropdown arrow and click the CODE attribute.

12. Under step 2, click the Browse button.

13. Navigate to the Yellowstone folder, click the vegtype table, and click Add.

14. Under step 3, click the dropdown arrow and click the VEGTYPE column.

15. Click OK in the Join Data dialog box. The vegtype table is added to the list of tables that have been joined to the coverage.

16. Click Yes to create an index.

17. Click the Symbology tab.

18. Click Categories in the Show list.

19. Click the Value Field dropdown arrow and click vegtype.TYPE.
20. Click the Color Ramp dropdown arrow and click a different color palette, if desired.
21. Click Add All Values.

To change the color of individual values, for example, to make the water polygons blue, double-click the patch of color to the left of the value. Set the fill and outline colors in the Symbol Selector dialog box and click OK.
22. Click OK in the Layer Properties dialog box.

The vegetation type layer represents the forest resources in the study area.

**Add the vegetation type layer to the map**

Now that the vegetation layer has been created, you can add it to the Yellowstone map.

1. Double-click the Yellowstone map in the Catalog.
2. Click and drag the vegetation type layer from the Catalog and drop it in the map’s table of contents below park roads and above hydrology in the Study Area data frame’s list of layers.

3. Click the Save button in ArcMap.
4. Click the File menu and click Exit to stop ArcMap.

The Yellowstone map is now complete.

You’re now finished with the Quick-start tutorial. This exercise showed how to use ArcCatalog to manage shapefiles and dBASE tables including how to define a coordinate system and add and remove attributes.

Overall, this tutorial has introduced you to a wide range of tasks. Whether you are looking for data, building maps, or managing data for your project or an entire organization, ArcCatalog plays a pivotal role in getting the job done. The remaining chapters in this book look in detail at the variety of tasks you can accomplish with ArcCatalog.
IN THIS CHAPTER

- Starting ArcCatalog
- The ArcCatalog window
- Browsing through the Catalog
- Repositioning the Catalog tree
- Getting help
- Stopping ArcCatalog

Whether you need to find a specific map, document its contents, or modify a coverage, you can do it in ArcCatalog. Before you begin, read this chapter. It runs through the basics of what you see when you start ArcCatalog and how to use it to browse through your data holdings. It also explains how to use the online Help system, which can help you to learn what the various elements are in the ArcCatalog window. Help topics also provide step-by-step instructions that show you how to accomplish your tasks.
Starting ArcCatalog

Starting ArcCatalog is the first step to exploring your data. However, before you can begin, ArcCatalog must be installed on your computer. If you don’t know whether it has been installed, check with your system administrator or install it yourself using the installation guide. Once the software is installed, you can access ArcCatalog from the Start button on the Windows taskbar.

1. Click the Start button on the Windows taskbar.
2. Point to Programs.
3. Point to ArcGIS.
4. Click ArcCatalog.

Tip

Starting ArcCatalog from ArcMap

You can also start ArcCatalog from ArcMap by clicking the Launch ArcCatalog button on the Standard toolbar.
The ArcCatalog window

- The title bar displays the selected item’s location.
- Click the buttons on the active toolbars to explore the current view.
- The Catalog tree lets you access all of the Catalog’s contents. Select an item in the tree to view its contents.
- Each tab displays the contents of the selected item in a different way. Within each tab, several different views let you change how you see the selected item’s contents.
- The status bar describes what a button or menu command does and also reports which items are selected.
- Move this bar to resize the Catalog tree.
Browsing through the Catalog

Browsing through geographic data in the Catalog is easy, whether you’re looking for something specific or simply seeing what’s there. The Catalog tree displays all the items in the Catalog and illustrates the hierarchy in which they are organized. When you select an item in the Catalog tree, the Contents tab lists the items it contains. By pressing the Up and Down arrow keys on your keyboard, you can quickly select the items displayed above or below the currently selected item in the Catalog tree. The Up One Level button on the Standard toolbar selects the next item up in the Catalog tree’s hierarchy.

Sometimes, the Catalog’s list of a folder’s contents will not match the folder’s actual contents—for example, after you receive a map as an e-mail attachment and you save it in a folder. You can update, or refresh, the Catalog’s list of the folder’s contents by selecting the folder in the Catalog tree, clicking the View menu, then clicking Refresh.

When you know exactly which item you want to work with and where it’s located, it’s quicker to select it by typing its path than by browsing through the ▶

Selecting items in the Catalog tree and the Contents list

1. Click the Contents tab.
2. Click an item in the Catalog tree that contains a subset of items, such as a folder or feature dataset.
   The items it contains are listed in the Contents tab.
3. Double-click an item in the Contents list that contains a subset of items.
   The items it contains are listed in the Contents tab.
4. Double-click an item that contains a subset of items in the Catalog tree.
   The items it contains are listed in the Catalog tree.
5. Double-click an item that does not contain other items, such as a shapefile or table, either in the Contents list or in the Catalog tree.
   Maps open in ArcMap, and XML documents and file types open in the appropriate application. A Properties dialog box will appear for all other items.
6. Click an item that doesn’t contain other items in the Catalog tree.
   Its properties and thumbnail are listed in the Contents tab.
Catalog's contents. An item’s path describes how to navigate the Catalog’s hierarchy to find it. For items located in a remote database stored in the Database Connections folder, the path includes both the folder’s name and the name of the database connection. For example, a path that selects a parcel’s feature class in an ArcSDE® geodatabase might appear as “Database Connections\myConnection\theDataset\anOwner.parcels”. If you type the path of a folder for which a folder connection doesn’t already exist, a new folder connection will automatically be created.

The selected item’s path always appears in the ArcCatalog window’s title bar and in the text box on the Location toolbar. The status bar shows how many items are currently selected and what type of items they are, if appropriate.

**Tip**

**Selecting a path from the Location list**

*After selecting an item by typing its path, the path is added to the Location list. To select that item again later, click the Location dropdown arrow and click the appropriate path in the list.*

---

**Selecting an item by typing its path**

1. Type the path to the item you want to select in the Location text box.
2. Press Enter.

The Catalog tree expands to show the item you’ve selected. Or, a new folder connection is added to the Catalog, and it is selected in the Catalog tree.

---

**Moving up the Catalog tree**

1. Click the Up One Level button.

The next item up in the Catalog tree’s hierarchy is selected.

---

1. Type the path of a folder for which a folder connection doesn’t already exist, a new folder connection will automatically be created.

The selected item’s path always appears in the ArcCatalog window’s title bar and in the text box on the Location toolbar. The status bar shows how many items are currently selected and what type of items they are, if appropriate.

---

**Tip**

**Selecting a path from the Location list**

*After selecting an item by typing its path, the path is added to the Location list. To select that item again later, click the Location dropdown arrow and click the appropriate path in the list.*
When browsing through a long list of folders, you may find it difficult to locate your data. By default, all folders have the same, plain folder icon. To make your data easier to find, the Catalog gives you the option to use a special icon for folders that directly contain GIS data. With this option checked, you will experience delays when accessing data across the network. After locating the folder you need, add a folder connection that directly accesses it, then uncheck the option to use the special icons. Some illustrations in this book show ArcCatalog with this option checked.

Tip

Returning to your last location

By default, when ArcCatalog is started it automatically selects the item that was selected the last time you stopped ArcCatalog. This option is convenient, but if you turn it off ArcCatalog may start faster, especially if the item is located on the network.

Tip

Hiding file extensions

By default, file extensions are hidden for maps, layers, file types, and raster datasets. When file extensions are shown, a raster would be listed as Buffalo.bil, for example.

Making it easier to find geographic data on disk

1. Click the Tools menu and click Options.
2. Click the General tab.
3. Check Use a special icon for folders containing GIS data.
4. Click OK.

Folders that directly contain GIS data will have a special folder icon to make your data easier to find.
Repositioning the Catalog tree

The main elements of the ArcCatalog window are the Catalog tree, which displays the contents of the Catalog, and the tabs, which provide different views of the contents of the selected item in the Catalog tree. You can reposition the Catalog tree to make it easier to explore the selected item’s contents. By default, the Catalog tree is docked on the left side of the ArcCatalog window, but you can dock it on the right, the top, or the bottom of the window if you prefer. You can also undock the Catalog tree so that it floats on your desktop to make it easier to drag datasets to a map or a Geoprocessing tool. Similarly, you might want to hide or close the Catalog tree temporarily.

Tip

Moving the Catalog tree without docking it

If you hold down the Ctrl key while dragging the Catalog tree with your mouse pointer, ArcCatalog won’t try to dock the tree in the ArcCatalog window. This applies to toolbars as well.

Undocking the Catalog tree

1. Click and drag the bar at the top of the Catalog tree with your mouse pointer to a location outside the ArcCatalog window.

A rectangle with a thick line indicates where the Catalog tree will be placed.

2. Drop the panel.

The Catalog tree is floating on the desktop but is still working with the application.
Hiding and showing the Catalog tree

1. Click the Close button on the bar at the top of the Catalog tree to hide it.
   The Catalog tree no longer appears in the ArcCatalog window.

2. Click the Window menu and check Catalog tree to show it again.

The Catalog tree no longer appears in the ArcCatalog window.
Getting help

A quick way to learn about ArcCatalog is to use the online Help system. You can get help in a variety of ways.

When you position the mouse pointer over a button for a second or two, the button’s name pops up in a small box called a ToolTip. Also, when you position the pointer over an element in the ArcCatalog window, a brief description of what it does appears in the status bar. To quickly display a longer description of a button or menu command, click the What’s This? button, then click the element in which you’re interested. You can also get help in some dialog boxes. When you click the What’s This? button in the upper-right corner and click an element in the dialog box, a description of the item pops up. Some dialog boxes have a Help button; clicking it opens a Help topic with detailed information about the task you’re trying to accomplish.

Much of the information in this book is available in the online Help system. The Help viewer contains a navigation pane—with Contents, Index, and Search tabs—and a topic pane for viewing Help topics. Both panes are visible in the viewer at all.

Getting help in the ArcCatalog window

1. Click the What’s This? button on the Standard toolbar.
2. Click the Help pointer on the element in the ArcCatalog window you want to learn more about.
3. Click anywhere on the screen to close the Help description box.

Getting help in a dialog box

1. Click the What’s This? button on the upper-right corner of the dialog box.
2. Click the Help pointer on the element in the dialog box you want to learn more about.
3. Click anywhere on the screen to close the Help description box.
Using the Contents tab to get help

1. Click the Help menu and click ArcGIS Help.
2. Click the Contents tab.
3. Click the plus sign next to a book to see a list of topics in it.
4. Click the topic you want to read.
5. View the topic in the topic pane on the right.
6. Click the minus sign next to a book to close it.

Times, allowing you to keep track of where you are in the Help system. The Help topics are organized around the tasks you want to complete; they also provide the concepts behind the tasks. Use the Help Contents to look up general topics and see how they are organized. You can also search the index by entering keywords that identify your task. Alternatively, use the Search tab to find Help topics that have specific words or phrases.

To get more precise results, you can perform an advanced search using wildcard expressions, Boolean operators, or nested expressions. Wildcard expressions let you search for one or more characters using a question mark (?) or an asterisk (*). Boolean operators include AND, OR, NOT, and NEAR. Use these operators to define which words should be included and excluded in the topics you want to find. Nested expressions let you create complex searches for information. For examples of advanced search expressions, see the online Help topic ‘Using this Help system’; you’ll find it in the ‘Getting more help’ book in the Contents tab.
Using the Index tab to get help

1. Click the Help menu and click ArcGIS Help.
2. Click the Index tab.
3. In the text box, type one or more keywords representing the topic you want to find.
4. Click the keyword that interests you from the list below, then click Display.
5. If several topics are related to the keyword you selected, the Topics Found dialog box appears. Click the keyword that interests you and click Display.
6. View the topic in the topic pane on the right.
Tip
Searching for words within a topic
You can search for words in the topic you’re currently viewing. Press Ctrl + F on the keyboard to open the Find dialog box, then type the keyword you want to find. The keyword is highlighted everywhere it appears in the current topic.

Finding Help topics containing specific words
1. Click the Help menu and click ArcGIS Help.
2. Click the Search tab.
3. Type the word or words that should be contained in the topics you want to find.
   Your word expression may include an asterisk (*) to represent several characters, or a question mark (?) to represent one character. It may also use Boolean operators, such as AND, OR, NOT, and NEAR.
4. Click List Topics.
5. Double-click the topic you’re interested in.
6. View the topic in the topic pane on the right.
   The word or words you specified are highlighted in the topic.

Tip
Searching for words within a topic
You can search for words in the topic you’re currently viewing. Press Ctrl + F on the keyboard to open the Find dialog box, then type the keyword you want to find. The keyword is highlighted everywhere it appears in the current topic.
Stopping ArcCatalog

Close ArcCatalog when you’re finished working with it. ArcCatalog automatically remembers which folder connections are in the Catalog, which toolbars are visible, and where elements of the ArcCatalog window are positioned. By default, the Catalog also remembers which item was selected in the tree when you closed it and will select that item again the next time you start ArcCatalog.

1. Click the Close button in the ArcCatalog window.
ArcCatalog is the place where you can assemble connections to all the data you need to use. When you select a connection you can access the data to which it’s linked. The connection might access a folder on a local disk, a database on the network, or an ArcGIS server. Together, your connections create a catalog of geographic data sources.

Individual folders and coverages are items in that catalog. If you use ArcInfo Workstation, you’re accustomed to using the term item when referring to a coverage’s attributes; in this book, item refers only to an element in the Catalog tree such as a folder.

This chapter briefly describes the items that appear in the Catalog by default. For more information about data formats and how they model features on the earth’s surface, read *Modeling Our World*. The data sources supported by ArcCatalog can be extended by programmers to include additional data formats; for information about this, read *Exploring ArcObjects*.
When you first start ArcCatalog, the Catalog tree contains *folder connections* that let you access your computer’s hard disks. You can add folder connections that access specific *folders*, or directories, on a local disk; shared folders on the network; or the contents of a floppy or CD–ROM drive when appropriate. You can also remove folder connections that you don’t need.

When you look in a folder connection, you see the items it contains. Unlike Windows Explorer, the Catalog doesn’t list all files on disk. A folder might appear empty in the Catalog even though it isn’t. Only the items that you choose to see will be included in the folder’s contents.

In addition to choosing which geographic data formats you want to work with, you can choose to see files such as Microsoft® Word documents that contain information about your data. To do so, you must add them to the file types list. A *file type* consists of the file extension identifying the file on disk—for example, .doc—the image representing the file type in the Catalog, and a description. See Chapter 5, ‘Building the Catalog’, for more information.

By default, all folders have the same icon. Instead, you might want to use a different icon to represent folders that contain the items you’ve chosen to work with in the Catalog. This can make your geographic data easier to find, especially if you have a large number of folders on a local disk. However, with this option you will experience delays when accessing data across the network.

ArcCatalog also has folders that let you manage Database Connections, Address Locators, connections to GIS Servers, and Search Results. Other folders for managing Coordinate Systems and Toolboxes are hidden by default. These folders are discussed in greater detail later in the chapter. You can hide these folders if you don’t use them.

The next time you start ArcCatalog, there may be a computer on the network, a database, or a GIS server that is unavailable. When you see a little red x on the icon for any of these connections, it implies that they are disconnected; until your connection is reestablished, their data is inaccessible.
Maps, layers, and graphs

You can access maps, layers, and graphs from ArcCatalog. A map is essentially a printed map stored on disk. It can contain geographic data, titles, legends, and North arrows. You can use custom map templates to create a series of maps with the same layout. You can also embed map documents in other documents—for example, in Microsoft Word. Published maps can make your work available to a wider audience by letting people interact with and print your maps using ArcReader™.

Layers include symbology, display, label, query, and relationship information, all of which define how geographic data is drawn on a map. For example, a layer might select specific cities from a shapefile, draw them as blue squares, and label them with text stored in a related table. Layers don’t include the data itself; they reference data sources stored elsewhere.

Layers can be stored either inside a map document or as individual layer files. They are an effective communication tool that can be shared in an organization. For example, you can place predefined layers in a shared folder on the network. By using those layers, others can add data to their maps without having to know where the geographic data is stored, how to join it to a related table, or what each column means.

Several layers can be combined to form a group layer. When added to a map, all layers in the group will be represented by one entry in the table of contents. For example, you might create a group layer representing the background material for a map. Similarly, you could combine road, railroad, and ferry shapefiles into a single transportation theme.

In ArcMap, you can create graphs illustrating the attributes of features or records in a table. For example, your graph could illustrate population density within the regions that appear on the map. By saving a graph to a file you can add graphs with the same format to a series of maps. When added to a map, the graph establishes a link to the data and will change dynamically to reflect the currently selected features or records.
Shapefiles, dBASE tables, and text files

A folder can contain shapefiles, which store geographic features and their attributes. Geographic features in a shapefile can be represented with points, lines, or polygons (areas). The folder might also contain dBASE tables, which can store additional attributes that can be joined to a shapefile’s features. For more information about the shapefile data model see ‘Exploring GIS data’ in the book Getting Started with ArcGIS.

All files that have the file extensions .txt, .asc, .csv, or .tab appear in ArcCatalog as text files by default. However, in the Options dialog box you can choose which of these file types should be represented as text files and which should not be shown in the Catalog tree. When text files contain comma- and tab-delimited values, you can see those values in Table view and join them to geographic features. Text files can be deleted, but their contents are read-only in ArcCatalog.

In a layer’s Properties dialog box, the Joins & Relates tab lets you join attributes stored in a dBASE table or text file to the features in a shapefile. If, instead, a table contains information describing spatial locations, such as x,y,z coordinates or street addresses, you can create a shapefile representing those locations with tools available in the Catalog.

In addition to shapefiles and tables, ArcView® GIS 3 users work with project files, legend files, and Avenue™ scripts. To view these in the Catalog, you must add their file extensions to the Catalog’s file types list. For example, to see ArcView GIS 3 projects in the Catalog, add the file extension .apr to the list. Details about adding file types can be found in Chapter 5, ‘Building the Catalog’.
Coverages and INFO tables

Coverages use a set of feature classes to represent geographic features; each feature class stores a set of points, lines (arcs), polygons (areas), or annotation (text). Feature classes can have topology, which determines the relationships between features.

More than one feature class is often required to define the features. For example, line and polygon feature classes both exist in a coverage representing polygon features. Polygon features also have label points, which appear as a separate feature class. Every coverage has a feature class containing tic points, which represent known real-world coordinates. For more information about the coverage data model see ‘Exploring GIS data’ in Getting Started with ArcGIS.

Feature attributes are stored in a separate INFO table for each feature class in the coverage. Other attributes can be stored in INFO or relational database management system (RDBMS) tables, then joined to features with a layer or a relationship class.

When you look in a folder in the Catalog, you see all the coverages and INFO tables it contains; you don’t see the INFO folder itself. Look in a coverage to see its feature classes; each feature class represents both the features and their associated feature attribute table. For example, after selecting a polygon feature class, you can preview its features and its attributes.

Coverages often have associated files; to see them in the Catalog, add them as file types. For example, to see ARC Macro Language (AML™) scripts, you would add the file extension .aml to the file types list.

PC ARC/INFO® coverages are like ArcInfo coverages except that their attributes are stored in dBASE tables. PC ARC/INFO coverages can be previewed in the Catalog, and you can create metadata for them, but other data management operations, such as copy and paste, are not available.

Coverages created with ArcInfo before version 7 appear dimmed in the Catalog. After converting the workspace using ArcInfo Workstation, you can access their contents in ArcCatalog.
Geodatabases

Geodatabases are relational databases that contain geographic information. Geodatabases contain feature classes and tables. Feature classes can be organized into a feature dataset; they can also exist independently in the geodatabase.

Feature classes store geographic features represented as points, lines, polygons, annotation, dimensions, and multipatches and their attributes. All feature classes in a feature dataset share the same coordinate system. Tables may contain additional attributes for a feature class or geographic information such as addresses or x,y,z coordinates.

Many objects in a geodatabase can be related to each other. For example, tables containing customer addresses and billing information are related, just as state and county feature classes are related. To explicitly define the relationships between objects in a geodatabase, you must create a relationship class. Relationships let you use attributes stored in a related object to symbolize, label, or query a feature class.

Feature classes in a feature dataset can be organized into a geometric network or a topology. A geometric network combines line and point feature classes to model linear networks—for example, electrical networks—and maintains topological relationships between its feature classes. A topology is a set of relationships that define how the features in one or more feature classes share geometry—for example, cities must be properly inside states.

Creating and accessing geodatabases

To manage your own spatial database, you can create a personal geodatabase. If you do this, your data will be stored in a Microsoft Access database. For a multiuser spatial database, use ArcSDE, which lets many people in an organization simultaneously update data stored in a centrally located RDBMS. SDE® for Coverages lets you access coverage, ArcStorm™, or ArcInfo Librarian™ databases just as you would an RDBMS.

You can access personal geodatabases directly in ArcCatalog, but to access data stored in an RDBMS you must add a database connection. To do so, double-click one of the Add Database Connection wizards in the Database Connections folder. You’ll be prompted for information such as your username and password and the database to which you want to connect.

In general, when you create a database connection, you choose the data provider that will retrieve your data from the database. For multiuser spatial databases, ArcSDE is the data provider. Object Linking and Embedding Database (OLE DB) providers generally retrieve nonspatial data only. You can preview these tables in ArcCatalog and join their values to spatial data. If an OLE DB provider can retrieve spatial data and present it in Open GIS Consortium, Inc. (OpenGIS® or OGC), format, you can preview that data in the Catalog.

All database connections are stored in the Database Connections folder by default, but they can be moved elsewhere. For example, you can place a connection that has read-only access to the database in a shared folder where others can access it; they can use it to view the database’s contents in the Catalog without having to know the details of how to connect to the database.

The first time you select a database connection, ArcCatalog tries to connect to the database. If the connection attempt is successful, ArcCatalog will list the items contained in the database. When you see a little red x on the database connection’s icon, it is disconnected; until you have reestablished the connection, you can’t access data stored in the database.

Items in an RDBMS are owned by the user who created them. When ArcCatalog lists the contents of an ArcSDE geodatabase, the owner’s name appears before the item’s name. For example, a feature class named valves that is owned by the user admin would appear in the Catalog as admin.valves. If the RDBMS supports databases, such as SQL Server™, the database name will appear between the owner’s name and the object’s name.
Personal geodatabases let you manage your own data.

Relationship classes define an association between two items in a geodatabase.

A topology establishes a set of relationships that define how several feature classes share geometry.

Tables may contain geographic data or attributes of geographic features.

Database connections let you use data stored in a central database; the data is retrieved using ArcSDE or an OLE DB provider.

In the Database Connections folder you create and manage database connections.

Wizards let you create database connections.

Feature datasets contain a collection of feature classes that share the same coordinate system and whose features are located in the same geographic area.

Geometric networks establish topological relationships among several feature classes that together form a linear network.

Feature classes can contain points, lines, polygons, annotation, dimensions, or multipatches.

Objects in a database are owned by the user who created them; these feature classes are owned by the user myTeam.
Raster data

ArcCatalog lets you directly access raster data in a variety of formats. You can work with many types of images, ESRI grids, and rasters stored in geodatabases. The supported raster file formats are listed in the Catalog’s Options dialog box. All raster data is treated the same in ArcCatalog regardless of format. However, you can make a raster’s format apparent by unchecking Hide file extensions in the Options dialog box.

Raster datasets are comprised of one or more raster bands. A raster band is a rectangular matrix of cells. Individual grids, such as digital elevation models (DEMs), and single-band images appear in the Catalog as raster datasets with one band. Multi-spectral images appear as raster datasets containing several raster bands. For some raster formats, you can see attributes describing a raster dataset in Table view. The attributes may contain descriptive information about the raster’s values, such as land use for a classified image, or they may contain statistics for the raster’s values.

Large file-based rasters can be difficult to work with. Therefore, large raster datasets have traditionally been split into smaller tiles that are stored in separate files on disk. With ArcSDE, the individual tiles can be loaded into one raster dataset to create a seamless raster mosaic.

Raster catalogs contain or reference many associated rasters, which can have various formats and resolutions of raster data. In a geodatabase, a raster catalog contains and manages all of its rasters; the geodatabase can store detailed attributes and metadata describing each raster in the raster catalog. These raster catalogs have a special icon in the geodatabase. Raster catalogs may also be defined using a table that references raster datasets stored in various locations throughout your GIS; these raster catalogs appear as tables in ArcCatalog.

Both types of raster catalogs can be previewed using the Preview tab. In Geography view all rasters in the raster catalog will draw, and in Table view you’ll see a list of all rasters that comprise the raster catalog. With raster catalogs in geodatabases the Contents tab provides special capabilities for working with their contents. You can query, select, and draw individual and sets of rasters in the raster catalog.

Raster catalogs that reference external raster data can be defined using any table format. The table’s columns must be IMAGE, XMIN, YMIN, XMAX, and YMAX. The image column contains the name or path of a raster dataset, and the remaining columns describe its extent.

In an ArcSDE geodatabase, a raster’s name is presented in ArcCatalog as the owner’s name followed by the raster’s name. For example, a raster dataset named KansasDEM that is owned by the user Ryan would appear in ArcCatalog as Ryan.KansasDEM. If the RDBMS stores sets of tables within different databases, such as SQL Server, the database name will appear between the owner’s name and the raster’s name. For example, if the database is USA, the raster dataset’s name would be Ryan.USA.KansasDEM.

For detailed information about working with raster data, please see Chapter 14, ‘Working with rasters’.
Raster datasets contain a rectangular grid of data cells. By showing file extensions, a raster’s format is apparent.

A raster dataset can contain one or more raster bands. Raster bands may have different names depending on the raster’s format.

A raster catalog can be defined using a table that references raster datasets. This type of raster catalog lets you preview many associated raster datasets together.

Raster datasets and raster catalogs can also be stored within geodatabases.

Raster catalogs in a geodatabase directly contain and manage many discrete raster datasets.
TIN datasets

*TIN datasets* can be used to display and analyze surfaces. They contain irregularly spaced points that have x, y coordinates describing their location and a z-value that describes the surface at that point. The surface could represent elevation, precipitation, or temperature. A series of edges join the points to form triangles. The resulting triangular mosaic forms a continuous faceted surface, where each triangle face has a specific slope and aspect.

TINs can be created from several types of data including rasters and point, line, and polygon feature classes that have z-coordinate values. Features used to create TINs ensure that known z-values are maintained in the surface. They may also interrupt the smoothness of the surface to more appropriately represent features, such as streams, dams, building footprints, and so on, where there is an abrupt change in the surface’s slope around the feature.

---

TIN datasets can be used as an alternative to rasters to represent surfaces.
CAD drawings

You can access *CAD drawings* directly in ArcCatalog. CAD drawings typically have many layers, each of which represents a different type of geographic feature. For example, the drawing might contain different line layers for streets, water mains, and parcel boundaries. Other layers in the drawing may represent geographic features with points or polygons or contain annotation for labeling the features.

For each CAD drawing on disk, there is both a CAD dataset item and a CAD drawing item in the Catalog tree. The *CAD dataset* contains point, line, polygon, annotation, and multipatch feature classes. The line feature class, for example, represents all line features in all layers in the drawing and their attributes. Additional feature attributes may be stored in separate tables.

CAD feature classes are drawn in Geography view using the same default symbology used by ArcCatalog when drawing shapefiles and coverages. If you create a layer file from a CAD feature class, you can change the symbology used to draw its features, join attributes stored in separate tables to them, and select which features to display according to their attribute values. You can only analyze and edit features in ArcMap when the layer references a CAD feature class.

In the Catalog tree you’ll also find a CAD drawing item, which represents all features in all layers of the drawing. In Geography view, the CAD drawing item’s features appear with the symbology defined in the drawing itself. When a layer is created from the CAD drawing item, you can choose which of the drawing’s layers it represents. For example, you might want to see only the streets, traffic lights, and street names on your map.

For a list of the CAD formats supported by ArcCatalog, see the online Help topic ‘CAD drawings and datasets’.
The Vector Product Format (VPF) is a U.S. Department of Defense military standard that defines a standard format, structure, and organization for large geographic databases. VPF data is read-only in ArcCatalog. However, you can create Catalog-style metadata if you have write permission where the data is located. There are four levels of VPF data.

A VPF database is a collection of data that is managed as a unit. A VPF library, similar to a Librarian library, is a collection of coverages that fall within a defined extent and use the same coordinate system. A VPF coverage, similar to an ArcInfo coverage, may contain many feature classes. The name of a VPF coverage is the library name followed by the coverage name. For example, a coverage named elev in a library named algiers would appear in the Catalog as algiers:elev. Coverage names are often specified in the VPF product specification.

A VPF feature class is a collection of features (primitives) that have the same attributes. Each feature class contains point (node), line (edge), polygon (face), or annotation features and has an associated feature attribute table. The feature classes within a VPF coverage represent different types of features. For example, a hydrology coverage may have feature classes representing dams, ditches, lakes, and rivers.

A coverage’s features appear continuous even though they may be tiled. They must also interconnect in a manner defined by the coverage’s topology. There are four levels of topology for VPF coverages: 0, 1, 2, and 3. Level 0 coverages have no topological information. Level 3 coverages have full polygon topology.

VPF tables describe the contents of databases, libraries, coverages, and feature classes. They reside within the folder corresponding to each level of data. Tables describing the database appear below its list of coverages. Tables describing a library reside within its folder along with one folder for each coverage. In turn, a coverage’s folder contains tables describing its contents and one folder for each tile, if appropriate.
SDC data

ArcCatalog provides read-only access to data in *Smart Data Compression (SDC)* format. SDC data is encrypted and highly compressed. This format is used by commercial data vendors who distribute street data for geocoding and routing with various ESRI software products.

An *SDC feature dataset* is a table of attributes containing one or more Shape columns. Each Shape column contains a different representation of the same feature. In ArcCatalog you’ll see one *SDC feature class* for each Shape column. All feature classes in the feature dataset will have the same type of features, points, lines, or polygons, and the same set of attributes. An *SDC table* doesn’t contain any Shape columns.

Typically, each SDC feature class would be used at different map scales. For example, an SDC feature dataset representing major highways might have four feature classes: majhwys, majhwys_1, majhwys_2, and majhwys_3. The majhwys feature class contains the most detailed features, while the majhwys_3 feature class contains the most generalized features. A group layer can take advantage of this by showing the majhwys feature class at large scales and the majhwys_3 feature class at small scales.

To create data in SDC format you must use a Data Developer’s Kit. However, ArcGIS provides conversion tools that let you convert SDC data to shapefiles and other formats.
XML documents

XML is similar to HTML. An HTML file contains both data and information about how it’s presented. An XML file contains data only; presentation information is defined in a separate file, a stylesheet. For example, in an HTML file data is embedded within tags that tell a Web browser how it should be presented; `<B>24</B>` will display 24 in a bold font. With HTML you only know what 24 means from the context in which it appears on the page; if it precedes the text °C you would know it represented a temperature.

XML data is embedded within tags that add meaning. For example, `<price>24</price>` declares 24 to be a price. In XML terms this price is referred to as an element. Other elements might be product names, quantities, or totals. While a person can look at the XML and determine that 24 is a price, what’s more important is that software can extract price elements from the file; this isn’t possible with the HTML file, where there is nothing to distinguish 24 from °C.

XML data can be displayed in a Web browser using XSLT stylesheets that transform the XML data into an HTML page. A stylesheet is similar to an SQL query that selects, orders, and formats values from tables in an RDBMS and presents them as a report. You can display the same XML data in many different ways by using different stylesheets. Only values from selected XML elements will appear in the output HTML page.

When metadata is created for items in ArcCatalog, that metadata is stored as XML data either in a file alongside the item or within its geodatabase. In ArcGIS, metadata becomes a part of the item—the metadata is automatically moved, copied, and deleted along with it.

Metadata XML documents that are part of an item don’t appear in ArcCatalog, but standalone XML documents do. These might be metadata documents created outside ArcGIS, metadata templates, or completely unrelated XML documents such as customer orders. You can see the contents of standalone XML documents in the Metadata tab using the XML stylesheet.

A standalone XML document may contain metadata created outside of ArcCatalog, a metadata template, or data unrelated to GIS.
Address locators

An *address locator* lets you convert textual descriptions of locations into geographic features. Different styles of locators let you create features from different types of descriptions. For example, the street addresses in a table may or may not include ZIP Code information. Another locator might give you the area represented by a telephone area code.

Address locators use *reference data* to find locations. A locator’s reference data might be a street centerlines shapefile with information about the address ranges for each section of the street. Using that service, you could take a table containing customer addresses and create a point feature class representing the location of your customers. To geocode a table of street addresses or other location descriptions, right-click the table and click Locate Addresses.

The *Address Locators folder* at the top level of the Catalog tree lets you manage existing and create new locators on your computer. Locators can also be stored within an ArcSDE geodatabase where they can be used by many people in your organization. You may also find ArcView GIS 3 geocoding indexes in folders on disk with the shapefile or coverage data upon which they are based; you can use these geocoding indexes as well. For more information about address locators see the book *Geocoding in ArcGIS.*
ArcIMS servers

The GIS Servers folder lets you manage connections to ArcIMS® servers such as www.geographynetwork.com. An ArcIMS server provides access to searchable metadata services and live data services, which retrieve current data over the Internet. To access secure ArcIMS services you must log in when you connect to the ArcIMS server; these services have a little lock on their icon.

ArcIMS Feature Services are similar to feature datasets. Each ArcIMS Feature Class in the service represents different types of features, which are streamed to you over the Internet. You can add individual ArcIMS Feature Classes to your map and analyze their features in the same manner as a geodatabase feature class.

ArcIMS Image Services and ArcIMS ArcMap Image Services take snapshots of the data on the server and send them to you in raster format. After adding either service to a map, you can turn off specific layers in the service but you can’t export the data or change its symbology. Both services can include vector and raster data. The major difference between these two services is that ArcIMS ArcMap Image Services are based on actual ArcMap map documents (.mxd or .pmf).

An ArcIMS Metadata Service is a searchable catalog of ArcIMS Metadata Documents that describe GIS resources including paper maps, geoprocessing tools, and events such as field surveys. Documents can be organized into folders for browsing. If a document describes an ArcIMS data service, a globe appears on its icon; you can preview the service and add it to your map. If you have permission to publish metadata, the service’s icon will show a hand. To publish an item’s metadata or an XML document, drag the item and drop it onto the Metadata Service.

If an ArcIMS server is unavailable, a little red x appears on its icon; click it in the Catalog tree to reestablish your connection.
**ArcGIS servers**

The *GIS Servers folder* lets you manage connections to ArcGIS Servers. An *ArcGIS Server* provides access to a variety of different GIS objects, such as maps and address locators.

An *ArcGIS Geocode Server* provides access to an address locator, which can provide the spatial location associated with a text description, such as a street address or a ZIP Code. With a Geocode Server the locator’s computations are processed on the computers that host this resource. An *ArcGIS Map Server* lets you view and use ArcMap map documents that are hosted on various computers. When using these documents, what you see is a raster snapshot of the map document.

You can connect to an ArcGIS Server using your local network or the Internet. Some objects that are available locally may not be available over the Internet. No matter how you connect, you will be able to use all the GIS objects that you have permission to access.

When an ArcGIS server is disconnected, a little red x appears on its icon. Double-click the server to reestablish the connection. When connected over the network, the icons of ArcGIS server objects illustrate their status. Objects that are running have ordinary icons. Objects that are starting show a red ellipses (...). Like a media player, objects that are paused show two vertical red lines, and objects that are stopped show a red square.

Administrators for an ArcGIS Server can use ArcCatalog to manage the available services and modify their properties. Administrators can learn more about working with ArcGIS Servers in *ArcGIS Server Developer’s Guide*.
The Search Results folder contains your previous searches. A search is comprised of the name, type, location, spatial, temporal, and keyword criteria that together describe the data you want to find. For example, you can search for raster datasets for the San Francisco area that were created within the last five years by a specific agency.

When you click Find Now in the Search dialog box, your search is saved in the Search Results folder. As ArcCatalog finds items that satisfy your criteria, shortcuts to those items are added to your search’s results list. A shortcut provides a link to an item that resides elsewhere. With a Catalog or File System search you get shortcuts to items in your Catalog. When searching an ArcIMS Metadata Service you get shortcuts to published documents that describe GIS resources. Documents with a globe describe ArcIMS services that you can directly access. Other documents may describe data that is available on a CD–ROM, for example.

You can modify the search’s criteria, if you wish, by opening its Properties dialog box. When you have changed the desired properties and click Find Now, the search’s results will be updated. To see a search’s list of criteria, look at its metadata.

When you select a shortcut in the Catalog tree, you can preview the item’s data and metadata. You can drop a shortcut on a map or modify the item’s properties in ArcCatalog. When you delete a shortcut you delete the shortcut itself, not the actual item. To select the item itself in the Catalog tree, right-click the shortcut and click Go To Target.

The Search Results folder contains your previous searches.

Each search represents a set of criteria defining what you want to find.

Searching an ArcIMS Metadata Service, you find shortcuts to published documents that describe GIS resources; those with a globe describe ArcIMS services.

With a Catalog or File System search, the results consist of shortcuts to items in your Catalog.
Coordinate systems

There are two types of coordinate systems: geographic and projected. Geographic coordinate systems use latitude and longitude coordinates on a spherical model of the earth’s surface. Projected coordinate systems use a mathematical conversion to transform latitude and longitude coordinates that fall on the earth’s three-dimensional surface to a two-dimensional surface.

Each data source stores the parameters that define its coordinate system as an integral part of its data. However, those parameters can also be stored in separate files so that they can be reused when defining data for different projects.

The Coordinate Systems folder provides a location where you can organize coordinate system files. It contains many commonly used coordinate systems that are provided with ArcCatalog. You may have your own custom coordinate systems in other folders that were created with ArcInfo Workstation or with ArcCatalog. If you choose to, you can move those files into the Coordinate Systems folder.

By default, the Coordinate Systems folder is hidden in the Catalog tree. To show or hide the Coordinate System folder, check or uncheck its entry on the General tab in the Catalog’s Options dialog box.
Toolboxes

The Toolboxes folder provides access to all geoprocessing tools. There are three types of tools: system tools, models, and scripts; all tools can be run from a dialog box or from a command line. The system tools provided with ArcGIS let you analyze and modify spatial data. You can create models to run a chain of tools in sequence. Scripts take advantage of the command line to run tools in sequence. Scripts are useful for batch processing, such as converting many datasets to another format or running the same model with a series of different input datasets.

All tools are stored in a toolbox. Within a toolbox, related tools can be organized into toolsets to make them easier to find. A toolset may also contain other toolsets. The toolboxes provided with ArcGIS can be found in the System Toolboxes folder. Toolboxes that you create can be found in the My Toolboxes folder. You might create a toolbox to store system tools that you use frequently or to store new tools that you have created.

ArcToolbox initially provides access to all System Toolboxes. You can delete tools and toolboxes that you rarely use from the ArcToolbox window. However, they aren’t permanently deleted. You can always find them in the System Toolboxes folder and add them to ArcToolbox again later if you need them.

To learn more about geoprocessing and toolboxes, see Geoprocessing in ArcGIS or ‘Geoprocessing’ in the ArcGIS Desktop Help system.

- The Toolboxes folder provides access to all available toolboxes and their tools.
- A geoprocessing model can run a chain of tools in sequence.
- The History toolbox lists all the tools you have used, cataloged by date.
- A toolbox contains a group of related tools. You can create your own toolboxes in the My Toolboxes folder.
- System tools are provided with ArcGIS to let you analyze and modify spatial data.
- Related tools can be organized into toolsets.
- Scripts take advantage of the command line to run other tools—for example, to execute the same process on several different data sources.
When you first open ArcCatalog, you see folder connections that let you access data on your computer’s local disks. Often, however, the data you use isn’t stored on your computer. You can build your own catalog of geographic data by connecting to other disks or folders on the network and adding connections to databases and GIS servers. You can also add file types and hide items that you don’t need for the moment.

When all your data is in one place, you gain more than just an inventory. It becomes easier to find the data. And because you can work with all types of geographic data sources the same way, regardless of their format, your data becomes easier to manage.
Adding folder connections

When you first start ArcCatalog, the Catalog tree has entries for your computer’s hard disks. To access data stored on a CD, floppy disk, or another computer on the network, you must add connections to those locations. A folder connection can point to any folder to which you have access. If only one folder on your computer’s C:\ drive, data, contains GIS data, you don’t have to include the entire C:\ drive in the Catalog tree. Add a new connection that points directly to the C:\data folder, then remove the C:\ drive connection from the Catalog tree. A quick way to do this is to drag the C:\data folder from the Contents tab and drop it on the Catalog at the top of the Catalog tree. To quickly connect to folders that aren’t currently available in ArcCatalog, type the folder’s path into the Location text box and press Enter. If a shared folder is unavailable on the network the next time you start ArcCatalog, a little red x will appear on the folder connection’s icon indicating that it is unavailable. The x disappears when the connection is reestablished.

Connecting to a folder

1. Click the Connect To Folder button.
2. Navigate to the folder or disk that you want to add to the Catalog.
3. Click OK.

A new folder connection appears in the Catalog tree.

Disconnecting from a folder

1. Click the folder connection that you want to remove from the Catalog.
2. Click the Disconnect From Folder button.

The folder connection is removed from the Catalog tree.
Adding spatial database connections

With ArcCatalog, you can explore and manage geographic data stored in an RDBMS through ArcSDE. Similarly, SDE for Coverages lets you access coverage, ArcInfo Librarian, and ArcStorm databases the same way you access data from an RDBMS. To access these spatial databases, you must add a connection to the Catalog. You aren’t required to type your username and password to create a connection; however, if you don’t, you will be prompted to enter them when a connection is established. Further, you can type your username and password and create a test connection if you’re unsure whether the information you have is correct. If the connection test fails, contact the database administrator to ensure the database is operational. You can still add this connection to the Catalog but will be unable to retrieve data until the problem is resolved. After creating a test connection, uncheck Save name and password if you prefer not to save your login information as part of the connection. Choosing not to save login ►

Connecting to a spatial database

1. Click the Database Connections folder in the Catalog tree.
2. Double-click Add Spatial Database Connection.
3. Type the name or IP address of the server to which you want to connect.
4. Type the name or port number of the service to which you want to connect.
5. If the data is stored in a Sybase®, SQL Server, IBM® DB2®, or Informix® RDBMS, type the name of the database to which you want to connect.
   - If the data is stored in another RDBMS, skip this step.
6. Type your username and password for accessing the data.
7. Click Test Connection.
   - If the test was successful, the button becomes unavailable.
   - If the test fails, you won’t be able to retrieve data until you’ve provided the correct information or the database problem has been resolved.
8. Uncheck Save Name/Password if you don’t want this information saved with the connection. ►
Connecting to a specific version of the database

1. Follow steps 1 through 8 for connecting to a spatial database.
   You must provide complete connection information for the database including your username and password.

2. Click Change.

3. Click the Version dropdown arrow and click the version of the database that you want to access.

4. Click OK.

5. Uncheck Save Version if you don't want to connect to the same version of the database each time.

6. Click OK.

7. Type a new name for the database connection.

8. Press Enter.
Adding OLE DB connections

You can use OLE DB providers to retrieve data from a database. The Catalog communicates with all OLE DB providers in the same way, with each provider, in turn, communicating with a different database. This standard lets you work with data from any database in the Catalog in the same way.

Looking in an OLE DB connection, you’ll see a list of tables in the database. If the provider can retrieve spatial data in OpenGIS format, you may also see feature classes.

Microsoft’s OLE DB providers come with ArcCatalog. They let you access Jet (Microsoft Access), SQL Server, and Oracle databases. Another provider communicates with open database communication (ODBC) drivers. Additional OLE DB providers may be available from other sources.

The Connection tab is different for each provider, although they all require similar information—the database to which you want to connect and your username and password. Each provider should have a Help topic with specific information on how to create a connection.

1. Double-click Database Connections in the Catalog tree.
2. Double-click Add OLE DB Connection.
3. Click the OLE DB provider you want to use for accessing data.
4. Click Next or click the Connection tab.
5. Provide the required connection information.
6. Click Test Connection.
7. Click OK if the connection test was successful.
8. Type a new name for the connection.
Working with database connections

Database connections are either connected or disconnected. All connections are disconnected when you start ArcCatalog. The first time a connection is selected, the Catalog attempts to connect to the database. If your login or version information isn’t saved with the connection, you’ll be prompted for it. When a connection is established, you can access the database’s contents. Database connections remain connected until ArcCatalog is closed or you can disconnect manually. You could make a local copy of the data and disconnect before editing it onsite. The strategy you choose for connecting and disconnecting affects the number of licenses available to others who must access the database.

If the database is moved to a new computer, or the usernames and passwords for accessing its contents change, you must update your database connections, as well as the source information for layers that access data in that database, with the new connection information.

Connecting to a database

1. Click the database connection you want to use.
2. If your username and password aren’t saved with the database connection, a login dialog box will appear. Type the required information, then click OK.
   The red x disappears from the database connection’s icon.

Disconnecting from a database

1. Right-click the database connection that you want to disconnect.
2. Click Disconnect.
   A red x appears on the database connection’s icon.
Repairing a database connection

1. Right-click the database connection you want to fix and click Connection Properties.

   The appropriate dialog box appears for spatial or OLE DB database connections.

2. Change the connection properties. For example, change your username and password.

3. Click OK.
Connecting to GIS servers

To access services provided by a GIS server, add either an ArcGIS or an ArcIMS server connection to ArcCatalog. To connect to either an ArcGIS or an ArcIMS server over the Internet, you must provide the Universal Resource Locator (URL) that uniquely identifies the server on the Internet. For ArcGIS servers you can also connect over your local network; to connect you must provide a Local Area Network address such as the name of the computer.

Your connection can either access all the services provided, or you can choose the specific services in which you are interested. In addition to the services that are freely available, you may have permission to access secure services. For ArcIMS servers to include secure services in the list, you must provide a username and password before clicking Get List.

Upon starting ArcCatalog, all GIS servers are disconnected; a little red x will appear on the icons indicating that they are unavailable. The first time you open a GIS server, ArcCatalog connects to it. If your

Adding an ArcIMS server

1. Double-click GIS Servers in the Catalog tree and double-click Add ArcIMS Server.
2. Type the URL of the ArcIMS server to which you want to connect—for example, type “http://www.geographynetwork.com”.
3. If you don’t want to connect to all services, click Just the following service(s) and click Get List.

A list of all services that are freely available on the server appears below. Check the services you want to use.
4. Click OK.
5. You can rename the ArcIMS server to one that is more meaningful for you.

Right-click the IMS Server name and click Rename, then enter a new name.
6. Press Enter.
Accessing secure ArcIMS services

1. Double-click ArcIMS Servers in the Catalog tree and double-click Add ArcIMS Server.
2. Type the URL of the ArcIMS server to which you want to connect.
3. Check Show secure services.
4. Type the User name and Password for accessing the secure services that are available to you.
5. If you don’t want to connect to all services, click Just the following service(s) and click Get List.
   The list of services that appears below includes all free services provided by the ArcIMS server as well as the secure services that you have permission to access.
6. Check the services you want to use.
   Uncheck the services you don’t want to use.
7. Click OK.
8. Type a new name for the ArcIMS server.
Connecting to an ArcGIS Server

1. Double-click the GIS Servers folder in the Catalog tree and double-click Add ArcGIS Server.

2. Click either Local Server or Internet Server in the Add ArcGIS Server dialog box.

3. Type the name or URL of the ArcGIS Server to which you want to connect.

4. If required, type your User name and Password for accessing the server, then uncheck Save Name/Password if you don’t want this information saved with the connection.

5. If you don’t want to connect to all server objects, click Just the following resource(s) and click Get List.
   A list of all server objects that you have permission to access appears below. Check the objects you want to use.

6. Click OK.

7. You can rename the ArcGIS server to one that is more meaningful to you.
   Right-click the ArcGIS server name and click Rename, then enter a new name.
Hiding folders and items

The Catalog lets you work with data sources in many different formats and has folders that help you manage them. You can customize the Catalog to show only the folders and items with which you want to work. For example, you might only want to see the shapefiles in a folder, not the coverages and CAD drawings. When you first start ArcCatalog, the Database Connections, GIS Servers, Geocoding Services, and Search Results folders are visible. If you don’t use data stored in a remote database or provided by a GIS server, you can hide those folders. If you don’t use geocoding services or the Catalog’s Search tool, you can hide those folders as well. Similarly, show the Coordinate Systems folder when you want to modify its contents. Check the items you want to see and uncheck those you want to hide in the General tab in the Catalog’s Options dialog box.

1. Click the Tools menu and click Options.
2. Click the General tab.
3. Uncheck the items and folders you want to hide in the Catalog.
   Check the items and folders you want to show in the Catalog.
4. Click OK.
Changing a data format’s properties

Some data formats let you set properties that control how they behave in the Catalog. For example, by default the text files you see in the Catalog are files stored on disk that have the file extensions .txt, .csv, .tab, or .asc. These file extensions are commonly used to denote files that contain American Standard Code for Information Interchange (ASCII) data. You can change the properties of text files and control which ones will appear in ArcCatalog. If files with the .csv extension are the only ones on your computer that describe geographic features, you might want only those files to appear in the Catalog as text files.

Similarly, you can change which files appear as CAD drawings in ArcCatalog. One of the CAD formats supported by ArcCatalog is a MicroStation design file. Typically, data in this format is stored in files with the file extension DGN, but this isn’t always the case. If you want ArcCatalog to check all files in a folder to see if they contain DGN data, check the option to do so on the CAD.

Changing how text files appear in ArcCatalog

1. Click the Tools menu and click Options.
2. Click the General tab.
3. Click Text Files in the list.
4. Click Properties.
5. Check the file extensions that you want to appear in ArcCatalog as text files.
6. Click OK.
7. Click OK.
Changing how CAD files appear in ArcCatalog

1. Click the Tools menu and click Options.
2. Click the CAD tab.
3. Check Examine all file extensions if you want ArcCatalog to examine all files in a folder to see if they contain DGN data.
4. Click OK.
Adding file types

Many files that you would see in a folder using Windows Explorer aren’t initially visible in ArcCatalog. Some of these files may contain information that you need when working with geographic data. To see them, you must add their types to the Catalog’s file types list.

Create your own file type by defining the file extension, description, and the icon you want to use to represent those files. Files with that extension will appear in the Catalog with that icon, and the description will appear in the Type column in Details view. For example, to see ArcView GIS 3 project files in the Catalog, add the file extension apr to the file types list.

Some of the files you want to see in the Catalog may already be registered with the operating system, such as Microsoft Word documents. You can add file type information for these files to the Catalog using the information in the registry. When you double-click a file whose type is registered with the operating system, ArcCatalog will open it in the appropriate application.

Defining a file type

1. Click the Tools menu and click Options.
2. Click the File Types tab.
3. Click New Type.
4. Type the file extension.
5. Type a description of the new file type.
6. Click Change Icon.
7. Click an icon.
   Or click Browse, then navigate to and click the application whose icon you want to use for the file type, and click Open.
8. Click OK in the Change Icon dialog box.
9. Click OK.
   The new file type is added to the list.
10. Click OK.
Importing a file type

1. Click the Tools menu and click Options.
2. Click the File Types tab.
3. Click New Type.
4. Click Import File Type From Registry.
5. Scroll down until you see the file type you want to use and select it in the list.
6. Click OK.
   The file type's properties appear in the File Type dialog box.
7. Click OK.
   The file type is added to the list.
8. Click OK.

Tip

Editing a file type

Edit the properties of a file type to change the description that appears in Details view or to change the icon used to represent it in the Catalog. Select the file type in the File Types tab of the Options dialog box, then click Edit. Modify the appropriate properties, click OK, then click OK in the Options dialog box.
Managing the Catalog’s contents

IN THIS CHAPTER

- Viewing an item’s contents
- Working in Details view
- Changing the columns you see
- Exploring an item’s properties
- Organizing your data
- Converting data to a different format

With the Catalog tree and the Contents tab you get a bird’s-eye view of how your data is organized. The Catalog has many built-in functions that make managing your data easy. Copy, move, rename, and delete items in folders and databases using standard Windows shortcuts. Several scripts and tools are also available for converting your data from one format to another.

With ArcCatalog, you can quickly learn a great deal more about a data source than just its name. The Contents tab provides different ways of listing the contents of items in the Catalog. You can see thumbnail snapshots illustrating the contents of maps and data sources. Or customize the columns that appear in Details view so you can compare the properties and metadata of several data sources at a glance. There are a few additional capabilities, such as querying, when working with raster catalogs. For more information on this, see Chapter 14, ‘Working with rasters’.

Whether you use it to browse for data to add to maps or manage your organization’s ArcSDE geodatabase, ArcCatalog is bound to become a permanent feature on your desktop!
Viewing an item’s contents

In the Contents tab, items that contain subsets of items, such as folders, databases, coverages, and feature datasets, appear at the top of the Contents list and are grouped by type. This behavior is similar to Windows Explorer, which also places folders at the top of its contents list. Individual items, such as shapefiles, maps, and tables, are listed below in one group. Even though raster datasets may contain several raster bands, they are not grouped separately at the top of the list because they can be either single-band or multiband rasters.

Listing an item’s contents

When you select items, such as folders or databases, in the Catalog tree, the Contents tab lists the items they contain, such as maps or tables. You can display the Contents list in several ways. To change its appearance, use the buttons on the Standard toolbar.

Large Icons view

In Large Icons view, each item in the Contents list is represented by a large icon. The icons are ordered from left to right in rows increasing from top to bottom.

List view

In List view, each item in the Contents list is represented by a small icon. The icons are ordered from top to bottom in columns increasing from left to right.
Details view

In Details view, each item in the Contents list has a small icon. The items are arranged in a long list. Properties for each item appear in columns. By default, there are only columns describing the item’s Name and Type, but you can add columns representing other properties and information stored in the metadata. If a property is inappropriate, the item’s value for that property is blank. For example, the file size of a dBASE table is well-known, but this property doesn’t apply to tables stored in a database.

<table>
<thead>
<tr>
<th>Contents</th>
<th>Preview</th>
<th>Metadata</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>geo</td>
<td>Folder</td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td>Folder</td>
<td></td>
</tr>
<tr>
<td>deutschland</td>
<td>Personal Geodatabase</td>
<td></td>
</tr>
<tr>
<td>france</td>
<td>Coverage</td>
<td></td>
</tr>
<tr>
<td>d24 well in manufacturing</td>
<td>Layer</td>
<td></td>
</tr>
<tr>
<td>fr - ha in vineyards</td>
<td>Layer</td>
<td></td>
</tr>
<tr>
<td>france</td>
<td>Map Document</td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>Map Document</td>
<td></td>
</tr>
<tr>
<td>gis - ha in olives</td>
<td>Layer</td>
<td></td>
</tr>
<tr>
<td>gis city</td>
<td>Shapefile</td>
<td></td>
</tr>
<tr>
<td>gis Legh</td>
<td>Shapefile</td>
<td></td>
</tr>
<tr>
<td>Greece</td>
<td>Map Document</td>
<td></td>
</tr>
</tbody>
</table>

Viewing the contents of individual items

Items, such as maps, shapefiles, and tables, don’t contain other items. When you select individual items, the Contents tab lists the properties and metadata that you would see in Details view as well as the item’s thumbnail.

Thumbnails view

Thumbnails view displays a snapshot illustrating the contents of each item in the Contents list. A thumbnail might provide an overview of all features in a coverage or a detailed look at the features symbolized by a layer. If an item can’t or doesn’t have a thumbnail, its icon is displayed in a gray box.

For all items except maps, thumbnails are created and updated manually in Geography view. A map’s thumbnail is created automatically when it is saved.
Working in Details view

Sometimes you need information about an item before you can decide whether or not to use it. Details view can show you a few properties and metadata elements for the items in the list so you can quickly see some of the differences between them. To better see the values for a property, resize a column. To compare the items in the list, sort them by a property’s values.

Changing a column’s width

1. Click the item whose contents you want to list in the Catalog tree.
2. Click the Contents tab.
3. Click the Details button on the Standard toolbar.
4. Position the mouse over the edge of the column you want to resize. The pointer’s icon changes.
5. Drag the column’s edge to the desired width and drop it. The column is resized.

The column has been resized.
Sorting the Contents list by a property

1. Click the item whose contents you want to list in the Catalog tree.
2. Click the Contents tab.
3. Click the Details button on the Standard toolbar.
4. Click the heading of the column whose values will be used to sort the list.
   The first time you click the column heading, its values are sorted in ascending order.
5. Click the column heading again to sort the list in descending order.

The Contents list is sorted by the property's values.
Changing the columns you see

When you start using ArcCatalog, you’ll see two columns in Details view that show the Name and Type of each item. You can add columns that show additional properties or information stored in the item’s metadata. Check the columns you want to see in the Contents tab in the Options dialog box. When an individual item is selected in the Catalog tree, the values that would appear for that item in all columns in Details view are listed in the Contents tab. A column may not apply to all items. For example, the Size and Modified properties in the standard columns list apply to maps and layers, but no values will appear in these columns for data stored in a database. Values won’t appear in metadata columns if metadata hasn’t been created for an item or if the element it corresponds to is empty.

You can add your own property and metadata columns to the lists in the Options dialog box. To do so, you must type the exact name of the property or metadata element into the Property text box in the Add Standard Column or Add Metadata Column dialog box.

Showing and hiding standard and metadata columns

1. Click the Tools menu and click Options.
2. Click the Contents tab.
3. Check the properties and metadata elements you want to show in Details view.
   Uncheck the properties and metadata elements you want to hide in Details view.
4. Click OK.

All the checked properties and metadata elements appear in Details view and in Individual Item view.
Adding columns to the list

1. Click the Tools menu and click Options.
2. Click the Contents tab.
3. Click Add under the list of standard or metadata columns.
4. Type the column name in the Caption text box as it should appear in Details view. In the Property text box, type the name of the property or the metadata element’s path.
   - Or, click the Caption or Property dropdown arrow and click the property or metadata element that you want to add to the list.
5. Type an appropriate default width for this column in pixels, if desired.
6. Click OK.
   - The new column is added to the appropriate list.
7. Click OK.
   - The new column is added to the appropriate list.
its short name as defined in the CSDGM—cloud and dataqual, respectively. The dataqual element is contained in the root element of the XML document, metadata. To add this Cloud Cover element as a column in Details view, provide the path dataqual/cloud in the Property text box; the root element isn’t included in the path. If you’re not familiar with the CSDGM or the ESRI Profile on FGDC Metadata, you can determine a metadata element’s path by looking at metadata with the XML stylesheet.

All columns that are listed in the Options dialog box by default appear in the Caption and Property lists in the Add Standard Column and Add Metadata Column dialog boxes. If you delete a default column, you can add it again later by choosing its caption or name from either the Caption or Property dropdown lists.

Tip

Changing the order of columns
Because you can’t move columns in Details view, you must control the order in which they appear in the Options dialog box. Columns will appear in order from the first standard column to the last metadata column in the list.

Rearranging columns

1. Click the Tools menu and click Options.
2. Click the Contents tab.
3. Click the property or metadata column whose position you want to change in the list.
4. Click the Up and Down arrows to change the column’s position.
5. Click OK.

Removing columns

1. Click the Tools menu and click Options.
2. Click the Contents tab.
3. Click the column that you want to remove from the list.
4. Click Remove.
The column no longer appears in the list.
5. Click OK.
Exploring an item’s properties

While useful, Details view can only provide you with a limited amount of information. To learn more about an item, open its Properties dialog box. If you have write permission for the data source, you may be able to change some of its properties. For example, when looking at a raster’s properties, you can find out if statistics have been calculated or if its coordinate system has been defined. If you have write permission, you can update these properties.

1. Right-click the item whose properties you want to see.
2. Click Properties.
3. Examine the properties using the tabs and buttons in the Properties dialog box.
4. Click Cancel to dismiss the Properties dialog box.
Organizing your data

With ArcCatalog, managing maps and geographic data is as easy as managing files with Windows Explorer. Use the standard Windows shortcuts and drag and drop techniques to copy, move, rename, and delete items in the Catalog. These features make it easy to organize not only data sources on disk, such as coverages and shapefiles, but data stored in databases as well.

Keep in mind that when you delete a database connection, you are deleting the connection itself, not the database or its contents. However, when you delete a personal geodatabase, you are deleting the Access database file and all the data it contains.

You can copy or move items, such as database connections and coordinate systems, to and from their folders in the Catalog tree and other folders on disk. For example, you can place ArcSDE geodatabase connections and custom coordinate systems in a shared folder on the network so everyone in your organization can access them.

Creating a new folder

1. Click the folder connection or folder in which you want to create a new folder.
2. Click the File menu.
3. Point to New and click Folder.
4. Type a new name for the folder.
5. Press Enter.

Creating a new personal geodatabase

1. Click the folder connection or folder in which you want to create a new personal geodatabase.
2. Click the File menu.
3. Point to New and click Personal Geodatabase.
4. Type a new name for the personal geodatabase.
5. Press Enter.
Tip

Renaming coverage feature classes

*With ArcCatalog, you can rename an entire coverage and also rename region and route feature classes within a coverage.*

---

**Copying an item**

1. Click the item you want to copy.
2. Click the Copy button.
3. Click the folder or geodatabase to which you want to copy the item.
4. Click the Paste button.

---

**Renaming an item**

1. Click the item you want to rename.
2. Click File and click Rename.
3. Type the new name.
4. Press Enter.

---

**Deleting an item**

1. Click the item you want to delete.
2. Click the Delete button.
Converting data to a different format

Converting data from one format to another is a common task, usually done at the beginning of a project. You might receive data in Interchange (.e00) format and have to import that data to a coverage. Or, you might export data from a geodatabase to a shapefile before sending it to someone else.

ArcCatalog makes it easy to change a data source’s format. Right-click the data source whose format you want to change and point to Export. A list of the data converters that are appropriate for the selected data source will appear. Similarly, when a geodatabase is selected, you can import data from several different formats.

The data converters are scripts and tools that are provided in the ArcToolbox. Conversion parameters will be set to suggested values based on the data source’s format and the type of data it contains. However, you can change those parameters and export the data to a different coordinate system. You can also choose which attributes are exported and what their new names will be.

You can convert many items at once. For example, if you want to load several tables into a geodatabase, select the folder in which they reside in the Catalog tree. While holding down the Ctrl key, click the appropriate tables in the Contents list. Click the File menu, point to Export, then click Table to Geodatabase. The Table To Geodatabase tool appears with a batch grid at the bottom. There will be one row in the grid for each table.

You can add rows to or delete rows from the batch grid using the appropriate buttons on the tool. You can set conversion parameters for each table individually or set parameters for many tables at once. Select the appropriate rows in the batch grid before setting parameters for those tables.

Click the Help button for detailed instructions about how to use the data converters. There are many data conversion tools available in the ArcToolbox. You’ll also find data management and analysis tools.
Exploring an item’s geography

IN THIS CHAPTER

- Previewing an item’s geographic data
- Exploring geographic data
- Creating thumbnails

In ArcCatalog, you can preview an item’s geographic data without first having to create a map. Who hasn’t been told about a map they can use, then promptly forgotten its name even though they remember what it contains? Now you can look at a map in the Catalog to make sure it’s the one you want before opening it in ArcMap.

Have you ever been almost certain that two coverages with different names actually contain the same data? You can zoom in and pan around to get a good look at their features to decide which coverage has the most recent data. The Geography view in ArcCatalog lets you quickly decide which maps and data sources you want to use.
Previewing an item’s geographic data

The Preview tab lets you see a selected item’s geographic data. For items that contain both geographic data and tabular attributes, you can toggle between the Geography and Table views using the dropdown list at the bottom of the Preview tab.

Geography view draws each feature or annotation in a vector dataset, each cell in a raster dataset, and each triangle in a TIN dataset. When you are previewing data in Geography view, the Geography toolbar is active. You can explore the selected item’s geographic data using the buttons on the Geography toolbar.

Thumbnails illustrate the contents of items containing geographic data. Once created, they can help you find the data you need quickly and easily. For all items except maps, thumbnails are created manually by clicking the Create Thumbnail button on the Geography toolbar. The thumbnail, which records exactly what you see in Geography view, is stored within the item’s metadata.

How ArcCatalog draws geographic data

When a feature dataset, coverage, or any other type of dataset is selected in the Catalog tree, the feature class within that dataset with the highest level of geometry will be drawn. For example, if you select a polygon coverage, the first polygon feature class found in that coverage will draw. The same rule is used when drawing a geometric network.

When ArcCatalog draws vector data, features are drawn using default symbology defined by ArcCatalog: polygons and multipatches are yellow, lines are blue, points are black diamonds, annotation is gray text, and dimensions are black. Thumbnails for vector data sources show the data in the same manner as the preview because symbology is not stored with the data source; layers store symbology information but not data. There are two exceptions to this rule: CAD drawings and geodatabase feature classes that have subtypes.

A CAD drawing has two representations in the Catalog tree: a CAD dataset item and a CAD drawing item. The CAD dataset has point, line, and polygon feature classes. With a line feature class, you’ll see all line features in the drawing. As with shapefiles, CAD feature classes are drawn with the Catalog’s default symbology.

If you select the CAD drawing in the Catalog tree, each layer in the drawing is drawn with the symbology defined in the CAD drawing. Lot, building, tree, and road lines all have different symbology if they are in different layers in the drawing. You’ll also see point, polygon, and annotation features.
Feature classes in a geodatabase can have subtypes, which represent different categories of features. For example, lots might be residential, commercial, or agricultural. When previewing a feature class with subtypes in Geography view, each feature is symbolized according to its subtype.

A raster dataset’s appearance in Geography view depends on how many raster bands it has. If there is only one raster band, the cell values are symbolized using a grayscale color ramp unless the raster dataset has a colormap. Colormaps define the color that will be used to represent a specific value.

Raster datasets with more than one raster band are displayed by creating a composite image. In the Options tab, you can specify which raster bands supply the red, green, and blue display values. For example, if a remotely sensed image had seven bands, you might want to see bands five, four, and three.

Raster catalogs can be objects in geodatabases. They may also be defined using a table. Either way, ArcCatalog will draw raster catalogs in Geography view. All rasters in the raster catalog will draw in the order in which they were added.

TIN datasets are drawn using the Catalog’s default symbology. A triangle’s color reflects its elevation. Any mass points and break lines that were used to create the TIN will be drawn as part of the TIN dataset.

Layers include a shortcut to data that’s stored elsewhere and information about how to symbolize and label the data. For example, the size of a city point might reflect its population, and the symbol used to represent a city might reflect whether or not it is a capital city. When you preview a layer in the Catalog, you see it exactly as it will appear in a map.

Layers may also include instructions for joining attributes stored in another table to the data, a choice of which attributes are available in the map, and even alternate names for those attributes that are more descriptive.

Group layers combine data from many data sources; when added to a map, there is one entry in the table of contents for the group. For example, a group layer named transportation might combine highway, road, and trail coverages. Group layers can combine data sources that have different formats, such as TIN datasets and shapefiles.

Not only can you preview individual data sources, layers, and graphs, but ArcCatalog can also draw map documents, map templates, and published maps in Geography view. This lets
you decide whether or not you’ve found the correct map before opening it.

In ArcMap, you can also create graphs that describe the relationships between the attributes of different features. Once created, graphs can be saved to disk. This lets you add a graph with the same format and colors to several maps. For example, the same graph format used in different maps might compare how prevalent a group of industries are in different regions of the country. Before adding a graph to a map, you can look at its contents in Geography view.

When you do a search in ArcCatalog, the results of your search consist of shortcuts to items in the Catalog or published documents that describe GIS resources. If you select a Search in the Catalog tree, Geography view will show you an overview describing where on the earth’s surface the items that were found by the search are located.

Overall, Geography view is quite useful. The remaining tasks in this chapter show how to use the tools in Geography view to explore your data.
Exploring geographic data

When the selected item in the Catalog tree contains geographic data, you can preview that data without having to create a map—simply choose Geography from the Preview dropdown list on the Preview tab. In Geography view, each feature in a vector dataset, each cell in a raster dataset, or each triangle in a TIN dataset is displayed. Explore the data using the buttons on the Geography toolbar. You can zoom in, zoom out, and pan around to see different areas or reset the display to draw the entire dataset. With the Identify tool, you can click a feature, raster cell, or TIN triangle and see a list of its attributes.

Zooming in on a data source

1. Click the Zoom In button on the Geography toolbar.
2. Drag a box over an area to see it in detail or click an area to center it in the display; it will zoom in by 10 percent.

After you zoom in, the scale of the displayed features is larger.

Tip
Stop drawing
You can press the Esc key at any time while you are previewing geographic data to stop ArcCatalog from drawing the data.

Tip
Zooming out
Zooming out on a dataset is the exact opposite of zooming in. After clicking the Zoom Out button, click or drag a box over the dataset.
Panning around a data source

1. Click the Pan button on the Geography toolbar.
2. Click and drag the geographic data in the display and drop it in a new location.

After panning, you'll see the features in a new geographic area.

Tip
Seeing the entire dataset
After zooming and panning around a dataset, if you want to see its entire contents again, click the Full Extent button on the Geography toolbar.

Tip
Where is the data?
When exploring data in Geography view, as you move the cursor around the canvas, the ArcCatalog status bar shows you the coordinates of the cursor's location.
Identifying geographic data

1. Click the Identify button on the Geography toolbar.
2. Click the feature, raster cell, or TIN triangle whose attributes you want to see.

The feature flashes or the cell or triangle is singled out, and its attributes appear in the Identify Results window.

The attributes of the feature, raster cell, or triangle appear in the Identify Results window.
Creating thumbnails

Maps, layers, and data sources can have a thumbnail that appears in the Contents tab and in the item’s metadata when you use the ESRI stylesheet. A thumbnail illustrates the geographic data in a data source, the features a layer represents, or a map’s layout. It might show an overview of all features or a close-up illustrating a layer’s symbology. Thumbnails draw quickly because they are snapshots; the Catalog doesn’t draw the data itself when displaying a thumbnail.

You must create and update thumbnails for items manually. You might update a layer’s thumbnail after changing its symbology. Thumbnails are stored in the item’s metadata. If metadata doesn’t exist before creating a thumbnail, metadata will be created automatically, but it will only contain the thumbnail. Adding properties and documentation to the metadata is a separate process.

1. In the Catalog tree, click the layer for which you want to create a thumbnail.
2. Click the Preview tab.
3. Click the Preview dropdown arrow on the Preview tab and click Geography.
4. Click the Zoom In button on the Geography toolbar and zoom to the area that best represents the layer’s contents.
5. Click the Create Thumbnail button.
Exploring the values in a table

Whether you want to know if a data source has a specific attribute or if its values are correct, you can find the answer in ArcCatalog. You can sort a table’s records by the values in one or more columns, get statistics describing a column’s values, or locate a specific value in a table. When exploring values, you can easily add and delete attributes without having to open the data source’s Properties dialog box. Table view lets you learn a lot about the contents of a table without having to create a map.
Previewing the values in a table

The Preview tab lets you explore the selected item’s data in either Geography or Table view. For items that contain both geographic data and tabular attributes, you can toggle between Geography and Table view using the dropdown list at the bottom of the Preview tab. This chapter focuses on Table view.

In Table view, the table’s columns and rows and the value for each cell are displayed. Explore the table’s contents using the scroll bars and the buttons at the bottom of the table. Once you click inside the table, you can also use the arrow keys on your keyboard to explore its contents.

Unlike ArcMap, you can’t select records while exploring a table’s values in ArcCatalog; you can only view all the records in a table.

When working with tables stored in databases, many people may view and edit a table’s contents at the same time. If the values in the table you’re previewing are changing, you may want to reload the table’s contents periodically to ensure you’re working with the most current values. Click Options at the bottom of the table and click Reload Cache to refresh the table’s values.

By default, an asterisk next to the column name indicates the values in that column are indexed.

From the Options menu you can reload the table’s values.

Total records in the table. An asterisk means the total hasn’t yet been determined.

Current Record button.

Beginning of table.

Previous record.

Type a number in the Current Record text box and press Enter to make it the current record. The number of the first record is zero.

End of table.

Next record.
Setting the font, highlight color, and index character

1. Click the Tools menu and click Options.
2. Click the Tables tab.
3. Click the Selection color dropdown arrow. In the color palette, click the color you prefer to use for selected columns.
4. Click the Table Font dropdown arrow and click the font you prefer. Type the font size you want to use or pick a size from the dropdown list. If you want to set the font’s color, click the font color dropdown arrow and click the text color you prefer.
5. Type the character to use when indicating whether or not a column has an index associated with it. Uncheck Show index fields with if you prefer not to see which columns are indexed.
6. Click OK.

The appearance of all tables changes according to the settings in the Options dialog box.
columns remain fixed. Freezing a table’s columns can be helpful when exploring its contents. Suppose a shapefile represents all counties in a state, and its attributes describe the demographics of each county. By freezing the county name column, you can easily place other attribute columns next to it and learn which county has how many households or farms. After unfreezing a column, it reappears in the table to the left of the other scrolling columns. The changes you make when resizing, repositioning, and freezing a table’s columns are lost when you select a different data source in the Catalog tree.

**Changing a column’s width**

1. Position the mouse over the right edge of the column you want to resize.
   - The pointer’s icon changes.
2. Drag the column’s edge to the desired width.
   - A black line indicates where the right edge of the column will be located.
3. Drop the edge of the column.
   - The column is resized.

The column has been resized.
Repositioning a table’s columns

1. Click the heading of the column you want to move.
2. Click the column’s heading again, but hold down the mouse button.
   The pointer’s icon changes.
3. Drag the column heading to where you want the column to appear.
   A red line indicates where the column will be located.
4. Drop the column.
   The column appears in the new position.

The column has been moved to a new position.
**Freezing a column**

1. Press the Ctrl key on the keyboard and click the headings of the columns that you want to freeze.
2. Right-click the heading of one of the selected columns and click Freeze/Unfreeze Column.

   The columns are frozen.

---

**Tip**

**Rearranging frozen columns**

After freezing more than one column, you may want to arrange them in a logical order. Not only can you rearrange columns in the main body of the table, but you can also rearrange columns within the frozen section of the table.

**Tip**

**Unfreezing columns**

It is also possible to unfreeze columns. Simply right-click the heading of the frozen column you wish to unfreeze, then click Freeze/Unfreeze Column.

The column has been frozen.
Calculating statistics

When exploring a data source’s contents, you can get statistics describing the values in numeric columns. You’ll see how many values the column has as well as the sum, minimum, mean, maximum, and standard deviation of those values. A histogram is also provided showing how the column’s values are distributed. Statistics are calculated for all numeric columns in the table. To see a description of another column’s values, click its name in the Field dropdown list.

1. Right-click the heading of a column that contains numeric data.
2. Click Statistics.
   In the Statistics dialog box, you’ll see information about the values in the column whose heading you clicked.
3. If you want to see statistics for another numeric column, click the Field dropdown arrow and click the column’s name.
4. Click the Close button when you are finished exploring the statistics.
Sorting records in a table

Sorting the rows in a table lets you more easily derive information about its contents, such as which county had the highest rent last year. After sorting a column’s values in ascending order, the values are ordered from A to Z or from 1 to 10. With descending order, a column’s values are arranged from Z to A or from 10 to 1. Sometimes it’s helpful to sort a table’s rows by more than one column. For example, it might be more helpful to sort the counties first by state, then by rent—the effect is similar to producing a report. To sort by more than one column, you must first arrange and select the columns that you’ll use for sorting; the columns must be arranged in order from left to right. The values in the selected column farthest to the left will be used to sort the records first, and the values in the selected column farthest to the right will be used to sort the records last. The columns for sorting aren’t required to be adjacent to each other; however, if they are, the order of the records is more obvious.

Sorting records by one column

1. Click the heading of the column whose values you want to use to sort the records.

2. Right-click the selected column’s heading and click Sort Ascending or Sort Descending.

The table’s records are sorted.

The records have been sorted according to the selected column’s values.
Sorting records by more than one column

1. Rearrange the table’s columns so that the column whose values will be used first to sort the records appears in the left of the table, then the column whose values will be used second, and so on.

2. Click the heading of the first column you want to use to sort the records.

3. Press the Ctrl key on the keyboard and click the second column’s heading.

4. Repeat step 3 until all columns that will be used to sort the table’s records have been selected.

5. Right-click the heading of one of the selected columns and click Sort Ascending or Sort Descending.

The table’s records are sorted.

Tip
Selecting adjacent columns
When sorting by more than one column, you will often position those columns together to the left of the table as if you were creating a report. There is a shortcut for selecting adjacent columns. Place the mouse pointer over the heading of the leftmost column, then hold the mouse button down while dragging the mouse pointer to the right. All columns that you drag the pointer over will be selected.
Finding values in a table

Occasionally, you have to look for records in a table that contain specific text or numbers. By default, the Find command tries to match your text to any part of the table’s values. The text San would be found in Pleasants and in San Juan. However, if you choose Start of Field from the Text Match dropdown list in the Find dialog box, Pleasants will not be found. To find all instances of the exact text San Juan, choose Whole Field instead. You can search for numbers the same way you search for text.

When looking for a record, Find assumes by default that the current record is at the top of the table and that you want to search down through the remaining records. If the current record is at the bottom of the table, you may want to search up through the table’s records instead—click Up in the Search dropdown list. If you choose All, the search starts from the current record, goes down through the remaining records in the table, loops around to the top of the table, then proceeds down to the current record.

Finding text in a column

1. Click the heading of the column that contains the text for which you want to search.
2. Click Options and click Find.
3. Type the text you want to find in the Find what text box.
4. Click Find Next.
   The first record found containing your text is selected.
5. If you want to find another record containing the same text, click Find Next again.
6. Repeat step 5 until you are finished looking for values in the table.
7. Click Cancel.
Finding text in any column in the table

1. Click Options and click Find.
2. Type the text you are looking for in the Find what text box.
3. Uncheck Search Only Selected Field(s).
4. Click Find Next. The first record found which contains your text is selected.
5. If you want to find another record containing the same text, click Find Next again.
6. Repeat step 5 until you are finished looking for values in the table.
7. Click Cancel.

Tip
Matching the case
To match the capitalization of the text you type, check Match Case in the Find dialog box; if you don't want to match the text's capitalization, uncheck Match Case. The Match Case option won't be available for some databases.

![Finding text in any column in the table](image)

The first record found containing your text is selected.
Adding and deleting columns

When exploring a table’s contents, you may decide that a column should be deleted or that a new column should be added. Table view provides an easy way to do this without having to open the item’s Properties dialog box. This technique for adding and deleting columns works exactly the same for all data sources regardless of their format. You must have write access to the data to add or delete a column.

Adding a column to a table

1. Click Options and click Add Field.
2. Type the name of the new column.
3. Click the Type dropdown arrow and click the appropriate data type for the new column.
4. Set the properties for the new column. For example, type the maximum number of characters that Text values can have.
5. Click OK.

The new column appears to the right of all other columns in the table.
Deleting a column from a table

1. Click the heading of the column that you want to delete.

2. Right-click the selected column's heading and click Delete Field.
   
   A warning message appears indicating that deleting columns cannot be undone.

3. Click Yes to delete the column.
   
   The column is removed from the table.
Creating new data sources from the values in a table

You may decide when looking at a table to create a copy of its records. Table view lets you export the data source’s attributes and in doing so create a new table. Regardless of the type of data source you’re looking at, you can create a new dBASE, INFO, or geodatabase table.

Similarly, if a table contains x,y,z coordinates, ArcCatalog lets you create point features representing those locations quickly and easily. The Create Feature Class From XY Table dialog box lets you pick which columns contain the coordinate values, define their spatial reference, and choose the format in which you want to create the new point locations.

Exporting records

1. Click Options and click Export.
2. In the Export Data dialog box, click the Browse button.
3. Click the Save as type dropdown arrow and click the format to which you want to export the data. For example, click Personal Geodatabase tables.
4. Navigate to the folder or geodatabase in which you want to place the exported data.
5. Type a name for the new data source.
6. Click Save.
7. Click OK.
Creating point features from coordinate values

1. Right-click a table in the Catalog tree that has columns containing x,y coordinates. The table may also have a column containing z-coordinates.

2. Point to Create Feature Class and click From XY Table.

3. Click the X Field dropdown arrow and click the name of the column that contains the x-coordinates.

4. Click the Y Field dropdown arrow and click the name of the column that contains the y-coordinates.

5. If appropriate, click the Z Field dropdown arrow and click the name of the column that contains the z-coordinates.

6. Click Spatial Reference of Input Coordinates to define the coordinate system for the input values.

7. Follow the steps for ‘Defining a shapefile’s coordinate system’ in Chapter 12 to define the spatial reference of the coordinates.

8. Click the Browse button. ▶
9. Click the Save as type dropdown arrow and click the format in which to create the new point features. For example, click Shapefile.

10. Navigate to the folder or geodatabase in which you want to store the new features.

11. Type a name for the new data source.

12. Click Save.

13. If the output feature class will be stored in an ArcSDE geodatabase, specify the configuration keyword to use when creating the feature class.

14. If the output features should have a different coordinate system from the input values, click Advanced Geometry Options. Otherwise, skip to step 17.

15. Click the ellipsis (...) button to the right of the Spatial Reference property and define the spatial reference of the output features.

16. Click OK, then click OK in the Define Output Geometry dialog box.

17. Click OK.

A new point data source is created in the appropriate location.
Metadata describes GIS resources in the same way a card in a library’s card catalog describes a book. It consists of properties and documentation. With ArcCatalog’s default settings, all you have to do to create metadata is click the item in the Catalog tree and click the Metadata tab. Properties, such as the extent of a shapefile’s features, are automatically derived from the item by ArcCatalog and added to the metadata. Documentation is descriptive information supplied by a person using a metadata editor.

No GIS exists in isolation. Metadata is critical for sharing tools, data, and maps, and for searching to see if the resources you need already exist. Once you’ve found a resource, its metadata will help you decide whether or not it’s suitable for your purposes. To make this decision you often need more information than its properties and a look at its features. You may need to know how accurate or current the resource is and if there are any restrictions in how it can be used. Documentation can answer these questions if it exists.

Any item in ArcCatalog, including folders and file types, such as Word documents, can have metadata. Once created, metadata is copied, moved, and deleted along with the item when it is managed with ArcCatalog or ArcInfo Workstation. Metadata created with ArcCatalog is stored in XML format either in a file alongside the item or within its geodatabase. See Chapter 4, ‘What’s in the Catalog’, for a description of XML data and the stylesheets that are used to present it.
The Metadata tab is where you view an item’s metadata or the contents of a standalone XML document. Metadata is initially presented with the default stylesheet. To change its appearance, pick a different stylesheet in the dropdown list on the Metadata toolbar. ArcCatalog’s stylesheets generate HTML pages. Therefore, you can interact with the information you see as you would interact with any HTML page in a Web browser.

The stylesheets whose names begin with “FGDC” present metadata elements that are defined in the FGDC’s *Content Standard for Digital Geospatial Metadata*, which will be referred to as the FGDC standard. Stylesheets beginning with “ISO” present metadata elements defined in the ISO standard 19115, *Geographic Information – Metadata*, which will be referred to as the ISO standard.

Some stylesheets show Esri-defined content in addition to content defined by the appropriate standard. To better describe resources such as geometric networks and topologies, Esri has created the *Esri Profile of the Content Standard for Digital Geospatial Metadata*, which will be referred to as the Esri Profile. The Esri profile is documented at support.esri.com. Esri has not created a profile of the ISO standard.

**FGDC ESRI stylesheet**

The FGDC ESRI stylesheet presents metadata in tabbed format. It shows a subset of the elements defined by the FGDC standard and all of the elements defined by the Esri Profile. The Description tab shows documentation including the item’s date, status, location, thumbnail, and enclosures. The Spatial tab shows properties including the item’s coordinate system and detailed feature, raster, topology, and geometric network information. The Attributes tab describes attribute columns, the subtypes of a geodatabase feature class, and lists any related items.

When you position the mouse pointer over a green heading, the pointer changes to a hand. Click the heading to hide or show its information. For example, in the Attributes tab, click an attribute name to see its data type and a description of its values. Click the attribute name again to hide those details.

**FGDC stylesheet and ISO stylesheet**

The FGDC and ISO stylesheets present FGDC and ISO elements in the same format. A quick summary of the item and its thumbnail appears at the top of the page, followed by a complete list of the standard’s elements. In addition to the FGDC elements, the FGDC stylesheet shows all elements defined in the Esri Profile. The only Esri-defined content that appears in the ISO stylesheet is the item’s thumbnail and enclosures.
Elements defined by the FGDC or ISO standards appear with blue text; ESRI-defined elements are green. A green asterisk appears next to any element whose values are automatically updated by ArcCatalog.

**FGDC FAQ stylesheet**

The FGDC FAQ stylesheet presents a subset of the FGDC metadata elements in question and answer format. It may be useful if you’re new to metadata. This stylesheet does not show any ESRI-defined content. This presentation format emulates the FAQ HTML page that can be created by the FGDC metadata parser utility, mp.

**FGDC Geography Network stylesheet and ISO Geography Network stylesheet**

The ISO and FGDC Geography Network stylesheets provide a brief overview of the item. They present FGDC- or ISO-defined metadata elements in the same way that metadata is presented on the Details page in the Metadata Explorer. These stylesheets do not show any ESRI-defined content.

**FGDC Classic stylesheet**

The FGDC Classic stylesheet shows all metadata elements defined by the FGDC standard. It does not show any ESRI-defined content. The information appears in the same format as the metadata you typically see when searching for resources using the National Spatial Data Institute (NSDI) Geospatial Data Clearinghouse. This presentation format emulates the HTML page that can be created by the FGDC metadata parser utility, mp.

**XML stylesheet**

The XML stylesheet shows the entire metadata or standalone XML document. XML tags are red and the values of those elements are black. XML data is hierarchical; an element may contain single-value elements. You can explore the XML data by clicking the minus sign (-) next to an element to hide its contents. Click the plus sign (+) next to an element to show its contents.
Metadata for folders

While metadata isn’t automatically generated for folders, you can document their contents using a metadata editor in the same way you would create documentation for any other item in ArcCatalog. Alternatively, you can create an HTML page to document its contents. This type of metadata can help others in your organization locate the resources they need when they are browsing the network. You might describe the project for which the folder’s contents were created, the general area in which the data is located, or give a warning to users that the data in the contents are incomplete.

Like XML, these HTML pages must be well-formed and free of syntax errors. To be well-formed, all opening tags such as `<P>` for paragraph must be properly closed by an end tag such as `</P>`. Unfortunately, most HTML authoring tools don’t create well-formed HTML. You must use an authoring tool that can create a page in XHTML format; otherwise, you will have to fix your HTML page in a text editor before it will display properly in the Metadata tab. Once your HTML page has been created, rename the file “metadata.htm” and place it within the folder it describes.
Changing the default stylesheet

Every time you start ArcCatalog, metadata is initially presented with the default stylesheet. To change the default stylesheet, use the Options dialog box. This change won’t be apparent until the next time you start ArcCatalog; at that time, metadata will initially be presented with the new default stylesheet. Setting the default stylesheet doesn’t prevent you from changing the current stylesheet using the dropdown list on the Metadata toolbar.

1. Click the Tools menu and click Options.
2. Click the Metadata tab.
3. Click the Default Stylesheet dropdown arrow and click the stylesheet that should be the default.
4. Click OK.

The next time you start ArcCatalog, the stylesheet you’ve chosen will be used as the default.
Creating and updating metadata

By default, metadata is automatically created or updated when you view it in the Metadata tab. ArcCatalog will get the item’s properties and record those values in the metadata. This ensures the metadata is kept up to date as the item changes over time. For example, the extent and count of a shapefile’s features will be current when you look at its metadata, even if new features were recently added.

If you want more control over when metadata is created and updated, you can turn off automatic creation or updates. This can be accomplished either for all items by changing the settings in the Options dialog box, or for individual items by changing the settings in the Metadata Properties dialog box. You might turn off automatic updates for a single item after its work on the item has been completed.

Choosing how metadata is created and updated

1. Click the Tools menu and click Options.
2. Click the Metadata tab.
3. Check the appropriate boxes to have the Catalog automatically create or update metadata.
   Uncheck the appropriate boxes if you prefer to manually create or update metadata.
4. Click OK.
At any time you can manually create or update an item’s metadata by clicking the Create/Update Metadata button on the Metadata toolbar. For example, you might do this if you modify an item’s properties using its Properties dialog box while you are viewing the metadata in the Metadata tab.

**Turning off automatic updates for individual items**

1. In the Catalog tree, click the item for which metadata should not be updated automatically.
2. Click the Metadata tab.
3. Click the Metadata Properties button on the Metadata toolbar.
4. Click the Options tab.
5. Check Do not automatically update metadata.
6. Click OK.

**Creating and updating metadata manually**

1. In the Catalog tree, click the item whose metadata you want to create or update.
2. Click the Metadata tab.
3. Click the Create/Update Metadata button on the Metadata toolbar.
Importing and exporting metadata

If you have metadata that was created outside of ArcCatalog, you can import it if it’s stored in one of the input formats supported by the FGDC’s metadata parser utility, mp; these are the FGDC CSDGM TXT, FGDC CSDGM XML, and FGDC CSDGM SGML formats in the Format list. ArcCatalog uses mp itself to import and export metadata in its supported formats. Use the XML format to import metadata created with ArcCatalog. You can’t import metadata in HTML format.

Importing overwrites all of an item’s existing metadata. By default, after importing, ArcCatalog will update as many metadata elements as possible with values derived from the item such as its coordinate system. However, if you uncheck Enable automatic update of metadata in the Import Metadata dialog box, ArcCatalog won’t overwrite any existing values. If you want to choose which elements in the imported metadata should be updated automatically, uncheck the option when importing, then use the metadata developer sample Set Synchronized.

**Importing metadata**

1. In the Catalog tree, click the item for which you want to import metadata.
2. Click the Metadata tab.
3. Click the Import Metadata button on the Metadata toolbar.
4. Click the Format dropdown arrow and click the format of the metadata that you will be importing.
5. Click the Browse button.
6. Navigate to and click the metadata file whose contents you want to import. Click Open.
7. If you don’t want ArcCatalog to update the metadata with the current properties of the data, uncheck Enable automatic update of metadata.
8. Click OK.

The imported metadata appears in the Metadata tab.
Exporting metadata

1. In the Catalog tree, click the item for which you want to export metadata.
2. Click the Metadata tab.
3. Click the Export Metadata button on the Metadata toolbar.
4. Click the Browse button.
5. Navigate to the folder in which the exported metadata should reside, type a name for the new metadata file, then click Save.
6. Click the Format dropdown arrow and click the format in which you want to export the metadata.
7. Click OK.

A new file containing a copy of the item’s metadata is created in the appropriate format.
Writing documentation

Automatically generated metadata is not a substitute for good documentation—it just helps to reduce metadata maintenance costs. Good documentation protects your investment in the resources you have created or purchased. For example, without knowledge of data accuracy, provenance, and age, you can’t have a high level of confidence in decisions based on that data.

Documenting your GIS resources also provides you with information that can be used to build or contribute to a GIS catalog portal such as an ArcIMS Metadata Service. Whether internal to your organization or available on the Internet, portals let others search, find, and access the GIS resources they need.

Metadata standards

Following a well-known metadata standard is a good idea because tools will already exist with which you can create metadata. For those who plan to publish their metadata to a wide audience, following a standard also makes it easier for people from different communities, industries, and countries to understand each others’ documentation because the standard acts as a dictionary, defining terminology and the expected values.

There are a number of metadata content standards to choose from. The FGDC standard aims to provide a complete description of a data source. Because it’s quite detailed, other states and regions have created their own metadata standards to try to simplify the information that should be recorded. For example, the European Committee for Standardization (CEN) and the Australia New Zealand Land Information Council (ANZLIC) have created their own metadata standards and guidelines.

Also, this year the ISO standard will be finalized. Designed with an international audience in mind, it attempts to provide a solution that will satisfy the requirements of all existing standards. It allows for either general or detailed descriptions of data sources, makes some allowances for describing resources other than data, and has a small number of mandatory elements.

Simply because so many standards exist, metadata in ArcCatalog isn’t required to meet any specific standard. However, your organization may be required to follow a particular standard. For example, U.S. federal government departments must provide metadata following the FGDC standard. But, in time, the FGDC and most other standards organizations are committed to adopting the ISO standard. This move should help eliminate some of the barriers to sharing data worldwide.

If you’ve chosen to follow a specific metadata standard, a few pieces of information will be considered mandatory in order for your metadata to be considered compliant with that standard. Keep in mind that blindly following a standard’s rules is not the way to create good metadata. This is particularly true for organizations that decide to add only the required pieces of documentation. A good book is not written in a day. Good documentation for a GIS resource will not be written in two minutes.

Generally people choose to create minimal metadata in order to cross the task off their list and to reduce its costs. However, in doing so they sacrifice the usefulness of that documentation.

What documentation to provide

As with any project you should have a plan outlining what content your metadata should include. Look over the metadata standard you’ve chosen to follow to get an idea of the content it suggests. However, you ultimately need to decide what pieces of documentation are most important to your organization based on how you intend to use it.

If you plan to publish your metadata so that people can find your resources by doing a search, you need to consider what information needs to be present to do different types of searches. Typically, people will search by keywords describing the theme or subject of the resource; by the type of resource; by how current it is; and, depending on the portal, by the publisher of the resource. Keywords are more useful if they are derived from a thesaurus; otherwise, you might be searching for roads while the data you’re looking for is described as streets.
If the spatial extent of the resource is present, then people can find it if they include an area of interest in their search; for most GIS portals, the extent must be provided in decimal degrees. If a data source’s coordinate system has been defined, ArcCatalog will automatically record its extent in decimal degrees. If an item, such as a geoprocessing tool, isn’t specific to a place, defining its extent as covering the entire globe will ensure that it will be found by any spatial search.

Once users have found information about a resource, they need to determine if this information will work for their application. Several pieces of information may be used to determine if the resource is appropriate. Include a description, its age, its cost, and any legal information specifying how the resource may be used. For data sources you should also include its accuracy, its scale or resolution, and descriptions of its attributes. Information must also be provided about how to get the resource if someone else wants to use it.

Some pieces of information may also be required by the GIS catalog portal to which you will be publishing your metadata. These requirements are unrelated to whatever standards the portal supports. For example, if the portal lets people search using some predefined queries, you may be required to provide information in your metadata for those queries to work. The metadata librarian who runs the portal may give you a list of keywords, a thesaurus, and require at least one of the keywords in your metadata to be derived from that list.

**How to get documentation done**

There are ways to reduce the documentation effort without sacrificing its quality. An ideal solution is to create a metadata template containing documentation that is the same for a group of resources. The template could include information such as contact information, the publication date, and legal restrictions. The template should not include properties that will be added and maintained automatically by ArcCatalog.

A template can be either a standalone XML document that you import before adding more documentation or a custom synchronizer that automatically adds template documentation whenever metadata is updated automatically. A sample showing how to build a custom synchronizer is available at ArcObjects™ Online. With ArcCatalog maintaining the item’s properties and a template for adding repetitive documentation, the metadata author is left to focus on documentation that is specific to the individual resource such as the quality of the data.

Creating a template from scratch can be difficult because it is an abstract process. An easier way to approach this is to document a resource as best you can, then print out what you have. Cross out any information that is specific to the resource and any properties that will be added automatically by ArcCatalog. If you’re unsure of what information was added automatically, the FGDC and ISO stylesheets show asterisks next to these properties. Now look at the rest of the documentation and think about what information will be same for all the resources that you have to document. You may end up creating several templates to use with resources created by different departments or for different projects.

Similarly, you could create one document representing a series of resources. Suppose the data for a region is broken down into several tiles. You could create metadata describing one of those tiles, then export it to a standalone XML document. Select the XML document in the Catalog tree, and use a metadata editor to modify its content so the properties and documentation reflect the series of tiles rather than a specific tile. When you’re done, you can publish the standalone XML document to the appropriate GIS catalog portal.

Last but not least, keep in mind that the toughest metadata document to create is the first one. Once you become familiar with the process, you will achieve better results in less time.
Choosing a metadata editor

1. Click the Tools menu and click Options.
2. Click the Metadata tab.
3. Click the Metadata Editor dropdown arrow and click the editor you want to use.
4. Click OK.

Adding documentation

1. Click the item whose metadata you want to edit in the Catalog tree.
2. Click the Metadata tab.
3. Click the Edit Metadata button on the Metadata toolbar.
4. Document your data using the metadata editor.
5. Close the metadata editor.
Using the FGDC metadata editor

The FGDC metadata editor is the default metadata editor in ArcCatalog. It lets you create FGDC-compliant metadata for the selected item in the Catalog tree. When metadata is created by ArcCatalog, documentation hints are added to the mandatory elements as defined by the FGDC standard. If you complete the documentation suggested by the hints, your metadata will satisfy that standard’s minimum requirements.

The FGDC standard divides information into seven main sections: Identification, Data Quality, Spatial Data Organization, Spatial Reference, Entity and Attribute, Distribution, and Metadata Reference. The section titles across the top of the FGDC metadata editor correspond to these sections. Information within each section is divided into subsections. When you click a section title, several tabs appear, with each tab representing a subsection.

You can enter values for all elements defined in the FGDC standard and some elements defined in the ESRI profile using this editor. At first, the organization of elements may seem confusing, but as you become familiar with the FGDC standard, you will find it easier to locate the elements you want to edit.

For most elements, text boxes are provided in which you can type the appropriate information. When the standard expects one of several predefined values, a dropdown list lets you choose one of the appropriate values. For some elements, you can either choose a predefined value or type your own information. For example, to define the time period of the data, choose “unknown” from the list or type “unknown” from the list or type an appropriate date.

Some properties are added to the metadata by ArcCatalog. These are best left unmodified and are read-only in the editor. However, you can edit other properties. Suppose many features are grouped together and a few are set apart. The bounding coordinates added automatically represent the extent of all features. You might edit the coordinates to represent the area occupied by the majority of the features. After editing elements that were added by ArcCatalog, they won’t be updated automatically in the future.

Some elements can be repeated many times. For example, you might use several keywords to describe the data’s subject. There is a toolbar containing buttons that let you add, delete, and browse through your entries. For each repeating element the toolbar’s status line shows the name of the repeating element and indicates both the total number of entries for that element and...
which entry is currently displayed. The appropriate navigation buttons are unavailable when you’re at the first or last entry.

When a single element can be repeated, the toolbar is located immediately below the text box. When a group of elements can be repeated, the toolbar is located at the bottom of the group. For example, a shapefile can have many attributes, and several elements are used to describe each one; a toolbar controls the group of elements that are repeated for each attribute. Similarly, coverages have many feature classes. A different toolbar controls the group of elements describing the feature class, which includes the group of elements describing its attributes.

Getting Help in the editor

For a detailed description of a section title, or any metadata element, click the What’s This? button in the upper-right corner, then click the section title or element in the dialog box. A Help description box appears showing the type of information that is expected, along with an indication of whether it is considered mandatory, mandatory-if-applicable, or optional in the FGDC standard.

Clicking Help in the editor shows you a topic that walks you through the process of completing the mandatory information in the FGDC standard. Derived from the Content Standard for Digital Geospatial Metadata Workbook, it shows you where to find the appropriate elements in the metadata editor and describes the information you should provide.

Use the workbook itself to get a better understanding of the FGDC standard and information about how to create a complete FGDC metadata record. It is available for download from the NSDI Web site at www.fgdc.gov/metadata. A link to this Internet site is provided from the editor’s Help topic. All U.S. government agencies and state and local agencies that receive federal funds to create metadata are mandated to follow the FGDC standard.
Using the ISO metadata editor

This wizard-style editor guides you through the process of creating ISO-compliant metadata by asking for information in plain language. You can navigate through the wizard from start to finish by clicking the Next button. You can stop paging through the wizard at any time and pick up where you left off later. To move directly to a specific page, select it in the editor’s table of contents.

On each page you can easily see which pieces of information are mandatory. If a page is missing some mandatory information, the page is marked in the table of contents. When the required information has been added, the mark is removed. At any time a quick scan of the table of contents will let you know if any mandatory information is missing. You can stop editing metadata at any time even if some mandatory information hasn’t been provided.

Some pages that let you add optional information aren’t initially shown in the editor. Only when you choose to add keywords or scale information will those pages appear. Within an optional section some metadata elements may be mandatory. For example, if you decide you want to add theme keywords, the keywords themselves are mandatory, but a description of the thesaurus that the keywords are derived from is optional. When the keyword page appears in the editor, it will have a mark in the table of contents until a keyword has been provided.

This editor comes with a personal contacts database. On the Metadata author, Point of contact, and Distributor pages, you can get contact information from the database rather than typing it in each time. You can add new contacts to the database by clicking Save, and you can add, update, and delete contact information from the database by clicking Edit Contacts. You can also run the Edit Contacts application outside of ArcCatalog. If you are authoring several metadata documents, you can have the editor add you as the author every time by clicking Make Default on the Metadata author page.

The ISO standard defines a core set of elements that includes a few mandatory elements and an additional set of highly recommended ones. Beyond the core set of elements, the ISO standard defines a large number of elements that can be used to thoroughly document GIS resources.

The ISO Metadata Wizard lets you define documentation for an item. When ArcCatalog automatically creates metadata, the item’s properties are added to the appropriate ISO metadata elements, many of which belong to the core set. Default values will also be added to some documentation elements. For example, the item’s name will be added as a default title. The ISO Metadata Wizard supports the documentation elements that comprise the rest of the core elements. Properties of the item generally don’t appear in the editor; if ArcCatalog can calculate the item’s extent in decimal degrees, the extent page won’t appear. Over time, additional pages will be added to the editor to support other elements in the ISO standard.
Adding enclosures

Documentation such as a report describing how values were collected may already exist for an item. You can enclose a copy of a file within an item’s metadata. In most cases, this should be a preliminary measure until you have time to create detailed metadata using the editor; information in the enclosure isn’t available when you do a search. If the original file is later modified, the copy stored within the metadata won’t change. Enclosing files in an item’s metadata works the same way as enclosing files in an e-mail message.

For a data source, you might enclose a layer file that can be added to a map document. You might also enclose an image in a folder’s metadata to describe the general area in which its data is located. When enclosing an image, check Image in the Add New Enclosure dialog box. Enclosed files are listed in the ESRI stylesheet. For enclosed images, the ESRI stylesheet will show thumbnails describing their contents. If metadata doesn’t already exist when you add an enclosure, metadata will be created.

Enclosing documentation files

1. In the Catalog tree, click the item to which you want to attach a file.
2. Click the Metadata tab.
3. Click the Metadata Properties button on the Metadata toolbar.
4. Click the Enclosures tab.
5. Click the Add button.
6. Click the Browse button.
7. Navigate to and click the file you want to attach. Click OK.
8. Type a description of the file.
9. If the enclosed file is an image, such as a Windows Bitmap file, check Image.
10. Click OK.
Viewing an enclosed file

1. Click the Metadata Properties button on the Metadata toolbar.
2. Click the Enclosures tab.
3. Double-click the enclosed file whose contents you want to see.

The file opens in the appropriate application.

Enclosed files are listed in the FGDC, FGDC ESRI, and ISO stylesheets. You will see thumbnails of enclosed files that are images.

Tip

Viewing enclosures
When you add an enclosure to an item’s metadata, your changes aren’t saved until the Metadata Properties dialog box is closed. You can’t view an enclosed file until it has been saved as part of the metadata. Before viewing the contents of a new enclosure, you must click OK and reopen the Metadata Properties dialog box.

Tip

Saving an enclosure to a separate file
You may want to remove an enclosure from an item’s metadata but not want to delete the information entirely. If this is the case, save the enclosure to a separate file before deleting it from the metadata. Deleting an enclosure will decrease the size of the metadata. Click Save As, then navigate to the folder in which you want to place the enclosure. Type a new name for the file, if appropriate, and click Save.

The FGDC ESRI stylesheet lists enclosed files and shows thumbnails of image enclosures.
Requirements for publishing to an ArcIMS Metadata Service

Before you can publish metadata to an ArcIMS Metadata Service, you must have metadata. After creating documentation for the GIS resource you should take a step back and review your work before you publish it. The usefulness of a Metadata Service is entirely dependent upon the quality of the metadata available on that service. The same care should be taken with your metadata that you take when constructing a written document or the data that the metadata describes.

Make sure you’ve provided enough information for people to find your document with a search to find and use the resource it describes. Your legal department should review any legal or security information communicating how the resource may be used. Also, make sure you remove any sensitive information that you wouldn’t want to share with people outside of your department or organization such as computer names. The review process will take time initially, but it can save you time in the long run. Use the experience to refine your metadata templates.

What can be published to a metadata service

Like ArcCatalog, an ArcIMS Metadata Service doesn’t require metadata to conform to any metadata standard. However, by default a Metadata Service requires five pieces of information to be provided: a title, a publisher, a spatial extent, and the theme and content type of the resource. This information is required to support basic searches with the Metadata Explorer and ArcCatalog. You can add this information using either the FGDC metadata editor or the ISO metadata editor.

When validation is enabled for a Metadata Service, the service checks submitted documents to see if they contain the required pieces of information. If any are missing, the document won’t be published, and ArcCatalog will show a report indicating what information is missing.

If validation has been disabled, you can publish any XML document with any content to a Metadata Service. However, you may have difficulty finding the document with specific searches.

It is important to be clear that validation according to an ArcIMS Metadata Service has nothing to do with validation according to a metadata content standard. Similarly, metadata that is compliant with a content standard such as FGDC or ISO may not contain the information that is required by the Metadata Service.

Defining theme and content type codes

In order to search for resources by theme and content type, the metadata must contain one of the theme or content type codes that the Metadata Service understands. Because the same codes must be used in all metadata documents, you will be able to publish metadata in any language to any Metadata Service. Its Metadata Explorer, which may be translated for any language, will then be able to find your document.

The theme categories used by the Metadata Service are described below. More than one theme can be defined for a resource. For example, if your dataset describes soil tests you might specify the theme codes for agriculture, geophysical, and environmental categories. Searches on any of those categories will find your dataset.

The descriptive name of each category appears below with bold text. These categories actually come from the ISO metadata standard. The ISO metadata editor presents you with a list of descriptive names for each category, but the editor actually saves the appropriate code into the metadata.

Because the FGDC metadata standard doesn’t directly support theme codes, the FGDC editor isn’t designed to handle them. To work around this situation, the Metadata Service looks for theme codes among the document’s theme keywords. The code that must by typed into the FGDC metadata editor follows the category name below. These codes must be typed exactly as they are shown regardless of the language in which the rest of the metadata has been defined. For example, for a shapefile of cell phone antennas you would type the theme code “utilitiesCommunication” into the FGDC metadata editor.
• **Administrative and political boundaries**: boundaries. This category refers to legal land descriptions.

• **Agriculture and farming**: farming. This category refers to the rearing of animals or cultivation of plants including resources describing irrigation, aquaculture, herding, and pests and diseases affecting crops and livestock.

• **Atmosphere, climatology, and meteorology**: climatologyMeteorologyAtmosphere. This category refers to atmospheric processes and phenomena, for example, resources describing cloud cover, weather, atmospheric conditions, climate change, and precipitation.

• **Biologic and ecologic**: biota. This category refers to naturally occurring flora and fauna, such as resources describing wildlife, biological sciences, ecology, wilderness, sea life, wetlands, and habitats.

• **Business and economic**: economy. This category refers to economic activities or employment including resources describing labor, revenue, commerce, industry, tourism and ecotourism, forestry, fisheries, commercial or subsistence hunting, and exploration and exploitation of resources, such as minerals, oil, and gas.

• **Cadastral and land planning**: planningCadastre. This category refers to land use, for example, resources describing zoning maps, cadastral surveys, and landownership.

• **Cultural, society, and demographic**: society. This category refers to the characteristics of societies and cultures including resources describing natural settlements, anthropology, archaeology, education, traditional beliefs, manners and customs, demographic data, crime and justice, recreational areas and activities, social impact assessments, and census information.

• **Elevation and derived products**: elevation. This category refers to height above or below sea level, such as resources describing altitude, bathymetry, digital elevation models, slope, and products derived from this information.

• **Environment and conservation**: environment. This category refers to environmental resources, protection, and conservation, for example, resources describing pollution, waste storage and treatment, environmental impact assessment, environmental risk, and nature reserves.

• **Facilities and structures**: structure. This category refers to man-made construction, such as resources describing buildings, museums, churches, factories, housing, monuments, and towers.

• **Geological and geophysical**: geoscientificInformation. This category refers to the earth sciences including resources describing geophysical features and processes; minerals; the composition, structure, and origin of the earth’s rocks; earthquakes; volcanic activity; landslides, gravity information; soils; permafrost; hydrogeology; and erosion.

• **Human health and disease**: health. This category refers to health services, human ecology, and safety, such as resources describing human disease and illness, factors affecting health, hygiene, mental and physical health, substance abuse, and health services.

• **Imagery, basemaps, and land cover**: imageryBaseMapsEarthCover. This category refers to basemaps, for example, resources describing land cover, topographic maps, and classified and unclassified images.

• **Inland water resources**: inlandWaters. This category refers to inland water features, drainage systems, and their characteristics including resources describing rivers and glaciers, salt lakes, water use plans, dams, currents, floods, water quality, and hydrographic charts.

• **Locations and geodetic networks**: location. This category refers to positional information and services, such as resources describing addresses, geodetic networks, postal zones and services, control points, and place names.

• **Military and intelligence**: intelligenceMilitary. This category refers to military bases, structures, and activities, for example,
resources describing barracks, training grounds, military transportation, and information collection.

- **Oceans and estuaries:** oceans. This category refers to the features and characteristics of salt water bodies excluding inland waters, such as resources describing tides, tidal waves, coastal information, and reefs.

- **Transportation networks:** transportation. This category refers to the means and aids for conveying people and goods including resources describing roads, airports and airstrips, shipping routes, tunnels, nautical charts, vehicle or vessel location, aeronautical charts, and railways.

- **Utility and communication networks:** utilitiesCommunication. This category refers to energy, water and waste systems, and communications infrastructure and services, for example, resources describing hydroelectricity, geothermal, solar, and nuclear sources of energy, water purification and distribution, sewage collection and disposal, electricity and gas distribution, data communication, telecommunication, radio, and communication networks.

The content type codes used by the Metadata Service are listed below. Like the theme codes, they must be typed in exactly as they are shown. But unlike the theme codes, only one content type code can be defined for a resource.

- **Live Data and Maps:** Live data and maps are dynamic geographic services that allow direct interaction with map content. This type of content is delivered in one of two ways: as a cartographic image or snapshot of a map, or as compressed vector features that are streamed to you. Streamed features allow for greater client-side interaction including dynamic labelling, feature symbolization, and MapTip creation. You do not need to download anything to use live data—just add it to your map and begin exploring.

- **Downloadable Data:** Downloadable data refers to map features that can be downloaded to your computer. After the data has been downloaded, it can be added to your map.

- **Offline Data:** Offline data cannot be directly downloaded to your computer but can be ordered on or offline from the publisher.

- **Map Files:** This category includes any digital maps that can be viewed in a mapping application. Maps created for ArcReader and ArcMap are examples of digital maps that fit into this category.

- **Static Map Images:** Static Map Images are map image files. You cannot directly interact with static map images as you do with live data and maps. You can view them and download them to your computer.

- **Other Documents:** This category includes geographic information stored in text files, spreadsheets, or other formats. These documents are used in conjunction with geographic data. In many cases, they can be viewed and downloaded.

- **Applications:** This category includes custom-built GIS applications. These applications usually have a complete user interface.

- **Geographic Services:** Geographic Services are Internet services that perform basic geoprocessing tasks, such as address matching and buffering. Sometimes Geographic Services are simply referred to as GeoServices.

- **Clearinghouses:** Clearinghouses are Web sites that either provide links to free geographic data or allow you to directly download it.

- **Geographic Activities:** A geographic activity is an event or set of events that are geographic in nature. This includes activities such as land surveys, geographic explorations, GIS conferences, and more. The information about these events can be presented in many forms, such as a Web site.

When ArcCatalog automatically creates and updates metadata, a default content type code is added. For ArcIMS image and feature services, the code Live Data and Maps is added to the metadata. For all other items the code Downloadable Data is
added. Before you publish metadata you should consider whether the default content type code is appropriate for your resource and change the value if necessary.

**Document identifiers and republishing metadata**

When metadata is published, a copy of your original document is added to the Metadata Service’s database and indexed for fast searching. You can later republish the original document, for example, after the dataset and its metadata have been updated. Because only one copy of the document is stored with the service, all references to that document in all folders on the service will access the new version; each reference does not have to be updated.

This is possible because ArcCatalog and the Metadata Service use a unique identifier to refer to the metadata document. The unique identifier is generated within the metadata during the publishing process and stored within the original metadata document. The second time the document is published, the identifier already exists; the Metadata Service locates and replaces the original document. When a document is republished, the indexes are updated with the latest information.

While it is possible to directly edit the published document using the metadata editors provided with ArcCatalog, those changes would be made only on the Metadata Service. The original document would not be updated; if you later republish it, those changes would be lost.

If metadata was created with ArcCatalog 8.1 or earlier, it will contain an identifier that is not guaranteed to be unique. For example, if you imported a metadata template, the template and every metadata document based on that template would have the same identifier. If you publish those documents the Metadata Service can’t distinguish between them; the first document will be replaced by the second document, and so on. To solve this problem, use the MetaIDChecker utility provided with ArcCatalog. It can be found in the Utilities folder in the location where ArcGIS was installed.
Preparing metadata for publication

Before you can publish metadata you need to define the pieces of information that are required by the Metadata Service: title, publisher, spatial extent, theme, and content type. Either the FGDC or ISO metadata editor, or both, may be used to do so.

With the FGDC editor you must type in the theme and content type codes. The FGDC editor lets you define any number of theme keywords—the requirement is for at least one keyword to come from the Metadata Service’s list. For example, a soils dataset might have the existing keywords: soil, clay, and corn. To publish the dataset’s metadata, add the theme code farming to that list. If you want to keep the theme code separate from the existing set of keywords, add a new group of keywords and define that group’s thesaurus as Metadata Service Theme Categories. Alternatively, leave your FGDC theme keywords list the way it is, and use the ISO editor to define the theme code.

Similarly, when defining the content type code, the FGDC editor lets you define any number of content type codes. The requirement is for at least one code to come from the Metadata Service’s list. For example, a soils dataset might have the existing codes: soil, clay, and corn. To publish the dataset’s metadata, add the content types farming, farming, and farming to that list. If you want to keep the content type codes separate from the existing set of codes, add a new group of codes and define that group’s thesaurus as Metadata Service Content Type Categories. Alternatively, leave your FGDC content type codes list the way it is, and use the ISO editor to define the content type code.

Adding required information with the FGDC metadata editor

1. Click the Edit Metadata button on the Metadata toolbar.
2. To add a title, click Identification at the top of the editor, click the Citation tab, then type a descriptive title that clearly identifies the item.
3. Click Details to show the Citation Information dialog box.
4. To add the publisher, click the Series/Publisher Information tab, then type in the publisher.
5. To add the spatial extent, click the Spatial Domain tab and click the Bounding Coordinates tab. The North, South, East, and West coordinates will be added automatically by ArcCatalog if the data’s coordinate system has been defined. If these boxes are empty or if the item is nonspatial, such as a table, type in an appropriate extent in decimal degrees.
6. To define the item’s theme, click the Keywords tab, click the plus sign (+) under Theme Keywords, then type one of the following codes into the Keyword text box:

- biota
- boundaries
- climatologyMeteorologyAtmosphere
- economy
- environment
- farming
- geoscientificInformation
- health
- imageryBaseMapsEarthCover
- intelligenceMilitary
- inlandWaters
- location
- oceans
- planningCadastre
- society
- structure
- transportation
- utilitiesCommunication

7. If the item falls into more than one theme category, click the plus sign again and type in another code.

---

**Tip:**

**Creating and publishing metadata for an ArcIMS Image or Feature Service**

To create metadata for an ArcIMS Image or Feature Service, you must have permission to author metadata for that service. Contact the ArcIMS administrator for the appropriate username and password. Metadata for an Image or feature service isn’t automatically published to a Metadata Service that exists on the same ArcIMS server. You must publish the metadata by dragging the Image or Feature Service and dropping it on the Metadata Service.
8. To define the item’s content type, click Distribution at the top of the editor, then type one of the following codes into the Resource Description text box:

- Live Data and Maps
- Downloadable Data
- Offline Data
- Map Files
- Static Map Images
- Other Documents
- Applications
- Geographic Services
- Clearinghouses
- Geographic Activities

9. Click Save.

Adding required information with the ISO metadata editor

1. Click the Edit Metadata button on the Metadata toolbar.

2. To add a title, click the Title page in the table of contents and type a descriptive title that clearly identifies the item.
the elements that are mandatory according to the FGDC standard. Because these hints are stored as values of those elements, they will be in the metadata that is published to the Metadata Service. You can delete the hints manually with the FGDC metadata editor; the Help button in the editor shows where to find the mandatory elements. Alternatively, the ArcObjects developer samples include a Visual Basic for Applications (VBA) script that can be used to delete the FGDC hints. Documentation hints are not added to ISO metadata elements.

While thumbnails aren’t required, they can be useful. The Metadata Explorer will show thumbnails in the search results if they exist. Existing FGDC standard metadata that is published on the NSDI Clearinghouse may have browse graphics rather than thumbnails. These are separate graphic files that are referenced, rather than enclosed, in the metadata. Like thumbnails, a browse graphic may illustrate the dataset symbolized in various ways. If a thumbnail does not exist, the Metadata Service will see if a browse graphic exists; the first browse graphic in GIF or JPEG format that can be accessed will be

3. Click the Point of contact overview page in the table of contents, click Yes in response to the second question to add a new point of contact, then click Next.

4. To add the publisher, click the last Point of contact page in the table of contents; it will be empty. Load a contact into the page from the contacts database, or type the publisher’s name into the organization name text box.

5. To define the contact as the publisher, click the Function in relation to the dataset dropdown list and click publisher.

6. To define the item’s theme, click the Themes or categories page in the table of contents and check all of the categories that apply for this item. ▶
loaded into the database as the document’s thumbnail. Additional browse graphics will not be loaded.

7. If the Geographic bounding box page appears in the table of contents, click that page and type in an appropriate spatial extent in decimal degrees. This page will not appear in the table of contents if the item’s extent in decimal degrees was added automatically by ArcCatalog; skip to step 8. An item’s extent in decimal degrees is added automatically if the item contains spatial data and its coordinate system has been defined.

8. Define the item’s content type by clicking the On-line delivery options page in the table of contents and click the appropriate content type from the resource description dropdown list.

9. Click Finish.
Publishing to an ArcIMS Metadata Service

You can publish an item’s metadata or any XML document to an ArcIMS Metadata Service using ArcCatalog. To do so, you must have permission to publish metadata; the ArcIMS administrator will give you a username and password. After creating a new connection to the server with that login information, the icon of the Metadata Service that you can publish to will show a hand holding a pencil.

To publish an item’s metadata, you can either copy and paste or drag and drop the item onto the Metadata Service. When metadata is published, the metadata is retrieved from the item. A copy of the metadata is added to the Metadata Service’s database and is indexed for fast searching. The item itself—the geodatabase feature class, or layer file, or ArcMap document—is not published or moved from its original location. If the published metadata must be updated later, you should update the original document and republish it to the Metadata Service.

1. In ArcCatalog, click the item whose metadata you want to publish. To select more than one item in the Contents tab, press the Ctrl key while clicking the items. These datasets should already have metadata.
2. Click the Copy button.
3. Click the folder in the ArcIMS Metadata Service to which you want to publish the metadata.
4. Click the Paste button.

The published documents will appear in the ArcIMS metadata folder. Publishing can take a few moments. If any problems were encountered, a report will appear indicating why a document could not be published. If any documents were previously published, the report will also show which documents were updated.
Managing published documents

Once a metadata document has been published, documents on the Metadata Service can be managed in the same manner that you manage other items in ArcCatalog. However, the ArcIMS administrator must have granted you the appropriate permissions in order to do so.

Anyone who has permission to publish to a Metadata Service can create folders on that service, copy documents, and establish relationships between documents. A publisher also has permission to rename, edit, and delete the documents that the publisher owns as well as to make the documents private. When metadata is published, the title within the metadata is used as the name of the document. You can rename a published metadata document in ArcCatalog, but doing so doesn’t change the title stored within the metadata.

A Metadata Service is only useful if the published documents are easy to find. Creating a useful catalog of documents requires the services of a librarian, who can manage the documents and work with contributors to ensure their quality. Like building an index for a book, the librarian also needs to think about the various ways that people will look for data. The librarian should be granted administration privileges by the ArcIMS administrator. This lets them view, modify, and delete all documents that are available on the service.

The librarian can use ArcCatalog to construct a series of folders that organize the published documents in different ways. One document would appear in a different place in each hierarchy. A Metadata Service might contain one folder that organizes the documents by geographic location like a gazetteer, another folder that organizes documents by publisher, another by subject, and so on. When browsing the contents of the service in ArcCatalog or the Metadata Explorer, people will use each of those folders as a different entry point to drill down through the catalog and find what they need.

For example, a Metadata Service that publishes information about the western United States might have one folder that organizes documents by publisher and another that organizes by geographic location. Each organization that contributes information could publish its metadata into its folder. The librarian who oversees the Metadata Service could then copy the published document into the appropriate geographic location folder. Metadata describing an image that covers a large area of California would be copied to the California folder. Metadata describing election results in Riverside County would be copied to the Riverside County folder.

While a published document can exist in many folders, only one physical copy of the document is stored in the database, and the document will only appear once in a list of search results. Similarly, when you delete a document on the Metadata Service, you are only deleting the selected reference to that document. All references to a document must be deleted in order to remove that document from the service. When you delete the last reference to a document, a message will appear confirming that you want to remove the document from the Metadata Service.
Changing a published document’s properties

One way to make it easier for people to find what they’re looking for is by establishing relationships between documents, such as the links between related topics in the Desktop Help system. For example, you might establish a relationship between metadata for a coverage describing electoral regions and metadata describing a paper that analyzes election results. Or, you might establish a relationship between a paper map and the aerial photographs that cover the area on that map. When you look at the contents of a document in the Details tab of the Metadata Explorer, links to any related document are listed at the bottom. In ArcCatalog you can view and manage the list of related documents using the Properties dialog box.

If you don’t want a document to be publicly available, make it private. To view a private document a person must log in to the Metadata Service with the appropriate username and password.

Creating relationships between documents in the same folder

1. Click the folder containing the related documents in the Catalog tree.
2. Press the Ctrl key while clicking the related documents in the Contents tab.
3. Right-click the selected documents.
4. Click Group Related Documents.

When viewing the contents of a document in the Metadata Explorer, its related documents are listed at the bottom.

Changing a published document’s properties

One way to make it easier for people to find what they’re looking for is by establishing relationships between documents, such as the links between related topics in the Desktop Help system. For example, you might establish a relationship between metadata for a coverage describing electoral regions and metadata describing a paper that analyzes election results. Or, you might establish a relationship between a paper map and the aerial photographs that cover the area on that map. When you look at the contents of a document in the Details tab of the Metadata Explorer, links to any related documents are listed at the bottom. In ArcCatalog you can view and manage the list of related documents using the Properties dialog box.

If you don’t want a document to be publicly available, make it private. To view a private document a person must log in to the Metadata Service with the appropriate username and password.
Creating relationships between documents in different folders

1. Click the document with which you want to establish a relationship.
2. Click File and click Properties.
3. Click the Related Documents tab.
4. Click Add, navigate to and select the related document, then click Add.
5. Click OK.
The document appears in the related documents list.

Making a published document private

1. Click the document that you want to be private.
2. Click File and click Properties.
3. Check Private on the General tab.
4. Click OK.
Searching for items

Sometimes you know where data is located; other times you don’t. It can be time-consuming to browse through each shared folder on the network looking for the data you need. The Catalog’s Search tool can solve that problem.

You can search for any item that you can use in the Catalog by its name and the type of data it contains. You can search for geographic data that is located within a specific area on the earth’s surface. If the item has metadata, you can search by temporal information, such as when the data was published, or by keywords such as the name of the person who created the data. The Catalog creates shortcuts to the items that have been found and places them in the search results list.
Searching for items

When searching for items in ArcCatalog, you can specify the name and type of item you want to find. When defining criteria that will test an item’s name, you can use an asterisk (*) to represent one or more characters. For example, San* would return all items whose name begins with San, including San Francisco and Santa Fe. You can also choose the specific types of items you want to find in the Type list.

When defining where to start looking for items, you can choose to search in the Catalog, which is the default; in the File system; or in an ArcIMS Metadata Service. When searching the Catalog, you can look in any folder, database connection, or GIS server. When searching the Catalog, if an item doesn’t have metadata, you can only check its name, type, and geographic location. If metadata is present, you can also search using temporal and keyword criteria; the name, type, and location information will be derived from the metadata rather than the item itself.

When searching the File system, your search may be faster than searching the

---

Defining the name, type, and location of the items you want to find

1. Click the Search button on the Standard toolbar.
2. Click the Name & location tab.
3. If you want to search by name, type all or part of the name you’re looking for into the Name text box. Use an asterisk (*) to represent one or more letters. Otherwise, type an asterisk in the Name text box.
4. If you want to search by type, press the Ctrl key while clicking the items you want to find in the Type list; otherwise, click Clear.
5. Click the Search dropdown arrow and click where you want to search.
6. Click the Browse button.
7. Navigate to and click the folder, database connection, or GIS server in which to start searching. Click Open.
8. If you are searching an ArcIMS Metadata Service and you want to find items that fall into a specific category, click the Content type dropdown arrow and click the appropriate category in the list. For example, to find any type of
As items are found that satisfy your search criteria, shortcuts to those items are added to the search results list.

As items are found that satisfy your search criteria, shortcuts to those items are added to the search results list.

**Stopping an ongoing search**

1. Click the Search button on the Standard toolbar or right-click the ongoing search and click Properties.
   The Search dialog box reappears.
2. Click Stop.

ArcIMS ➤ image or feature service, click Live Data and Maps.

9. Type a name for your search in the Save as text box.
10. Click Find Now.

The Search is saved in the Search Results folder and is selected in the Catalog tree. As items are found that satisfy the search criteria, shortcuts to those items are added to the search results list.

11. Click the Close button in the upper-right corner of the Search dialog box.

Catalog, but you will only find items for which metadata exists.

With a File system search, you can’t search the contents of databases or GIS servers.

When searching an ArcIMS Metadata Service, such as the Geography Network, you are searching a collection of published metadata documents that describe GIS resources. Those documents are indexed for fast searching. Within your organization, a metadata service may contain information about data that is available on the network. A public metadata service may contain information about ArcIMS image and feature services that you can directly access or data that is available on CD–ROMs that you can order through the mail.

When you click Find Now in the Search dialog box, your search is saved in the Search Results folder and is automatically selected in the Catalog tree. When an item is found that satisfies your search criteria, a shortcut to that item is added to the search results list. You can close the Search dialog box during the search. If your criteria were too inclusive, ArcCatalog may find a large number of items; you can stop the search, redefine your criteria, then start searching again.
Searching with geographic criteria

In addition to searching by name and type, you can search for data that covers a specific geographic area. You can draw your area of interest on a map or choose a place name from the dropdown list. You can use different maps from the Map dropdown list to define your geographic criteria. If the scale of the available maps is too small or if they don’t cover the appropriate area, click <Other...> in the Map dropdown list and select a data source of your own to use. For example, you might use a satellite image of your city to define your geographic criteria.

Defining your area of interest

1. Click the Search button on the Standard toolbar.
2. Click the Name & location tab to define the name, type, and location criteria for your search.
3. Click the Geography tab in the Search dialog box.
4. Check Use geographic location in search.
5. Draw a box on the map outlining your area of interest.
   Or click a place name in the Choose a location dropdown list. A box will be drawn on the map around that location.
   Or type the North, South, East, and West coordinates that define your area of interest. The box on the map changes accordingly.
6. If you wish, modify the box using the Selection tool or remove the box and start again.
7. Click Find data entirely within location or Find data overlapping location—whichever is appropriate for your search.
8. Type a name for your search in the Save as text box.
9. Click Find Now.
10. Click the Close button.
Using your own data as a map

1. Click the Map dropdown arrow and click <Other...>.
2. Navigate to and click the appropriate data source. Click Add.
   The data source is added to and selected in the Map dropdown list. The geographic data is drawn in the map, and a box that encloses the data appears.
3. Modify the box so that it contains your area of interest.

Your data source appears in the map along with a box that encloses the data.
Searching with temporal criteria

The Catalog lets you search for items using temporal criteria. You can search for items according to how current the data is, when the item’s metadata was last updated, or when the item was published. Temporal information about an item is derived from its metadata. Searches can either compare dates in the metadata to a specific date, a range of dates, or a general period of time. To use a specific date, click Before, Equal to, or After in the dropdown list and define the date; the Catalog will ignore the ending date in the date range. When using a general period of time—for example, the previous 60 days—the time period is always calculated in relation to today’s date. In the Search dialog box, dates appear according to the format of the system date on your computer.

Defining a specific date

1. Click the Search button on the Standard toolbar.
2. Click the Name & location tab to define the name, type, and location criteria for your search.
3. Click the Date tab in the Search dialog box.
4. Click Find and click the Find dropdown arrow. Click the type of date on which you want to search.
5. Click the dropdown arrow and click Before, Equal to, or After.
6. To use a date other than today, click the first date dropdown arrow. Navigate to and click the appropriate date. Or click the month, day, or year and type a new value. The new date appears in both date text boxes. When specifying the year, you can either type a two- or four-digit date.
7. Type a name for your search in the Save as text box.
8. Click Find Now.
9. Click the Close button to close the Search dialog box.
Defining a range of dates

1. Click the Search button on the Standard toolbar.
2. Click the Name & location tab to define the name, type, and location criteria for your search.
3. Click the Date tab in the Search dialog box.
4. Click Find and click the Find dropdown arrow. Click the type of date for which you want to search.
5. Click the dropdown arrow and click During.
6. Define the beginning date.
7. Define the ending date.
8. Type a name for your search in the Save as text box.
9. Click Find Now.
10. Click the Close button to close the Search dialog box.

Tip

Today’s date
To set either the beginning or ending date for your search to today’s date, click the date dropdown arrow and click Today at the bottom of the calendar.
Defining a general range of time

1. Click the Search button on the Standard toolbar.
2. Click the Name & location tab to define the name, type, and location criteria for your search.
3. Click the Date tab in the Search dialog box.
4. Click Find and click the Find dropdown arrow. Click the type of date for which you want to search.
5. Click during the previous.
6. Click the dropdown arrow and click the appropriate period of time.
7. Type the appropriate duration into the text box.
8. Type a name for your search in the Save as text box.
9. Click Find Now.
10. Click the Close button to close the Search dialog box.
Searching with keywords

You can search for items whose metadata contains specific text. You might look for items that have a specific word in their Title or in the Abstract that describes the item’s contents. With Full Text, the Catalog will locate items where a word exists anywhere in their metadata. When you define several keyword criteria, they are combined using the Boolean operator AND; for example, look for items whose Abstract includes the word soil AND the word salinity.

Several metadata elements that are commonly used in searches appear in the Metadata element list in the Advanced tab. If you are interested in information stored in a metadata element that isn’t in this list, you can type the element’s path in the Metadata element text box. An element’s path, like a file’s path, describes how to navigate the hierarchy of the metadata XML document from its root to find the element. For information on how to find a metadata element’s path, see Chapter 6, ‘Managing the Catalog’s contents’.

1. Click the Search button.
2. Click the Name & location tab to define the name, type, and location criteria for your search.
3. Click the Advanced tab in the Search dialog box.
4. Click the Metadata element dropdown arrow and click the appropriate keyword to use from the metadata.
5. Click the Condition dropdown arrow and click the appropriate condition.
6. Click in the Value text box and type the words for which you want to search. Or click the Value dropdown arrow and click the appropriate Value in the list.
7. Click Add to List.
8. Repeat steps 4 through 7 to add additional criteria to the list.
9. If you don’t want to search on a criterion, click it and click Delete to remove it from the list.
10. Check Match case to return items whose metadata contains the values exactly as they have been typed.
11. Type a name for your search in the Save as text box.
12. Click Find Now.
13. Click the Close button.
Exploring the results of your search

You can explore search results in the Catalog the same way that you explore the contents of other items. When a Search is selected in the Catalog tree, you can list its shortcuts in the Contents tab. In the Metadata tab, you’ll see a detailed description of the criteria that were defined for the search.

A search result is comprised of the shortcuts that were found by the Catalog. These shortcuts, like Windows shortcuts, provide a link to an item that is stored elsewhere. When a shortcut is selected in the Catalog tree, you can preview the item’s data and metadata in the appropriate tabs as if you were exploring the contents of the item itself.

In the Preview tab, you’ll see an overview describing where on the earth’s surface the shortcuts’ data is located. Use the Identify tool to determine which data sources are located in which areas, then select the ones that are of interest to you.

Once you’ve found the item that you want to use, you can right-click the shortcut and click Go To Target to select the item itself in the Catalog tree. Alternatively, you can work with the shortcut as if you were working with the item itself. You can drag and drop a shortcut onto a map or an ArcToolbox tool. You can also double-click a shortcut to open the item’s Properties dialog box. And, if you have write access to the data, you can modify its properties and update its metadata.
Modifying the search results

One of the reasons why you might be searching for items is so you can see which ones must be updated. For example, after repairing the contact information in the metadata for several items, you might update the search results so that you have an accurate list of your outstanding work. You can either delete each shortcut from the search results list as you modify its metadata, or you can rerun the search. Shortcuts in ArcCatalog are like Windows shortcuts—deleting, copying, or moving the shortcut has no effect on the original item. To copy the original item, right-click it and click Copy Target, then click the destination and click Paste. To delete the original item, select it in the Catalog tree and click Delete; remember to delete the shortcut as well.

Updating the search results

1. Right-click a Search and click Properties.
   The Search dialog box appears containing the Search's criteria.
2. Modify the Search's criteria, if appropriate.
3. Click Find Now.
   All shortcuts are removed from the search's current list of results. As the Catalog finds items that satisfy the new search criteria, shortcuts to those items are added to the search results list.
4. Click the Close button to hide the Search dialog box.

Deleting a shortcut

1. Click a shortcut in the Catalog tree.
2. Click the Delete button.
   The shortcut is removed from the search results list.
Selecting a shortcut's original item

1. Right-click a shortcut in the Catalog tree and click Go To Target.

The original item is selected in the Catalog tree.
Working with maps and layers

IN THIS CHAPTER

- Opening a map
- Adding data to maps
- Creating layers
- Setting a layer’s properties

With ArcMap, you can build, design, query, and analyze the data in your maps. The role of ArcCatalog is to help you find maps and locate data that you want to add to them. When you add data to a map, either by dragging and dropping from the Catalog or by using the Add Data dialog box, ArcMap creates a layer that references the source data. After refining a layer’s labels and symbology, you can save it as a separate file so that you can use it again in other maps or e-mail it to someone else along with the data. You can also create layer files directly in ArcCatalog.

If you’re managing an ArcSDE geodatabase, you can create layers for others to use and place them in a shared folder on the network. If different departments use different data in their work, place customized layers in separate folders. The rest of the organization can use those layers without having to know which tables in the database contain what data or how their attributes are related to your geographic features. With layers, people can focus on what the data means rather than how to access it.
Opening a map

When browsing through a folder’s contents, you might find a map document or template that you want to work with. After drawing the map’s contents and looking at its metadata to ensure it’s the right map, you can open it by double-clicking it in the Catalog. In ArcMap, you can draw, query, edit, or analyze the map’s contents.

If you want to create a new map, click the Launch ArcMap button on the Standard toolbar, choose to create a new map, then start adding your data to it. If you want to use a template, simply click on the template that you would like to use. Templates can be helpful since they are ready to use.

Opening an existing map

1. Navigate to the map you want to open.
2. Double-click the map either in the Contents list or in the Catalog tree.
   The map opens in ArcMap.

Creating a new map

1. Click Launch ArcMap on the Standard toolbar.
2. Click A new empty map and click OK.

See Also

For detailed information about working with maps, see Using ArcMap.
Adding data to maps

With the Catalog, you can locate the layers or data sources that you want to use and drag and drop them onto the map. You can drop the data onto the data view or layout view in the ArcMap window. You can also drop geographic data sources directly into the correct spot in the map’s table of contents. If you drop a table onto the map, it will only appear in the Source tab of the map’s table of contents. If the ArcCatalog window or another application is hiding the ArcMap window, drag the data to the Windows taskbar and hold the mouse pointer over the ArcMap program icon for a second or two. After the ArcMap window appears on top, drop the data onto the map.

1. In ArcMap, open the map to which you want to add data.
2. In the Catalog, navigate to the data source you want to add to the map.
3. Drag the data from the Catalog.
4. Drop the data in the data view, layout view, or in the map’s table of contents.

The new data appears in the map.
Creating layers

It takes time to analyze a feature class’s attributes and symbolize its features so that people will readily understand the information that lies within the data. Layers that are created in ArcMap are stored within the map document. After finalizing the symbolization and labeling of a layer, you can save it outside the map as a separate layer file. You can reuse those layers in other maps or e-mail them along with the data to other people.

If you’re managing a multiuser geodatabase, you can create layers for other people to use without having to open ArcMap. You might create a series of layers from the same feature class representing different feature attributes, such as age or income, then share them on the network. Others can drop those layers onto their maps without having to know how to access the database.

Sometimes you’ll want to group several geographic data sources together in a layer because you want to manage them as one entry in the map’s table of contents. For example, you might group all of a map’s background layers together, or you may want to group several layers storing transportation features, such as

Saving a layer outside a map

1. In ArcMap, open the map containing the layer that you want to save as a layer file.
2. Right-click the layer in the map’s table of contents.
3. Click Save As Layer File.
4. Navigate to the folder in which you want to save the layer.
5. Type a name for the layer file.
6. Click Save.
7. In the Catalog, navigate to the folder in which you saved the layer.

The layer is now an item in the folder. If the layer doesn’t appear in the Contents list, click the folder in which it should appear in the Catalog tree, click the View menu, then click Refresh to update the list.

The layer file is now an item in the folder.
Creating a new layer

1. Select the folder in which you want to store the new layer in the Catalog tree.
2. Click the File menu, point to New, then click Layer.
3. Type a name for the new layer.
4. Click the Browse button.
5. Navigate to and click the geographic data source for which you want to create the layer.
6. Click Add.
7. If you don't want the Catalog to create a thumbnail representing the entire layer, uncheck Create thumbnail.
8. If you don't want the layer to store the full pathname identifying the location of the data, check Store relative path name. The location of the data will be recorded in relation to where the layer itself is stored.
9. Click OK.

The new layer appears in the folder’s contents.
Creating a layer from the data

1. Right-click the data source from which you want to create a layer.
2. Click Create Layer.
3. Navigate to the folder in which you want to save the layer.
4. Type a name for the layer file.
5. Click Save.

The layer file appears in the folder’s contents.
Creating a new group layer

1. Select the folder in which you want to place the new group layer in the Catalog tree.
2. Click the File menu, point to New, then click Group Layer.
3. Type a name for the new group layer.
4. Press Enter.

Adding layers to a new group layer

1. Right-click a group layer, click Properties, then click the Group tab.
2. Click Add.
3. Navigate to and click the geographic data source or layer that you want to add to the group. Click Open.
4. Repeat step 3 until all layers have been added.
5. Layers are drawn in order from the bottom to the top of the list. Click a layer and then click the arrow buttons to reorder the list.
6. Click a layer and click Properties to set the properties of individual layers.
7. Click OK.
Creating a group layer from the data

1. Hold down the Shift or Ctrl key and click the appropriate geographic data sources in the Contents tab. The data sources must all have the same format—for example, select three raster datasets.
2. Right-click one of the selected data sources.
3. Click Create Layer.
4. Navigate to the folder in which you want to save the group layer.
5. Type a name for the group layer file.
6. Click Save.

The new group layer appears in the folder’s contents.
Setting a layer’s properties

The Layer Properties dialog box will be different for different types of geographic data. For example, defining the symbology of a vector data source will be different than for a raster dataset. If you have write permission for the data, you can change the layer’s properties such as its symbology. With a group layer, some properties apply to the whole group, but you can also edit the properties of each of its layers individually.

One property common to all layers is their data source. Layer files identify their data sources using a path. If the folder connection through which the data was accessed connects directly to a local disk drive, the path in the layer file will use the local disk name such as C:\. If you send this layer to others, they can’t access your data and will be unable to preview its contents. If the folder connection was created from the Network Neighborhood, the path will include the names of the computer and the Share Name such as \Blues\SharedData. Others will be able to access data stored on your computer if the layer’s path accesses the

Setting a layer’s properties

1. Right-click the layer whose properties you want to set.
2. Click Properties.
3. Set the layer’s properties in the Layer Properties dialog box.
4. Click OK.
Repairing a layer

1. Right-click the layer you want to fix and click Properties.
2. Click the Source tab.
   When a layer can’t find its data source, you’ll see information about the data it’s looking for but no extent or coordinate system information.
3. Click Set Data Source.
4. Navigate to and click the layer’s data source in the Browse dialog box. Click Add.
   The Source tab now shows the path to the data source as well as its extent and the properties of its coordinate system.
5. Click OK.

However, if you rename or move the data, you must update the layer files that access that data.

Another alternative for referencing a layer’s data source is to use a relative pathname. Suppose a folder named forest contains both a layer and another folder named data. The layer’s data source is located within the data folder. With a relative path, the layer will start looking for the data source from the location in which the layer is stored. With the relative path data/myShapefile, the layer will be able to find its data, even if the forest folder is relocated or renamed. The layer will only need to be repaired if the data folder or the data source itself is moved or renamed. You only have the option to use relative paths when you create a new layer in the Catalog.

You can label, query, or symbolize a layer’s data using attributes stored in another table. To do so, define the relationship between the layer’s data and the table in the Layer Properties dialog box. If you join the table, its attributes are appended to the layer’s data. If you establish a relate instead of a join, you can explore the related attributes in ArcMap, but you can’t use them to set the layer’s properties. Any two data
sources can be joined or related through a layer regardless of their format as long as they share a common attribute. For example, you might join attributes in a geodatabase table to a shapefile’s features based on a common attribute such as CustomerID. Relationship classes define the relationships among coverages and INFO tables in a folder or among feature classes and tables in a geodatabase. When a relationship class exists, the layer can use its information to join the two related data sources.

See Also

For detailed information about setting a layer’s properties, see Using ArcMap.

Joining attributes to the layer’s data

1. Right-click the layer to which you want to join attributes and click Properties.
2. Click the Joins & Relates tab.
3. Click Add next to the Joins list.
4. Click the dropdown arrow and click Join attributes from a table.
5. Click the dropdown arrow and click the attribute that will be used to join the layer’s data to an external data source.
6. Click the Browse button. Navigate to and click the data source whose attributes will be joined to the layer, then click Add.
7. Click the dropdown arrow and click the attribute in the external data source that contains the same values as the attribute chosen in step 5.
8. Click OK.
   The data source’s name is added to the list of those that have been joined to the layer. You can now label, query, and symbolize the layer’s data using attributes in the joined data source.
9. Click OK.
Joining attributes using a relationship class

1. Right-click the layer to which you want to join attributes. Click Properties.
2. Click the Joins & Relates tab.
3. Click Add next to the Joins list.
4. Click the dropdown arrow and click Join data based on a predefined relationship class.
5. Click the dropdown arrow and click the name of the relationship on which the join will be based.
6. Click OK.
   The data source's name is added to the list of those that have been joined to the layer. You can now label, query, and symbolize the layer's data using attributes in the joined data source.
7. Click OK.

You can symbolize the layer's data using joined attributes.
Working with shapefiles

IN THIS CHAPTER

- Creating new shapefiles and dBASE tables
- Adding and deleting attributes
- Creating and updating indexes
- Defining a shapefile’s coordinate system

The Catalog lets you create new shapefiles and dBASE tables and modify them by adding, deleting, and indexing attributes. You can also define a shapefile’s coordinate system and update its spatial index. While you can change the structure and properties of a shapefile in ArcCatalog, you must use ArcMap to modify its features and attributes—for example, to add values into a new column by performing a calculation on values in another column.
Creating new shapefiles and dBASE tables

New shapefiles and dBASE tables can be created in ArcCatalog. When you create a new shapefile, you must define the type of features it will contain, whether those features will represent routes, and whether those features will be three-dimensional. These properties can’t be modified after the shapefile has been created. If you choose to define the shapefile’s coordinate system later, it will be classified as Unknown until then.

The process of defining the new shapefile or dBASE table’s attributes is separate from creating the shapefile or dBASE table itself. After creating the item, right-click it in the Catalog and click Properties to define its attributes. Because they must contain at least one column, the Catalog adds a default column to the shapefile or dBASE table when it is created. For shapefiles, an integer column named Id is added as an attribute. For dBASE tables, the text column Name1 is added. Add the appropriate attributes to your shapefile or dBASE table, then delete the default column.

Creating a new shapefile

1. Select a folder or folder connection in the Catalog tree.
2. Click the File menu, point to New, and click Shapefile.
3. Click in the Name text box and type a name for the new shapefile.
4. Click the Feature Type dropdown arrow and click the type of feature the shapefile will contain.
5. Click Edit to define the shapefile’s coordinate system.
6. In the Spatial Reference Properties dialog box, click Select and choose a predefined coordinate system.
   Or, click Import and choose the data source whose coordinate system you want to copy.
   Or, click New and define a new, custom coordinate system.
7. Click OK.

8. If the shapefile will store polylines representing routes, check Coordinates will contain M values.

9. If the shapefile will store three-dimensional features, check Coordinates will contain Z values.

10. Click OK.

The new shapefile appears in the folder’s Contents.

Creating a new dBASE table

1. Select a folder or folder connection in the Catalog tree.

2. Click the File menu, point to New, and click dBASE Table.

A new dBASE table appears in the folder’s Contents.

3. Type a new name for the table and press Enter.
### Adding an attribute

1. Click the shapefile or dBASE table to which you want to add an attribute.
2. Click the File menu and click Properties.
3. Click the Fields tab.
4. Scroll down until you see the last attribute.
5. Click in the empty row below the last attribute under Field Name and type the name of the new attribute.
6. Click under Data Type next to the new attribute name. A dropdown list appears with the Text data type selected by default. Click the appropriate data type in the list for the new attribute.
   - The properties that are appropriate for the new attribute’s data type appear in the Field Properties list below.
7. Click in the Field Properties list and type the properties for the new attribute.
   - For example, if the data type is a real number, set the precision—the total number of digits the values can have—and scale—the total number of decimal places the values can have—properties.
8. Click OK.
Deleting an attribute

1. Click the shapefile or dBASE table whose columns you want to delete.
2. Click the File menu and click Properties.
3. Click the Fields tab.
4. Position the mouse pointer over the gray button to the left of the column you want to delete. The pointer's icon changes to an arrow.
5. Click the gray button to select the column.
   The column is selected and its properties appear in the Field Properties list below.
6. Press the Delete key on the keyboard.
   The selected attribute is removed from the list of columns.
7. Click OK.
Creating and updating indexes

With ArcCatalog you can add attribute indexes to shapefiles and dBASE tables. An index can improve the performance of queries that evaluate an attribute’s values. Indexes created by ArcCatalog and used by ArcGIS software are different from those created and used by ArcView GIS 3. Attribute indexes created in ArcCatalog are automatically maintained as values in the column change.

In addition to letting you add attributes, the Catalog also lets you add, update, and delete a shapefile’s spatial index. As features are added to or removed from the shapefile, its spatial index will be updated automatically. However, at times you may want to update the shapefile’s spatial index manually; this process also updates the extent of its features. Having a current spatial index ensures that a high level of performance is maintained when drawing and working with the shapefile’s features.

Indexing an attribute

1. Click the shapefile or dBASE table to which you want to add an attribute index.
2. Click the File menu and click Properties.
3. Click the Index tab.
4. Check an attribute to index its values.
   Uncheck an attribute to delete its index.
5. Click OK.
Adding a spatial index
1. Click the shapefile for which you want to create a spatial index.
2. Click the File menu and click Properties.
3. Click the Index tab.
4. Click Add.
5. Click OK.

Updating a spatial index
1. Click the shapefile to which you want to add a spatial index.
2. Click the File menu and click Properties.
3. Click the Index tab.
4. Click Update.
5. Click OK.
Defining a shapefile’s coordinate system

A shapefile often doesn’t have any information defining which coordinate system was used to define its features. In this case, the Shape column’s Spatial Reference property will be unknown or assumed geographic. If the features’ bounding coordinates are within the range of -180 and 180 in the x direction and -90 and 90 in the y direction, ArcGIS software assumes the data to be geographic and its datum to be NAD27. You can work with shapefiles even if their coordinate system hasn’t been defined, but you may not be able to take advantage of all the available functionality. For example, you may be unable to add the shapefile to some maps, and its automatically created metadata will be incomplete.

You can define a shapefile’s coordinate system in ArcCatalog in several ways. You can select one of the predefined coordinate systems provided with ArcCatalog, import the coordinate system parameters used by another data source, or define a new.

Defining a shapefile’s coordinate system

1. Click the shapefile whose coordinate system you want to define.
2. Click the File menu and click Properties.
3. Click the Fields tab.
4. Click the Shape column in the column list.
5. In the Field Properties list below, click the ellipsis button (…) next to the Spatial Reference property.
6. In the Spatial Reference Properties dialog box, click Select, then choose a predefined coordinate system.
   Or, click Import and choose the data source whose coordinate system parameters you want to copy.
   Or, click New, click Geographic or Projected, and define a new, custom coordinate system.
7. Click OK in the Spatial Reference Properties dialog box.
custom coordinate system. Afterwards, you can modify individual parameters as required. A shapefile’s coordinate system parameters are stored in the same location as the shapefile, in a .prj file with the same name as the shapefile.

Once a coordinate system has been defined, you can modify individual parameters. For example, you might want to modify one parameter in a coordinate system that was imported from another data source or customize one of the predefined coordinate systems. After creating a custom coordinate system, you can save it as a separate file. You might want to share your coordinate system with others in your organization.

**Tip**

**Defining coordinate systems of other data sources**

The way you define a shapefile’s coordinate system is the same way you define coordinate systems for feature classes in geodatabases, CAD drawings, and rasters that aren’t grids. For grids and TIN datasets, follow the steps for defining a coverage’s coordinate system in Chapter 13, ‘Working with coverages’.

In the Shapefile Properties dialog box, the name of the coordinate system appears next to the Spatial Reference property in the Field Properties list.

8. Click OK in the Shapefile Properties dialog box.

---

**Selecting an existing coordinate system**

1. In the Spatial Reference Properties dialog box, click Select.

---

The coordinate system’s name appears next to the Spatial Reference property.
2. Navigate to the coordinate system you want to use. For example, you can use one of the predefined coordinate systems in the Coordinate Systems folder that was provided with ArcCatalog. Or, you can use a projection file that was created with ArcInfo Workstation.

3. Click the coordinate system.

4. Click Add.

   The coordinate system’s parameters are listed in the Spatial Reference Properties dialog box.

5. If you wish, click Modify to change the coordinate system parameters. Or, click Clear and repeat steps 1 through 4.

6. Click OK in the Spatial Reference Properties dialog box.
Importing a coordinate system

1. In the Spatial Reference Properties dialog box, click Import.

2. Navigate to the data source whose coordinate system parameters you want to copy. For example, you can get coordinate system information from coverages, rasters, or feature datasets and feature classes in a geodatabase.

3. Click the data source.

4. Click Add.

   The coordinate system's parameters are listed in the Spatial Reference Properties dialog box.

5. If you wish, click Modify to change the coordinate system parameters. Or, click Clear and repeat steps 1 through 4.

6. Click OK in the Spatial Reference Properties dialog box.
Defining a new geographic coordinate system

1. In the Spatial Reference Properties dialog box, click New and click Geographic.
2. Type a name for the custom coordinate system.
3. Type the appropriate semi-major and semiminor or inverse flattening values and type a name for your custom Spheroid and Datum.
   Or click the Datum or Spheroid Name dropdown arrow and click a predefined datum or spheroid.
4. Type the appropriate Radians per unit and type a name for your custom units.
   Or click the Angular Unit dropdown arrow and click a predefined unit of measure.
5. Type the appropriate degrees, minutes, and seconds defining the prime meridian and type a name for this line of longitude.
   Or click the Prime Meridian dropdown arrow and click a predefined line of longitude.
6. Click OK.
7. Click OK in the Spatial Reference Properties dialog box.

Tip
Modifying default parameters
When creating a custom coordinate system, if you choose an object, such as a datum or spheroid, from one of the dropdown lists, those parameter values will be read-only. To modify them, click the dropdown arrow again and click <custom>. Change the default values appropriately and type a name for your custom set of parameters.
Defining a new projected coordinate system

1. In the Spatial Reference Properties dialog box, click New and click Projected.

2. Type a name for the custom coordinate system.

3. Click the Projection Name dropdown arrow and click one of the supported projections.

4. Type the appropriate parameter values for the projection.

5. Click the Linear Unit dropdown arrow and click a predefined unit of measure.
   Or click <custom> in the dropdown list, type the appropriate meters per unit, then type a name for your custom units.

6. Define the projection’s datum by selecting a predefined geographic coordinate system or defining a new geographic coordinate system. Afterwards, you can modify the geographic coordinate system’s parameters if you wish.

7. Click OK.

8. Click OK in the Spatial Reference Properties dialog box.
Modifying a coordinate system’s parameters

1. In the Spatial Reference Properties dialog box, click Modify.

The Geographic or Projected Coordinate System Properties dialog box appears.

2. Follow the steps for defining either a new geographic or a new projected coordinate system to change the appropriate parameters.

3. Click OK.

4. Click OK.

Saving a coordinate system to a file

1. In the Spatial Reference Properties dialog box, click Save As.

2. Navigate to the location where you want to place the coordinate system file. For example, place it in a shared folder on the network.

3. Type a name for the coordinate system file and click Save.

4. Click OK.

The coordinate system file appears in the folder’s Contents list.
If you are using ArcEditor™ or ArcInfo, you can use ArcCatalog to manage your coverages. The version of ArcGIS that you are using appears in the title bar of the ArcCatalog window. ArcCatalog lets you build a coverage’s topology, define its projection, and set its tolerances. Similarly, ArcCatalog lets you add, alter, and index attributes for coverage feature classes and INFO tables.

With ArcCatalog, you can also define the associations between coverages and INFO tables in a folder by creating relationship classes. When editing a coverage’s features in ArcMap, if the coverage participates in a relationship class with an INFO table, you can edit the INFO table’s attributes at the same time. In ArcCatalog, if there is a composite relationship between coverages, then when a feature is moved, its related feature is moved in the same way.
Creating a new coverage

ArcCatalog lets you create new, empty coverages. When assembling data, it’s important to use a master coverage as a template for all the coverages in a project so they can be overlaid correctly; otherwise, common features in different coverages, such as a shoreline, may not line up. When you create a new coverage using a template, the template coverage’s tic points, boundary, and coordinate system information are copied to the new coverage. If you don’t use a template, you must add tics to the new coverage before you can add features to it. You aren’t required to set the new coverage’s boundary before adding features to it.

The New Coverage Wizard prompts you to choose whether the new coverage will contain single- or double-precision coordinates. You must also choose which feature class will have topology; the wizard will create the appropriate feature classes and feature attribute tables in the new coverage based on your choice.

1. In the Catalog tree, click the folder in which the new coverage will be created.
2. Click the File menu, point to New, and click Coverage.
3. Type a name for the new coverage.
4. Check the box to use another coverage as a template.
5. Click the Browse button and navigate to the coverage that will be used as a template. Click the coverage and click Open.
6. Click Next.
7. If you want to define or modify the coordinate system information for the new coverage, click Define, then follow steps 5 through 12 in the task ‘Defining a coordinate system interactively’, later in this chapter.
8. Click Next.
9. Click the dropdown arrow and click the feature class that will have topology.
10. Click Single if you want to create a single-precision coverage. Double precision is the default.
11. Click Finish.

The new coverage appears in the Catalog.
Creating a new INFO table

You can create new, empty INFO tables in ArcCatalog. The table’s name must be 32 characters or less, while column names must not exceed 16 characters in length. Columns are defined using standard ArcInfo data types such as Binary. The input width is the maximum number of characters or bytes used to store the column’s values. For numeric columns, the width must be large enough to accommodate the decimal point and negative sign. The display width is the number of spaces used to display values in ArcInfo Workstation; for decimal values, the display width should be one space greater than the input width to account for the decimal point.

1. In the Catalog tree, click the folder in which the new INFO table will be created.
2. Click the File menu, point to New, and click INFO table.
3. Type a name for the new table.
4. Click the data type of the first column in the table.
5. Type a name for the column.
6. Default values for the column's width, display width, and number of decimal places are provided based on the column's data type. You can change these values if you wish.
7. Click New item to add another column to the table, then repeat steps 4 through 6 to define the new column.
8. Repeat step 7 until all columns have been added to the table.
9. Use the arrows to navigate back and forth through the table's columns to review and modify their properties, if necessary. Click Remove item if a column must be deleted.
10. Click OK.

The new INFO table appears in the Catalog.

Tip
Creating a new workspace

To create a new workspace, first select the folder connection or folder in which the workspace will reside in the Catalog tree. Next, click the File menu, point to New, and click ArcInfo Workspace. Type a name for the new workspace, then press Enter. The new workspace appears in the folder’s Contents list.
Generating topology

The General tab in the Coverage Properties dialog box provides important information about a coverage. In addition to showing which feature classes have topology, you can find out where the coverage is stored on disk and whether it is a single- or double-precision coverage. When you click a feature class, the number of features it contains appears at the bottom of the tab.

If topology is missing for a feature class that should have it, you can generate topology using either the Build or Clean commands in the Coverage Properties dialog box. You might also use the Build command to create a feature attribute table for a feature class. Build assumes the coordinate data is correct, while Clean finds arcs that cross and places a node at each intersection. Clean also corrects undershoots and overshoots within a specified tolerance. For polygon and region coverages with preliminary topology, a red warning indicator appears in the icons for both the coverage and the appropriate feature class.

Generating topology

1. Right-click the coverage for which you want to build topology and click Properties.
2. Click the General tab.
3. Click the feature class for which you want to build topology.
4. Click Build.
5. Change the feature class or annotation class for which to build topology, if appropriate.
6. Click OK in the Build dialog box.
7. Click OK.
Cleaning a coverage

1. Right-click the coverage that you want to clean and click Properties.
2. Click the General tab.
3. Click the feature class that you want to clean.
4. Click Clean.
5. Type in the fuzzy and dangle tolerances in the Clean dialog box, if appropriate.
6. If necessary, check Clean lines only.
7. Click OK in the Clean dialog box.
8. Click OK.

Tip

Setting tolerances
You can set the fuzzy and dangle tolerances and any other tolerance for the coverage in advance using the Tolerances tab of the Coverage Properties dialog box. See ‘Setting a coverage’s tolerances’ later in this chapter.
Defining a coverage’s coordinate system

The Projection tab in the Coverage Properties dialog box shows the coverage’s coordinate system and lists its parameters. The coordinate system defines how coordinates describing features on the earth’s surface are mathematically transformed to accurately represent them on a flat map sheet. If the coverage’s coordinate system hasn’t been defined, you can do so from the Coverage Properties dialog box. The Define Projection Wizard guides you through the process.

ArcCatalog lets you either define the coordinate system’s parameters interactively or copy the information from another coverage, grid, or TIN. If the coverage already has coordinate system information, you can also use the Define Projection Wizard to change that information.

Matching another item’s coordinate system

1. Click the coverage whose coordinate system you want to define.
2. Click the File menu and click Properties.
3. Click the Projection tab.
4. Click Define.
5. Click Define a coordinate system for my data to match existing data.
6. Click Next. ▶

Matching another item’s coordinate system

1. Click the coverage whose coordinate system you want to define.
2. Click the File menu and click Properties.
3. Click the Projection tab.
4. Click Define.
5. Click Define a coordinate system for my data to match existing data.
6. Click Next. ▶
7. Click the Browse button.
8. Navigate to and click the coverage, grid, or TIN whose coordinate system you want to use. Click Open.
9. Review the coordinate system’s parameters that appear in the wizard. If you want to use this coordinate system, click Next; otherwise, locate a different coverage.
10. Click Finish.
   The coordinate system and its parameters now appear in the Coverage Properties dialog box.
11. Click OK.

**Tip**

**Different ways to see projection information**

In the Projection tab, there are two different ways to look at a coverage’s projection information. When you click Display PRJ file, you see exactly how the projection is defined in the coverage’s PRJ file. When you click Display Spatial Reference, you see the Projection Engine’s interpretation of the information in the PRJ file; check Show Spatial Reference details to list all of the coordinate system’s parameters. The Spatial Reference version is the one that is recorded in a coverage’s metadata; this way coordinate system information will be recorded in the same format for all geographic data sources.

**Tip**

**Defining coordinate systems for grids and TINs**

The way you define the coordinate system of a raster dataset that is a grid and a TIN dataset is the same way you define a coordinate system for a coverage. For other rasters, follow the steps for defining a shapefile’s coordinate system.
Defining a coordinate system interactively

1. Click the coverage whose coordinate system you want to define.
2. Click the File menu and click Properties.
3. Click the Projection tab.
4. Click Define.
5. Click Next.
6. Click the appropriate coordinate system in the Projections list on the left. A description of the coordinate system appears on the right.
7. Click Next.
8. Enter the appropriate parameter values for the coordinate system; each one has a different set of parameters.

9. Click Next.

10. If the coverage uses a projected coordinate system, click the datum it uses or click Spheroid and define the spheroid’s parameters.

11. Click Next.

12. Review the summary of the coordinate system that will be assigned to the coverage. If you want to modify the coordinate system’s parameters, go back through the wizard by clicking the Back button. Click Finish if you want to use this coordinate system.

   The coordinate system and its parameters now appear in the Coverage Properties dialog box.

13. Click OK.
Modifying a coverage’s tics and extent

Every coverage has a set of tic points as well as boundary, or extent, information. Tics are points on a map sheet for which real-world coordinates are known. Before a digitizing session, you can register tics from the paper map with the digitizer and existing features in the coverage. Later, you can use the tics to transform feature coordinates from digitizer units to a known coordinate system. From the Coverage Properties dialog box, you can add or update tics if you know their coordinates. You can also delete tics from the coverage.

A coverage’s extent defines the maximum and minimum x,y coordinate values in the coverage. Usually, ArcInfo maintains the extent for you, updating it as you add features to or remove features from a coverage. If for some reason the extent shown does not match the actual extent of the features, click Fit in the Coverage Properties dialog box to recalculate the coverage’s extent. Alternatively, you can type new extent values into the appropriate text boxes.

Adding tics

1. Right-click the coverage to which you want to add a tic and click Properties.
2. Click the Tics and Extent tab.
3. Click Add.
4. Double-click in the X column and type the tic point’s x-coordinate.
5. Double-click in the Y column and type the tic point’s y-coordinate.
6. Click OK.
**Updating tic coordinates**

1. Right-click the coverage whose tics you want to modify and click Properties.
2. Click the Tics and Extent tab.
3. Click the ID of the tic whose coordinates you want to modify.
4. Click Update.
5. Click in the X column and type the tic point’s x-coordinate.
6. Double-click in the Y column and type the tic point’s y-coordinate.
7. Click OK.

**Deleting tics**

1. Right-click the coverage whose tics you want to delete and click Properties.
2. Click the Tics and Extent tab.
3. Click the ID of the tic you want to delete.
4. Click Delete.
5. Click OK.
Recalculating the extent
1. Right-click the coverage whose extent you want to recalculate and click Properties.
2. Click the Tics and Extent tab.
3. Click Fit.
4. Click OK.
The extent is recalculated.

Updating the extent manually
1. Right-click the coverage whose extent you want to modify and click Properties.
2. Click the Tics and Extent tab.
3. Click in the text box of the appropriate extent value and type the new coordinate value.
4. Repeat step 3 until all the extent coordinates are correct.
5. Click OK.
Setting a coverage’s tolerances

Many coverage operations use tolerances. For example, when you digitize or edit with node snapping turned on, two nodes are automatically snapped together if they fall within a given distance of each other; that distance is the Node Snap tolerance. Tolerances are distances in the coverage’s units. If the feature coordinates are in digitizer units, the tolerances are likely in inches; if the features are projected, the tolerances are likely in feet or meters.

The Tolerances tab lists the current values for all of a coverage’s tolerances. You’ll see Default next to values that have been suggested by ArcInfo. You may want to change the default tolerances to values that are more appropriate for the type and scale of features in the coverage; when you do so in the Tolerances tab, Default disappears. You can also set tolerances when using an ArcToolbox tool or an ArcInfo Workstation command. When you open the Coverage Properties dialog box after running the tool or command, Verified appears next to the tolerance that was used.

1. Click the coverage whose tolerances you want to set.
2. Click the File menu and click Properties.
3. Click the Tolerances tab.
4. Click in the text box of the tolerance whose value you want to modify and type the new value.
5. Repeat step 4 until all the tolerance values are correct.
6. Click OK.
Maintaining attributes

Features usually have descriptive information stored in attributes. Attributes can either reside in the feature attribute table or in separate INFO tables; INFO tables can be associated with the feature attribute table using a relate or a relationship class. Both relates and relationship classes use a common attribute to establish a temporary connection between corresponding records in two tables.

The properties dialog box for an INFO table and a coverage feature class is the same. When you open the properties dialog box for a table or feature class, you will see an FID column, which contains the unique identifier for each record or feature. A feature class also has a Shape column and may have several pseudo items, such as the angle of rotation for marker symbols. Pseudo items are maintained by ArcInfo; their names are preceded by a dollar sign ($), for example, $ANGLE. If a feature class has an attribute table, you will also see several attributes.

In the properties dialog box for a table or feature class, you can add, update, and delete.

Adding a new attribute

1. Right-click the coverage feature class or INFO table to which you want to add an attribute and click Properties.
2. Click the Items tab.
3. Under Item Name, click the attribute after which the new attribute should be placed. The attribute should not be a redefined attribute or a pseudo item. If an attribute is redefined, Yes appears in the Redefined column. For pseudo items, N/A appears under Column to the left of the attribute’s name.
4. Click Add.
5. Type the new attribute’s name in the Add Item dialog box.
6. Click next to Type, click the dropdown arrow, then click the appropriate data type for the values the attribute will contain.
attributes and create indexes for the values the attributes contain. You can only modify and delete columns in the attribute table that are not maintained by ArcInfo. Index an attribute to improve the performance of operations that access its contents, such as selecting features with specific attribute values. If you index the shape column, a spatial index will be created, which improves the performance of any operation that retrieves features by location. After modifying the values in a column, delete the existing index and add a new one.

In addition to new attributes, you can add redefined attributes. Add a redefined attribute to combine or divide the values in existing attributes. Redefined attributes are useful for customizing how the values in a table are displayed. For example, you might choose to show one redefined attribute that concatenates values rather than showing two separate, adjacent columns.

7. Type an appropriate input width and display width for the attribute’s values, then type the maximum number of decimals the values can have, if appropriate. Valid input widths may be presented as a dropdown list.

8. Type a more descriptive name for the attribute, if appropriate.

9. Click OK.

The new attribute appears in the Properties dialog box.

10. Click Apply to save your changes.

11. Click OK.
Adding a redefined attribute

1. Right-click the coverage feature class or INFO table to which you want to add a redefined attribute and click Properties.
2. Click the Items tab.
3. Under Item Name, click an attribute that is not a redefined attribute or a pseudo item. For redefined attributes, Yes appears in the Redefined column. For pseudo items, N/A appears under Column, to the left of the attribute’s name.
4. Click Add.
5. Click next to Redefined, click the dropdown arrow, and click Yes.
6. Click next to Column and type the starting position for the redefined attribute.
7. To define the attribute’s properties, follow steps 6 through 10 for ‘Adding a new attribute’.
8. Click OK.
   Redefined attributes are listed below other attributes in the Properties dialog box.
9. Click Apply to save your changes.
10. Click OK.
Modifying an attribute

1. Right-click the coverage feature class or INFO table containing the attributes you want to modify and click Properties.
2. Click the Items tab.
3. Under Item Name, click the attribute you want to modify.
4. Click Edit.
5. In the Value column, click next to the property you want to change. Type a new value or click a new value in the dropdown list, as appropriate. You can only change the Input Width of a redefined attribute.
6. Repeat step 5 until all properties of the attribute have correct values.
7. Click OK.
   The attribute's properties are updated in the Properties dialog box.
8. Click Apply to save your changes.
9. Click OK.
Deleting an attribute

1. Right-click the coverage feature class or INFO table containing the attribute you want to delete and click Properties.
2. Click the Items tab.
3. Under Item Name, click the attribute you want to delete.
4. Click Delete.
   The attribute no longer appears in the Properties dialog box.
5. Click Apply to save your changes.
6. Click OK.
Adding and removing indexes

1. Right-click the coverage feature class or INFO table whose indexes you want to modify and click Properties.

2. Click the Items tab.

3. Under Item Name, click the attribute to which you want to add or from which you want to remove an index.

4. Click Add Index to create an index of the attribute’s values. Click Delete Index to remove an existing index on the attribute’s values.

   The value in the Indexed column changes to Yes or No depending on whether an index was added or deleted.

5. Click Apply to save your changes.

6. Click OK.
What is a relationship class?

Features in a coverage often have associations with features in other coverages or attributes in separate tables. You can define these associations in the Catalog by creating relationships, which are stored in relationship classes. On the surface, a relationship is similar to an ArcInfo relate, although relationships let you represent associations more accurately.

With a relationship, you can define which column in a feature class’s attribute table and which column in another table share the same values. Once created, the relationship lets you establish a temporary connection between a coverage’s features and descriptive attributes in a table. You can use the related attributes to label, symbolize, or query the features; you can also edit them when editing the features in ArcMap.

Properties of a relationship

One property of a relationship is its cardinality, which describes how many features in the coverage are related to how many records in the other attribute table. If the associated table contains measurements taken at a point in the coverage, the relationship will be one to many: one point to many measurements. In general, relationships can have one-to-one (1–1), one-to-many (1–M), many-to-one (M–1), and many-to-many (N–M) cardinalities.

In the example above, the point feature class in the coverage is the origin of the relationship, and the table containing the measurements is the destination. The columns used to connect these data sources are key attributes. The point feature class, the origin, has an attribute containing a code for each station; this is the primary key for the relationship. The measurements table has an attribute indicating which station the measurements were taken at; this is an embedded foreign key.

Relationships have path labels that describe the nature of the association. The forward path label describes the relationship when navigated from the origin to the destination; for example, station points have measurements. The backward path label describes the same relationship when navigated from the destination to the origin; in this example, measurements “are taken at” stations.

Types of relationships

There are two types of relationships: simple and composite. Simple relationships describe associations between data sources that exist independently of each other. A coverage and table are independent of each other if, when you delete the origin coverage, the destination table continues to exist.
In the previous example, if you started taking measurements at a new point upstream and deleted the old point from the coverage, you would still keep the measurements taken from the old station for historical purposes. The relationship, therefore, is a simple one.

*Composite relationships* describe associations where the lifetime of one object controls the lifetime of its related objects. An example is the association between highways and points for placing a highway shield marker. The primary key in the line feature class in the highways coverage has a unique code for each line. The foreign key in the point feature class in the shields coverage contains the code for the line it is associated with. Shield points can’t exist without a highway.

After creating the composite relationship, when you edit highway lines in ArcMap your changes will affect marker points in the shields coverage. When you move, rotate, or delete a highway line, a message is sent to the related points, which are then moved or deleted appropriately. The default is for messages to be sent along the forward path in the relationship, though you can choose to send them backwards as well.

Simple relationships can have one-to-one, one-to-many, or many-to-many cardinalities. A many-to-one relationship is, by definition, a one-to-one relationship. Composite relationships always have a one-to-many cardinality. When you create a one-to-many relationship, whether simple or composite, the “one” side of the relationship must be the origin. The “many” side must be the destination.

One object can participate in many relationships. For example, in addition to the composite relationship between highways and shield points, the highway line feature class might have a simple relationship to an INFO table. In this case, each highway line has a code indicating the type of surface used, and the related table contains a description of each surface code, so many highways share the same surface description. To describe this second association, you would create a simple, one-to-one relationship.

Although all the above examples have included coverages, it is important to note that you can create a relationship class to define an association between two INFO tables.

**Coverage relationship classes**

As described in Chapter 11, ‘Working with maps and layers’, layers may define joins and relates between geographic and tabular data that are stored in different formats or in different ArcInfo workspaces. Joins and relates provide similar functionality to simple relationship classes, except that they must be defined for each individual layer.

You can create a coverage relationship class to model the relationships between objects in an ArcInfo workspace in a permanent and realistic fashion. Once created, the information can be reused in many layers. ArcMap will detect when a relationship class exists and let you easily access and edit related attributes. With composite relationships, as you edit features in a coverage, related features and attributes are edited appropriately.

Coverage relationship classes are essentially the same as the relationship classes you can create in a geodatabase. For specific information regarding relationship classes in geodatabases, see *Building a Geodatabase* or the appropriate topics in the ArcGIS Desktop Help system.
Creating a coverage relationship class

You can create a simple or composite relationship class between any two tables and feature classes in the same folder that share a common attribute. Related feature classes may exist in the same coverage or in different coverages. Create a simple relationship if the objects in the origin and destination exist independently of each other. Create a composite relationship if the lifetime of the objects in the origin controls the lifetime of the objects in the destination.

A relationship class lets you query, label, and symbolize the features in the coverage using attributes in the associated table. With any relationship class, you can edit attribute values in the destination in ArcMap while editing the origin coverage’s features. For example, with a composite relationship class, when you move, rotate, or delete the power lines in the origin coverage, ArcMap automatically moves or deletes poles in the destination coverage.

The relationship classes in which a coverage feature class or an INFO table participates are listed in the Relationships.
9. Type the forward and backward path labels for the relationship.
10. Click Next.
11. Click the appropriate cardinality for this relationship.
12. Click Next. 

Tab in their Properties dialog box. Click a specific relationship in the list and click Properties to learn more about it. For example, you can determine all the coverages and tables to which an INFO table is related. An item’s relationships are also recorded in its metadata; with the ESRI stylesheet, you’ll find the item’s relationships listed at the bottom of the Attributes tab in the metadata.
13. Click the first dropdown arrow to see a list of attributes in the origin table or feature class. Click the primary key for this relationship.

14. Click the second dropdown arrow to see a list of attributes in the destination table or feature class. Only those attributes that have the same data type as the primary key are listed. Click the foreign key for this relationship.

15. Click Next.

16. Review the options you specified for the new relationship class. If you want to change something, you can go back through the wizard by clicking the Back button.

17. When satisfied with your options, click Finish. The new relationship class appears in the folder’s contents.

The new coverage relationship class appears in the folder’s contents.
Raster datasets include many different types of information. Orthophotos, satellite images, and digital elevation models are just a few of the many raster categories. Raster datasets consist of a matrix of pixels—where each pixel represents an area, usually a geographic location, and has a numeric value. The value represents the feature being observed; for example, the pixel values in a digital aerial photograph represent the amount of light reflecting off the earth’s surface, which we could interpret to be trees, houses, or streets, and the pixel values in a DEM represent elevations. A raster dataset is often displayed within a GIS as a backdrop to enhance a map’s informational content or cartographic representation or to allow the user to build or edit new datasets.

ArcCatalog allows you to manage, create, and preview your raster datasets and raster catalogs. This chapter will discuss working with rasters in ArcCatalog, along with how raster dataset formats, attributes, and properties are handled within ArcGIS.
Raster dataset properties

A raster dataset’s Properties dialog box lists the specific details associated with each raster. These properties are divided into five sections: Data Source, Raster Information, Extent, Spatial Reference, and Statistics. You can collapse and expand each of these five sections as you explore this information; by default, all sections are expanded.

Data Source information is listed first. This section describes the raster dataset’s name, type, and location. If the raster dataset is on a server, it has server information rather than path information.

The Raster Information section lists raster-specific properties including:

- Number of pixels per column and row
- Number of bands
- Cell size (x, y)
- Uncompressed size
- Format
- Source type (continuous/discrete)
- Pixel type (unsigned/signed; integer/floating point)
- Pixel depth (1, 2, 4, 8, 16, 32, 64)
- NoData value
- Colormap (present/absent)
- Pyramids (present/absent)
- Compression type

The Extent section describes the rectangle (boundary) containing all of the raster dataset’s data. The top, bottom, left, and right coordinates of the rectangle are listed in the same spatial reference that the raster is stored.

The raster dataset’s coordinate system is described in the Spatial Reference section. All of the spatial reference’s parameters are listed; if a coordinate system has not been defined, this will be noted instead. To edit the spatial reference information, click Edit and follow the instructions in the dialog box that appears. For more information, please see ‘Setting a grid’s coordinate system’ or ‘Setting a nongrid raster dataset’s coordinate system’, in this chapter.

The Statistics section lists several of the raster dataset’s statistics: minimum value, maximum value, mean value, standard deviation, and the number of classes. If the statistics have not been calculated, or you wish to recalculate them, you can calculate them by clicking Options, then clicking Build Statistics.
Exploring geodatabase raster catalogs

A raster catalog is a container for raster datasets (for example, grids, DEMs, or other imagery). Raster catalogs can be created as unique objects within a geodatabase or they can be defined using a table. Exploring the contents of geodatabase raster catalogs is different from exploring the contents of table-based raster catalogs. For geodatabase raster catalogs, the Contents tab in ArcCatalog lets you view the contents of the raster catalog in table format. At the same time, you can select raster datasets in the table and see detailed information about them. You can select rasters by clicking rows in the table or by performing attribute queries on the table.
When you select a geodatabase raster catalog in the Catalog tree, the Contents tab lists its raster datasets and their attributes in table format. You can explore this table in the same manner as in Table view—you can add new fields, sort the fields, and export this table. However, the Contents tab also offers many additional options for exploring the raster catalog’s contents.

Options for previewing raster datasets

By clicking the Show/Hide button on the right edge of the window, you can add a data view to the Contents tab alongside the table. The data view lets you see detailed information about individual raster datasets within the raster catalog. All of the views that are available in ArcCatalog are available in the data view except for Table view. Additionally, you can view raster dataset properties and list the raster bands within the raster dataset. The choices in the dropdown list are:

- Properties—displays a raster dataset’s properties
- Geography—previews raster datasets either individually or in the context of the entire raster catalog
- Metadata—displays the metadata for a raster dataset or for the entire raster catalog
- Bands—lists the bands contained within a raster dataset

By default, Geography view is used. In this context, Geography view is a little different from the Preview tab. It has two previewing options, which are available on two different tabs: Overview and Selection; these are discussed in more detail below. To change the view, click a different option in the dropdown list in the bottom right corner of the Contents tab.

Previewing selected raster datasets

When you initially select a geodatabase raster catalog, no raster datasets are selected in the table. When no records are selected, Geography view’s Overview tab in the data view displays the extent of each raster dataset within the raster catalog—this is referred to as the wire frame format. Because no raster datasets are selected, the Selection tab will not display anything. The
Metadata view will show a description of the entire raster catalog. When no records are selected, the other views will show nothing.

Select a raster dataset by clicking the gray button to the left of its record in the table. Selected records are highlighted in the table. Once a raster dataset has been selected, all views can be used to show information. The Overview tab in Geography view draws the raster dataset in the context of the entire raster catalog; the raster dataset draws within the appropriate extent rectangle in the wire frame. The Selection tab in Geography view displays the raster dataset on its own. The Metadata, Properties, and Bands views show information describing the individual raster dataset.

You can select more than one by holding the Ctrl key on the keyboard and clicking the buttons next to additional records in the table. When many raster datasets are selected, the Overview tab displays all the selected rasters on the wire frame. The Selection tab draws the selected rasters without the wire frame. For the other views, a selection counter appears next to the dropdown list; use it to navigate through the selected set and view metadata, properties, or the bands for one raster dataset at a time.

### Querying the geodatabase raster catalog

You can select several raster datasets at the same time by querying the raster catalog; any information in the raster catalog’s table can be used in the query. Either type a query in the Query text box or click the Query Builder button and use the Build Query dialog box. Check Use Results to Select Rows to select the raster datasets that satisfy your query in the table. Click Apply to execute the query. You can change the table’s view to show all records or only those that are selected.

To learn more about the geodatabase raster catalog file format, see *Building a Geodatabase*. 
Changing raster dataset previewing properties

A raster dataset can be displayed with either one band or three bands simultaneously. If a raster dataset has more than three bands, only three can be displayed at one time. When you preview a single-band raster dataset, the value of each cell is drawn as a shade of gray (by default), as random colors if the file has less than 25 unique values, or as a set of predetermined colors if a colormap is present.

When you preview a multiband raster dataset, three of its bands are combined to form a composite image in which each band supplies either the red, green, or blue display value. From the Raster tab in the Options dialog box, you can choose which band will provide which value. You can specify a different set of defaults, mapping bands to red, green, and blue (RGB) display values for datasets with three bands, and also with four or more bands.

1. Click the Tools menu and select Options.
2. Click the Raster tab.
3. Under 3 band data source, type the number of the band that will provide the red display values.
   Type the number of the band that will provide the green values.
   Type the number of the band that will provide the blue values.
4. Repeat step 3 for raster datasets with four or more bands.
5. Click OK.
Choosing which raster dataset formats appear in ArcCatalog

The raster dataset formats that can be directly accessed by ArcCatalog are listed in the Raster tab of the Options dialog box and described in the online Help topic, ‘Supported raster dataset formats’.

At times, you may not want to see all types of raster datasets in the Catalog. For example, the same data may be stored in different formats and you want to work with only one of those formats at a time. Raster dataset files often have a well-known extension describing the format of the data they contain—for example, .jpg. If a raster dataset is in a format supported by ArcCatalog but its file extension doesn’t appear in the Raster tab’s list, it won’t appear in the Catalog; for example, only files with the extension .tif are recognized as TIFF images by default and not .tiff files. You can customize the list of file extensions that are associated with a raster dataset format; if you add .tiff to the list of extensions for TIFF images, they will appear in ArcCatalog as raster datasets.

Displaying specific raster formats

1. Click the Tools menu and click Options.
2. Click the Raster tab.
3. Click the General tab.
4. Click File Formats.
5. Click the option to Search only files that match the following file extensions to find valid raster formats.
6. Uncheck the formats you don’t want to see as rasters in the Catalog.
7. Check the formats you want to see in the Catalog.
8. Click OK, click OK.

Displaying all raster formats

1. Click the Tools menu and click Options.
2. Click the Raster tab.
3. Click the General tab.
4. Click File Formats.
5. Click Search all files to find valid raster formats.
6. Click OK, click OK.
Not all raster datasets have file extensions, and some are stored as folders. Because identifying such raster datasets takes more time, ArcCatalog skips those without extensions by default when searching through a folder’s contents. Therefore, they won’t appear in the Catalog. The exception is the ESRI grid format, which is quick to search for even without a filename extension. By default, the Catalog will always search for grids. If you choose to search all files and display all raster datasets, the contents list will be slower to appear, but you will see an accurate listing of all raster datasets in all folders.

### Changing which files appear as raster datasets

1. Click the Tools menu and click Options.
2. Click the Raster tab.
3. Click the General tab.
4. Click File Formats.
5. Scroll down until you see the appropriate raster format in the list.
6. Click in the File Extensions column to the right of the raster format’s name.
7. Move the cursor to the end of the selected file extension.
8. Type a semicolon (;), then type an asterisk (*) and period (.) followed by the letters of the file extension. For example, if you add the file extension ".wbp" into the File Extensions column to the right of Windows Bitmap, both .bmp and .wbp files will be recognized as Windows Bitmap images in ArcCatalog.
10. Click OK, click OK.
Defining a raster dataset’s coordinate system

The Spatial Reference section in the Raster Dataset Properties dialog box shows the raster dataset’s map projection and lists parameters of the projection. The projection defines how coordinates describing locations on the earth’s surface are mathematically transformed to accurately represent them on a flat map sheet, with the least amount of distortion. There will always be some sort of distortion in geographic data since you are trying to put three-dimensional data onto a two-dimensional plane. When you choose a spatial reference, you need to choose the projection which will minimize the type of distortion you are most concerned about.

If the raster dataset doesn’t have a coordinate system, you can assign one by clicking the Edit button. If the raster dataset is a grid, you will see the Define Projection Wizard. You can either define the coordinate system’s parameters interactively or copy the information from another coverage, a grid.

Setting a grid’s coordinate system

1. Right-click the raster dataset and click Properties.
2. In the Properties dialog box, scroll to the Spatial Reference information.
3. Click Edit.
or a TIN. If the raster dataset already has coordinate system information, you can also use the Define Projection Wizard to change that information. If the raster dataset exists as a format other than a grid, you will see the Spatial Reference Properties dialog box.

Tip

**Go back to make changes**

If you want to change any of the parameters in the wizard, you can go back by clicking the Back button.

Tip

**Defining coordinate systems for grids**

The way you define the coordinate system of a raster dataset that is a grid is the same way you would define a coordinate system for a coverage or a TIN. For other raster datasets, please see the following section.

4. Select Define the coordinate system interactively.

   You can select the other option; however, it will take you through some steps not represented here.

5. Click Next.

6. Click the appropriate coordinate system in the Projections list in the left. A description of the coordinate system appears on the right.

7. Click Next.

8. Enter the appropriate parameter values for the coordinate system; each one has a different set of parameters.

9. Click Next.
10. If the grid uses a projected coordinate system, select the datum it uses, or click Spheroid and define the spheroid’s parameters.

11. Click Next.

12. Review the summary of the coordinate system that will be assigned to the grid.

13. Click Finish.

14. Click OK in the Raster Dataset Properties dialog box.
Setting a nongrid raster dataset’s coordinate system

1. Right-click the raster dataset and click Properties.

2. In the Properties dialog box, scroll to the Spatial Reference information.

3. Click the Edit button.

4. In the Spatial Reference Properties dialog box, click Select to choose a pre-defined coordinate system. Or click Import to match the coordinate system of another data source. Or click New to define a new, custom coordinate system. Or click modify to change the current coordinate system’s properties.

5. Browse the dialog box to choose the projection that is required for your raster dataset.

   You will need to open up several folders before you can choose your correct projection.

6. Click Add.

7. Click OK in the Spatial Reference Properties dialog box.

8. Click OK in the Raster Dataset Properties dialog box.
Creating raster dataset pyramids

The amount of detail you see when drawing a raster dataset depends on its cell size. When each cell covers a small area to maintain detail, many cells are required to cover a large region; therefore a raster dataset can be very large, occupying a lot of space on disk and taking a long time to draw. To avoid this problem, you can create pyramids. Pyramids are a set of reduced resolution datasets that are created for a source raster dataset. Each successive layer of the pyramid is downsampled at a scale of 4:1.

With pyramids, the coarsest level of resolution displays quickly when drawing the entire dataset. As you zoom in, levels with finer resolutions are drawn; performance is maintained because you’re drawing successively smaller regions from the previously resampled data. Without pyramids, the entire dataset must be examined before the appropriate subset of cells can be displayed.

On building pyramids, a Reduced Resolution Dataset (.rrd) file is created. For an uncompressed raster dataset, this file is approximately 8 percent of the original raster dataset file size.

Building pyramids in ArcCatalog

1. Right-click the raster dataset in the Catalog tree.
2. Click Build Pyramids.
3. Navigate to the raster dataset you would like to build pyramids for, if it is not already selected.
4. Click Ok.

On building pyramids, a Reduced Resolution Dataset (.rrd) file is created. For an uncompressed raster dataset, this file is approximately 8 percent of the original raster dataset file size.

WORKING WITH RASTERS
You cannot build pyramids on a raster catalog, but you can build pyramids on each raster dataset within the raster catalog.

**Tip**

**Where is pyramid information written for a read-only file?**

Pyramid information will be written to the proxy file location if the file or folder associated with the raster dataset is read-only.

**Tip**

**Have pyramids been created?**

Pyramids are created for the whole dataset, including all bands, if you choose to build them. To check if pyramids are present, right-click the raster dataset and click Properties, then click the General tab. Check to see if the pyramids are present.

---

**Changing default settings for creating pyramids**

1. Click the Tools menu and click Options.
2. Click the Raster tab.
3. Click the appropriate choice describing when pyramids should be created.
4. Click OK.

---

**Options**

2. Raster tab

3. Build Pyramids Dialog Settings

4. Apply button
Creating raster dataset statistics

Statistics are required for your raster dataset in order to perform certain tasks in ArcMap or ArcCatalog, such as applying a contrast stretch or classifying data. It is not essential that statistics are calculated right away, since they are created the first time they are needed in ArcMap. However, it is recommended that you calculate statistics if you wish to render them using any of the stretching techniques. Statistics are permanently saved in an auxiliary (.aux) file if the raster dataset’s file format does not accommodate the storage of statistics.

You cannot recalculate statistics on a GRID dataset since they are stored within that format and are always present. The statistics will have been calculated using every cell in the GRID except for cells with the value of nodata.

1. Right-click the raster dataset and click Calculate Statistics.
   If statistics have already been calculated, you have the option to keep the current statistics or to calculate them again.

2. Navigate to the raster dataset you want to build statistics for, if it is not already set.

3. Choose the appropriate skip factors to use for calculating statistics.
   A skip factor of one for both row and column means every cell in the raster dataset will be used in the calculation, resulting in the most accurate statistics.

4. Enter a value you want to ignore when calculating statistics—this is often the background value.
   Eliminating such a value will often result in a more appropriate calculation.

5. Click OK.

Tip
What if the file is read-only?
Statistical information will be written to the proxy file location if the file or folder associated with the raster dataset is read-only.
Additional raster dataset file information

**Auxiliary files**

An Auxiliary file (.aux) is a file that accompanies the raster dataset in the same writable location and stores any auxiliary information that cannot be stored in the raster dataset file itself.

This is where statistical information for the raster dataset will be stored if it cannot be stored internally within the raster format. It will be created automatically the first time statistics are required to perform a task on your raster layer. It may take longer to create this file for larger raster datasets because more cells need to be accessed to derive the statistics. However, once they have been created, it will be reused for future procedures that require statistical information.

The .aux file will also store a pointer to the pyramid file (.rrd) if pyramids have been created for your raster dataset. If you use the operating system to move the raster dataset from its directory after the pyramids have been built, the software will look in the location the pointer indicates to find the .rrd file. If it cannot find the .rrd file there, it will look in the directory into which you have moved the dataset. It is recommended that you copy or move datasets using ArcCatalog in order to make sure you copy all related files.

**Pyramid files**

The pyramid file that gets created, when you choose to build pyramids, is a Reduced Resolution Dataset (.rrd) file with the same file name as the dataset.

A requirement for building an .rrd file for a raster dataset is to have write access to the directory where the dataset resides. The .rrd file will be created in the same directory as the source dataset. The next time you add this raster dataset, these pyramids will be used. One exception to this rule is ERDAS® IMAGINE® files, where the pointer to the pyramids is stored in the IMAGINE file.

In this case you must have write access to the raster dataset and the directory in which it resides.

For uncompressed raster datasets, the minimum .rrd file size is approximately 8 percent of the size of the original dataset. In certain situations; however, the size of the .rrd file created can be larger than the original file—depending on the compression technique used in the original raster dataset. If your .rrd file exceeds 2 GB, then a Reduced Resolution Dataset External raster dataset file (.rde) is created as a supplementary file.

Pyramids cannot be built for a raster catalog; however, you can build pyramids on each raster dataset within the raster catalog.

**Proxy files**

When a raster dataset is used in ArcGIS, and auxiliary information, such as statistics, histograms, and pyramids, cannot be found inside the raster dataset or in an associated auxiliary file, ArcGIS will build and store it. Normally, this information is stored inside the raster dataset itself—if the file format allows it—or it can be written to auxiliary files next to the raster dataset. When a raster dataset is marked with read-only permissions or when the folder it is located in is marked read-only, then these auxiliary files are subsequently written to a different writable location and are known as proxy files.

Three types of information can be written to the proxy location:

- Proxy Unrestricted Access Image (UAI) files point to the read-only raster dataset and use a uniquely named prefix that incorporates the pathname of the data and a .uai suffix. This is the file that points to the original read-only data. This naming convention is used to avoid overwrites of auxiliary files when similarly named raster datasets are from different folders.
• Proxy .aux files are the main auxiliary file associated with the UAI file. This file follows the UAI file prefix naming convention but has an .aux suffix. Like normal .aux files, the proxy .aux files store additional information, which is created by ArcGIS.

• Proxy .rrd files hold the pyramid data like normal .rrd files, but they are stored in the proxy location because of the read-only permissions of the raster dataset or the folder. The proxy location will never contain original raster data.

The raster proxy files are placed in a folder called rasterproxies located in each user’s temporary directory. This location will vary per user. If it is deemed preferable or necessary to change the location, a registry setting is provided for this purpose.

As you cannot remove read-only raster datasets using ArcCatalog, including raster datasets on read-only media, it is recommended that you manually remove unnecessary proxy files periodically, to avoid keeping unnecessary files on your hard-disk. Proxy pyramid files (.rrd) can grow substantially large.

**Performance tuning**

There are many different formats of raster datasets that use different mechanisms to improve access speed. ArcGIS provides the ability to make these many formats behave in a similar manner so the end user is required to know less about a particular format. Since raster datasets can be large, these added abilities are oriented toward tuning display performance. Here are some ways to improve the performance of files:

• Creation of pyramids—improves the display speed of large rasters
• Raster dataset compression—reduces storage space
• Calculation of statistics—for proper rendering and to be able to perform statistical operations
• Display resampling—improves the way your raster dataset is displayed
• Geodatabase rasters—multiuser access to raster datasets; also for large raster dataset holdings (gigabytes to terabytes)
After working with ArcCatalog awhile, you might want to customize its appearance to reflect your own preferences. Whether you want to hide toolbars you don’t use, modify toolbars and their contents, or create a custom toolbar, you can do it without writing a single line of code. You can add custom commands that others have created or, if you know Visual Basic, you can write macros and create custom commands yourself. This chapter will help you start tailoring the Catalog’s user interface to meet your needs. More detailed information can be found in Exploring ArcObjects.
Basic user interface elements

ArcCatalog has Main Menu and Standard toolbars. Both are referred to as toolbars, although the Main Menu toolbar contains menus only.

Any toolbar can be docked at the top or bottom or to the left or right side of the ArcCatalog window. Alternatively, toolbars can float on the desktop while functioning as part of the application. When a toolbar is docked, it is moved and resized with the ArcCatalog window. The Catalog tree is docked on the left by default, but you can dock it elsewhere in the window or have it float on the desktop. To prevent a toolbar or the Catalog tree from docking, hold down the Ctrl key while dragging it.

Toolbars can contain menus, menu items, buttons, tools, combo boxes, and edit boxes; these are different types of commands. Each type of command lets you interact with the user interface differently.

- **Menus** arrange other commands into a list.
- **Buttons** and **menu items** perform actions when clicked.
- **Tools** require interaction with the user interface before an action is performed. The Zoom In command is a good example of a tool—when you click or drag a rectangle over data in Geography view, ArcMap redraws the data at a larger scale.
- **Combo boxes** let you type information or choose an option from a dropdown list. For example, the Location combo box on the Standard toolbar lets you select an item by typing its path or by choosing a path from its dropdown list.
- **Text boxes**, or **edit boxes**, let you type in text. In ArcMap, you can type the scale at which you want to view the map.

Each command is associated with code. When you click a command, the code for the click event starts running. **Events** are fired when you interact with a command. Each type of command behaves differently because it has a different set of properties, methods, and events.

**Changing the Catalog’s appearance**

You can group commands, add new macros, or add custom commands in ArcCatalog using the Customize dialog box. The Customize dialog box resembles and has many of the same properties as the equivalent dialog box in Microsoft Office 2000 applications. If you’ve customized any of those applications, the process will be familiar to you.

The Customize dialog box lets you modify existing menus, toolbars, and context menus with simple drag-and-drop techniques. Afterward, if you prefer, you can return the menus and toolbars that are built into the Catalog to their default settings. You can create your own menus and toolbars, too.
Customizing toolbars

All of the Catalog’s toolbars are visible by default; if a toolbar’s commands don’t work with the current view, the toolbar is unavailable. To change which toolbars are available, use the Toolbars list in the View menu or the Customize dialog box. A check mark next to the toolbar’s name indicates that it’s available. Although it appears in the list, you can’t hide the Main Menu. When showing a toolbar for the first time, it appears as if it is floating on the desktop. If it was previously turned on, it returns to its last position. You can resize floating toolbars to see their commands however you like. A toolbar remembers its floating size even after you hide or dock it. To quickly hide a floating toolbar, click its Close button.

Customizing toolbars lets you tailor ArcCatalog into a powerful and efficient application. For example, you can create your own toolbars to quickly access your most frequently used ArcToolbox tools. You can rename and delete custom toolbars, but you can’t rename or delete toolbars that are provided by default with, or built into, ArcCatalog. If a toolbar comes  

Hiding and showing toolbars from the View menu

1. Click the View menu and point to Toolbars.
2. Check a toolbar to show it.
   Uncheck a toolbar to hide it.

Hiding and showing toolbars from the Customize dialog box

1. Click the Tools menu and click Customize.
2. Click the Toolbars tab.
3. Check a toolbar to show it.
   Uncheck a toolbar to hide it.
4. Click Close.
from an ActiveX® dynamic link library (DLL) that you added to the Catalog with the Add from file button, it cannot be renamed.

In addition to changing which toolbars appear and adding your own toolbars, you can specify how all toolbars in the Catalog will behave using the Options tab. The commands on a toolbar can appear with large icons rather than the small images you see by default. You can also choose whether or not ToolTips appear when you hold the mouse pointer over a command.

**Creating a new toolbar**

1. Click the Tools menu and click Customize.
2. Click the Toolbars tab.
3. Click New.
4. Type the name of your new toolbar.
5. Click OK.
The new, empty toolbar appears in the Toolbars list and as a floating toolbar on your desktop.
6. Click Close.

**Renaming a toolbar**

1. Click the Tools menu and click Customize.
2. Click the Toolbars tab.
3. Click the toolbar you want to rename.
4. Click Rename.
5. Type the name of your new toolbar.
6. Click OK.
The toolbar is renamed in the Toolbars list, and it appears as a floating toolbar on your desktop.
7. Click Close.

**Tip**

**Shortcut to the Toolbars list**
You can access the Toolbars list without using the View menu. Simply right-click any toolbar or the status bar. Then, check or uncheck toolbars or click Customize.
Displaying toolbars with large icons

1. Click the Tools menu and click Customize.
2. Click the Options tab.
3. Check Large icons to display large icons for a toolbar's commands.
4. Click Close.

Showing ToolTips on toolbars

1. Click the Tools menu and click Customize.
2. Click the Options tab.
3. Check Show ToolTips on toolbars to display ToolTips when you hold the mouse pointer over a button.
4. Click Close.
Adding a command to a toolbar or menu

1. Show the toolbar to which you want to add a command.
2. Click the Tools menu and click Customize.
3. Click the Commands tab.
4. In the Categories list, click the category that contains the command you want to add.
5. Click the command you want to add in the Commands list.
6. Drag the command to any location in the target toolbar or menu. A menu's contents will appear if you hold the mouse pointer over the menu.

   A thick black line indicates where the command will be positioned.
7. Drop the command.
The command appears in the toolbar or menu.
8. Click Close.

Tip

About the Save in combo box

The Save in combo box appears on the Commands tab, in the New Toolbar and Reset Toolbar dialog boxes, and in the Customize Keyboard dialog box. In ArcMap, you use this setting to choose the template in which your changes will be saved. In ArcCatalog, however, you must save your changes in the default template.
Adding a new, empty menu to a toolbar

1. Show the toolbar to which you want to add a new, empty menu.
2. Click the Tools menu and click Customize.
3. Click the Commands tab.
4. Click New Menu in the Categories list.
5. Click and drag the New Menu command from the Commands list and drop it on the toolbar.
   An empty menu called New Menu appears in the toolbar.
6. Right-click New Menu in the toolbar.
7. Type an appropriate caption for the menu in the text box.
8. Press Enter.
9. Click Close.

Tip
Creating access keys
All menus on the Main menu and their commands have an underlined character in their caption called an access key. It lets you access the menu from the keyboard by holding down Alt and pressing the underlined letter. To create an access key, place an ampersand (&) in front of a letter in the menu’s (or the command’s) caption.

The menu’s caption changes.
Adding a command to a context menu

1. Click the Tools menu and click Customize.
2. Click the Toolbars tab.
3. Check the Context Menus toolbar.
4. Click Context Menus on the toolbar.
   A list of all the context menus in the Catalog appears. You may need to scroll up or down in the list to find the menu you want to modify.
5. Click the arrow for the context menu to which you want to add a command.
   The context menu appears.
6. Click the Commands tab in the Customize dialog box.
7. Click the category that contains the command you want to add to the menu.
8. Click and drag the command from the Commands list to the context menu. A thick black line indicates where the command will be positioned. Drop the command in the appropriate location.
   The command appears in the context menu.
9. Click Close in the Customize dialog box.

The command appears in the context menu.
### Tip

#### Why open the Customize dialog box?

Even though you don’t make use of it in an operation, such as moving commands, you must display the Customize dialog box when you are customizing the Catalog. With the dialog box open, the Catalog is in a state where you can change its user interface.

### Tip

#### Removing commands

When you remove a command from a toolbar, you’re not deleting it; it’s merely no longer available on the toolbar. The command still appears in the Commands list in the Customize dialog box. Later, you can always add the command back to the toolbar or reset the toolbar’s contents.

---

### Moving a command

1. Show the toolbar with the command you want to move.
2. If you're moving the command to another toolbar, show the destination toolbar.
3. Click the Tools menu and click Customize.
4. Click and drag the command from its original position and drop the command in its new location.
5. Click Close in the Customize dialog box.

---

### Removing a command

1. Show the toolbar containing the command that you want to remove.
2. Click the Tools menu and click Customize.
3. Click and drag the tool you want to remove off the toolbar.
   - The mouse pointer changes to a line through a circle.
4. Drop the command.
   - The command is removed from the toolbar or menu.
5. Click Close in the Customize dialog box.
Resetting a built-in toolbar

1. Click the Tools menu and click Customize.
2. Click the Toolbars tab.
3. Click the built-in toolbar that you want to reset.
4. Click Reset.
5. Click OK.
6. Click Close.

A built-in toolbar was modified.

The toolbar's original contents are restored.
Changing a command’s appearance

ArcCatalog lets you modify the appearance of buttons, tools, and menus without programming. You can add a grouping bar to visually separate commands used for different tasks such as browsing and querying. You can also modify the command’s display type—either Image Only, Image and Text, or Text Only. By default, a button or tool dropped onto a toolbar has the display type Image Only; when dropped onto a menu the display type is Image and Text. Menus can only have the display type Text Only.

Changing a command’s caption changes the text that appears with the appropriate display types. Menus and their contents can be accessed from the keyboard by holding down the Alt key and pressing the underlined letter. To create an access key, type an ampersand (&) in front of a letter in the command’s caption.

Other properties, such as a button’s ToolTip and Message, can only be modified with programming. When you hold the mouse pointer over a button...

Grouping commands

1. Show the toolbar containing the commands that you want to group together.
2. Click the Tools menu and click Customize.
3. In the toolbar, right-click the command located to the right of where the grouping bar should be placed.
4. Check Begin a Group to show a grouping bar to the left of a command.
5. Uncheck Begin a Group to remove a grouping bar.
6. Click Close in the Customize dialog box.

Changing the display type

1. Show the toolbar containing the command whose display type you want to change.
2. Click the Tools menu and click Customize.
3. In the toolbar, right-click the command you want to change.

A grouping bar appears in the toolbar to the left of the command.
command, its *ToolTip*—a short message in a floating yellow box—displays. A command’s Message displays in the status bar. The Message describes the action performed by the command.

4. Check Text Only to display only the command’s caption. Check Image Only to display only the command’s image. Check Image and Text to display both its image and its caption.

5. Click Close in the Customize dialog box.

---

**Changing the image**

1. Show the toolbar containing the command whose image you want to change.

2. Click the Tools menu and click Customize.

3. In the toolbar, right-click the command you want to change.


5. Click one of the images displayed. Or click Browse, navigate to a custom image, then click Open.

The new image is applied. It appears in the toolbar if the display type is Image Only or Image and Text.

6. Click Close in the Customize dialog box.
Changing the caption
1. Show the toolbar containing the command whose caption you want to change.
2. Click the Tools menu and click Customize.
3. In the toolbar, right-click the command you want to change.
4. Type a new caption in the edit box on the context menu.
5. Press Enter.
The new caption is applied. It appears in the toolbar if the display type is Text Only or Image and Text.
6. Click Close in the Customize dialog box.

Resetting a built-in command
1. Show the toolbar with the command you want to reset.
2. Click the Tools menu and click Customize.
3. In the toolbar, right-click the command.
4. Click Reset.
The command's image, caption, and display type return to their default settings.
5. Click Close in the Customize dialog box.
Creating shortcut keys

When you access a menu from the keyboard using an access key, the menu opens and you can see its contents. In contrast, when you use a command’s *shortcut key*, you can execute the command directly without having to open and navigate the menu first. For example, Ctrl + C is a well-known shortcut for copying something in Windows. One command can have many shortcuts assigned to it, but each shortcut can only be assigned to one command. A command’s first shortcut is displayed to its right when the command appears in a menu.

Assigning a shortcut key

1. Click the Tools menu and click Customize.
2. Click Keyboard.
3. Click the category containing the command you want to modify.
4. Click the command to which you want to add a shortcut key.
5. Click in the Press new shortcut key text box, then press the keys on the keyboard that you want to use for a shortcut. If those keys have been assigned to another command, that command’s name will appear below.
6. Click Assign if the keys aren’t currently assigned to another command.
   
   The new shortcut appears in the Current Key/s list.
7. Click Close in the Customize Keyboard dialog box.
8. Click Close in the Customize dialog box.

Creating shortcut keys

When you access a menu from the keyboard using an access key, the menu opens and you can see its contents. In contrast, when you use a command’s *shortcut key*, you can execute the command directly without having to open and navigate the menu first. For example, Ctrl + C is a well-known shortcut for copying something in Windows. One command can have many shortcuts assigned to it, but each shortcut can only be assigned to one command. A command’s first shortcut is displayed to its right when the command appears in a menu.

Assigning a shortcut key

1. Click the Tools menu and click Customize.
2. Click Keyboard.
3. Click the category containing the command you want to modify.
4. Click the command to which you want to add a shortcut key.
5. Click in the Press new shortcut key text box, then press the keys on the keyboard that you want to use for a shortcut. If those keys have been assigned to another command, that command’s name will appear below.
6. Click Assign if the keys aren’t currently assigned to another command.

   The new shortcut appears in the Current Key/s list.
7. Click Close in the Customize Keyboard dialog box.
8. Click Close in the Customize dialog box.

The new shortcut key appears in the Current Key/s list and is assigned to the command.
Removing a shortcut key

1. Click the Tools menu and click Customize.
2. Click Keyboard.
3. Click the category that contains the command you want to modify.
4. Click the command from which you want to remove a keyboard shortcut.
5. Click the shortcut in the Current Key/s list that you want to delete.
6. Click Remove.
7. Click Close in the Customize Keyboard dialog box.
8. Click Close in the Customize dialog box.

Resetting built-in shortcut keys

1. Click the Tools menu and click Customize.
2. Click Keyboard.
3. Click Reset All.
   Click Yes when asked if you want to reset your shortcuts.
4. Click Close in the Customize Keyboard dialog box.
5. Click Close in the Customize dialog box.
Creating and running macros

ArcCatalog comes with Visual Basic for Applications. VBA is not a standalone program. It provides an integrated programming environment, the Visual Basic Editor (VBE), that lets you write a VB macro and debug and test it right away in the Catalog. A macro is a few lines of code that run in the Catalog; for example, the macro might analyze the currently selected coverage. A macro can integrate some or all of VB’s functionality, such as using message boxes for input, with the functionality available in ArcCatalog.

When you create a macro, you’re creating a VB Sub procedure. The procedure’s name is the name you assign to the macro. You add code to the procedure in a Code window just as you would in VB. When you create a new macro in the Macros dialog box, precede the macro’s name with the name of the module to store it in. To save your macro as part of the Catalog, you would type a name such as “ThisDocument.myMacro”. You can also organize your macros into different modules; each module has its own Code.

Creating a macro

1. Click the Tools menu, point to Macros, then click Macros.
2. Type the name of the macro you want to create in the Macro name text box.
   To place the macro in a specific location, type “ThisDocument” or the module’s name and a period (.) before the new macro’s name; otherwise, the macro will be added to the NewMacros module.
3. Click Create or press Enter.
   The Code window appears containing a stub for the new Sub procedure.
4. Type the code for the macro.
5. Click the VBE File menu and click Save Project.
6. Click the Close button in the VBE.
window. To add your macro to a specific module, type the module name before the macro’s name, for example, “ProjectMacros.getSelected”. If the module doesn’t already exist, a new module with that name is created for you and added to the VBE project. Similarly, if you provide a name for a new macro but don’t specify which module to store it in, a new module is created called NewMacros.

Using modules makes it easier to share your VB code with others; you can export a module to a .bas file from, and import a .bas file to, your VBE project. For more information about creating macros, see Exploring ArcObjects or the ArcObjects Developer Help system.

### Editing a macro

1. Click the Tools menu, point to Macros, then click Macros.
2. In the list below the Macro name text box, click the name of the macro you want to edit.
3. Click Edit.
   - The code that’s been written for the macro appears in the Code window.
4. Edit the code.
5. Click the VBE File menu and click Save Project.
6. Click the Close button in the VBE.

### Adding a macro to a toolbar or menu

1. Show the toolbar to which you want to add a macro.
2. Click the Tools menu and click Customize.
3. Click the Commands tab.
4. Click Macros in the Categories list.
5. Click and drag the macro from the Commands list and drop it on the toolbar.
   - The macro appears in the toolbar or menu.
6. Click Close.
Running a macro in the Macros dialog box

1. Click the Tools menu, point to Macros, and click Macros.
2. Click the Macro that you want to run.
3. Click Run.

Running a macro in the Visual Basic Editor

1. Click the Tools menu, point to Macros, and click Visual Basic Editor.
2. In the VBE Project window, double-click ThisDocument or the module containing the macro that you want to run. The Code window for that module appears.
3. Position the cursor inside the appropriate Sub procedure.
4. Click the VBE Run menu and click Run Sub/UserForm.
Creating custom commands with VBA

ArcCatalog uses Automation, which is a feature of the Component Object Model (COM) technology; it lets you access the Catalog’s objects in VB and other languages, tools, and applications that support Automation. For example, you can analyze a data source with VB using ArcCatalog objects but without using ArcCatalog itself.

Toolbars and commands are COM objects, too. You can create custom objects in VBA. To be a command, the object must meet a basic set of requirements for all commands. To be a button, it must also satisfy the button requirements. *Exploring ArcObjects*, the ArcObjects Developer Help topics, and the VBE online Help describe the interfaces, methods, events, and properties that are available in VBA. The ArcCatalog customization environment makes it easy to create custom commands with VBA. You can create a new button, tool, combo box, or edit box—collectively called UIControls—in the Customize dialog box, then attach behavior that incorporates the Catalog’s objects.

1. Show the toolbar to which you want to add a new command.
2. Click the Tools menu and click Customize.
3. Click the Commands tab.
4. Click UIControls in the Categories list.
5. Click New UIControl.
6. Click the type of UIControl you want to create.
7. Click Create to create the control without attaching code to it. The name of the control appears in the Commands list. You can add code for the control at another time.

If you want to start adding code to the control right away, click Create and Edit, then skip to step 11.

The new control is added to the Commands list.
8. Click and drag the newly created UIControl and drop it on a toolbar or menu.

9. In the toolbar, right-click the control and set its image, caption, and other properties.

10. Right-click the new control and click View Source. The Visual Basic Editor appears, displaying the control's code in the Code window.

11. Click the right dropdown arrow and click one of the control's event procedures.

12. Type code for the event procedure.

13. Repeat steps 11 and 12 until all the appropriate event procedures have been coded.

14. Click the VBE File menu and click Save Project.

15. Click the Close button in the Visual Basic Editor.

16. If you clicked Create and Edit in step 7, open the Customize dialog box, click the Commands tab, and drag the newly created UIControl from the commands list to a toolbar or menu.

17. Click Close in the Customize dialog box.
Working with UIControls

If you create a macro and add it to a toolbar, you’ve essentially customized what happens when you click the button. UIControls, however, let you create custom commands with VBA that work similarly to the buttons, tools, combo boxes, and edit boxes that come with ArcCatalog.

Typically in ArcCatalog, you use buttons to start, end, or interrupt an action or a series of actions. When you create a button, you write code that sets its properties including its ToolTip, the message that appears in the status bar describing what the button does, and whether it’s enabled. You also define the code that responds to the button’s click event; this is the code that runs when you click the button on a toolbar.

Though similar to buttons, tools let you interact with the display—for example, you can zoom in or pan around your map in Geography view. In addition to setting the tool’s properties, your code can respond to mouse and key events—clicking a mouse button or pressing a key—and to someone selecting, double-clicking, or right-clicking the tool. A tool can respond when the display refreshes or when it is deactivated.

A combo box combines the features of a text box and a list box. You can use combo boxes to provide a set of items to choose from, or you can let someone type a value that isn’t in the list. You can add or remove entries from the list using the combo box. Its properties let you work with the selected item or the text in the edit box as well as determine how many entries are in the list. The combo box can respond to several events such as changing the current selection or changing the text in the edit box. As with buttons and tools, you can also set the control’s ToolTip and provide a status bar message.

Edit boxes let you display information entered by the user or data derived from an external source. The Clear method removes the contents of the edit box, while the Text property provides access to the text that’s displayed. You can specify whether or not the control is enabled and have the tool respond when someone changes the text or presses a key. You can set the control’s ToolTip and its status bar message.

Writing code for a command’s event procedures lets the command respond to user interaction or the current state of the Catalog. And, by using combo and edit boxes in ArcCatalog, you might be able to avoid using a dialog box or UserForm to get information. UIControls let you create sophisticated custom commands that make ArcCatalog an efficient and powerful way to create and finish your projects.
Adding custom commands

You don’t have to use VBA to create custom commands. In fact, in some cases, your custom commands may require you to use another development environment. You can create custom objects in any programming language that supports COM; see Exploring ArcObjects for details. Custom commands or toolbars created outside VBA are often distributed as ActiveX libraries (.dll files). Before you can add a custom command to the Catalog, you must ensure that either you or the installation process by which you acquired it registers its ActiveX DLL. After registering the file on your computer, you must register the custom objects it contains with ArcCatalog. You can add the custom command to any toolbar or menu.

1. Click the Tools menu and click Customize.
2. Click Add from file.
3. Navigate to the file containing the custom command.
4. Click the file and click Open.
   The Added Objects dialog box appears, reporting which new objects have been registered with ArcCatalog.
5. Click OK.
   The custom commands appear in the Commands list for the appropriate category; a new category may be added to the Categories list.
6. Click Close in the Customize dialog box.

The custom commands appear in the Commands list for the appropriate category; a new category may be added to the list.
Updating the ArcID module

If you write macros that use COM objects, the ArcID module will be useful. You can refer to COM objects by name when using a method such as CommandBars.Find. If you do this, a list of the commands documented in the ArcID module will appear with Visual Basic’s code completion feature. After adding objects to the Catalog from a file, update the ArcID module so that the newly added commands appear in the list along with the commands that are built into the Catalog. After updating the module, commands that have been removed will no longer appear in the list.

1. Click the Tools menu and click Customize.
2. Click the Options tab.
3. Click Update ArcID module.
4. Click Close.

Using VB’s code completion feature, you can list the commands that have been added to the ArcID module.
Changing VBA security

A macro virus is a type of computer virus that’s stored in a macro or an add-in. When you open the file or perform an action that triggers a macro virus, the macro virus might be activated, transmitted to your computer, and stored as part of the Catalog. From that point on, every document you open or every file you save could be automatically infected with the macro virus; if others open these infected documents, the macro virus is transmitted to their computers. ESRI applications offer the levels of security described in the Security dialog box to reduce the chances of macro viruses infecting your documents, files, and add-ins.

Tip

Locking customizations

Since ArcCatalog is designed to be a personal data browser and manager, it doesn’t use templates the way ArcMap does. To learn how to lock your customizations in the Catalog’s Normal template or in ArcMap, see Using ArcMap.

1. Click the Tools menu and click Customize.
2. Click the Options tab.
3. Click Change VBA Security.
4. Click the level of security you want.
5. Click the Trusted Sources tab to see a list of the names of organizations or individuals whose signed macros will be allowed to run.
6. Click OK.
7. Click Close.
Using the ArcObjects Developer Help system

When you start creating macros and UIControls and programming how they work, you’ll find a lot of useful information in the ArcObjects Developer Help system. In addition to a general overview about how to get started, it provides object model diagrams, sample code, and detailed technical documents that will help you. For more indepth information about how to customize ArcCatalog, read *Exploring ArcObjects*.

The ArcObjects Class Help section of the Developer Help system also contains details about how to use each interface, property, and method that is available with ArcObjects. You can access this information where you need it most—while you are writing code. For example, you can select the method you are interested in and press F1.

1. Click the Start button on the Windows taskbar.
2. Point to Programs.
3. Point to ArcGIS.
4. Point to Developer Help then click Online Help.

The ArcGIS Online Developer help system appears.
**access key**
A keyboard shortcut that allows a user to access the contents of the Main menu by holding down the Alt key and pressing the underlined letter on the menu or menu command item. An access key is created by placing an ampersand (&) in front of the appropriate letter in the command’s caption.

**active data frame**
The data frame currently being worked on—for example, the data frame to which layers are being added. The active data frame is highlighted on the map, and its name is shown in bold text in the table of contents.

**AML**
See ARC Macro Language.

**annotation**
Descriptive text used to label features on or around a map. Information stored for annotation includes a text string, a position at which it can be displayed, and display characteristics.

**ARC Macro Language**
A proprietary high-level algorithmic language for generating end-user applications in ArcInfo Workstation. Features include the ability to create on-screen menus, use and assign variables, control statement execution, and get and use map or page unit coordinates. AML includes an extensive set of commands that can be used interactively or in AML programs (macros), as well as commands that report on the status of ArcInfo environment settings.

**ArcGIS Server**
It is a product developed to support building GIS server applications using ArcObjects. It provides a server object hosting and management framework that allows ArcEngine-based server objects to be accessed and used from standard Web service environments. This framework allows ArcEngine-based server objects to be hosted and distributed across multiple server machines. In addition, it includes a standard GIS Web service framework and Web application development tools.

**ArcInfo Librarian**
A set of software tools to manage and access large geographic datasets in a map library. ArcInfo Librarian commands create and define a map library, move data in and out of a library, query the data in a map library, and display the results of a query.
**ArcStorm database**

An ArcStorm database is a collection of libraries, layers, INFO tables, and external database management system (DBMS) tables. Data stored in an ArcStorm database benefits from the transaction management and data archiving capabilities of ArcStorm.

**attribute**

1. Information about a geographic feature in a GIS, generally stored in a table and linked to the feature by a unique identifier. For example, attributes of a river might include its name, length, and average depth.

2. In raster datasets, information associated with each unique value of raster cells.

3. Cartographic information that specifies how features are displayed and labeled on a map; the cartographic attributes of a river might include line thickness, line length, color, and font.

**attribute key**

See primary key.

**attribute table**

A database or tabular file containing information about a set of geographic features, usually arranged so that each row represents a feature and each column represents one feature attribute. In raster datasets, each row of an attribute table corresponds to a certain region of cells having the same value. In a GIS, attribute tables are often joined or related to spatial data layers, and then the attribute values they contain can be used to find, query, and symbolize features or raster cells. See also attribute table.

**Automation**

1. The technique of making an apparatus, a process, or a system operate automatically; that is, by mechanical or electronic devices that take the place of human organs of observation, effort, and decision.

2. In COM technology, a feature that lets users access ArcObjects in Visual Basic and in other languages, tools, and applications that support automation. For example, with Visual Basic, users can access the data in and properties of the selected item in the Catalog tree.

**band**

A set of adjacent wavelengths or frequencies with a common characteristic, such as the visible band of the electromagnetic spectrum.

**batch mode operation**

Executes a given ArcToolbox tool two or more times on the items listed in the batch table. You can save the contents of the batch table as a geoprocessing AML and reload the AML later for execution.

**batch processing**

Executing a series of noninteractive jobs at the same time. In geoprocessing, these system tools allow for batch processing: the Feature class to Geodatabase tool, the Feature class to Shapefile tool, the Table to Geodatabase tool, and the Table to dBASE tool. Batch processing is available through tools in ArcGIS 8.3 and previous versions.

**batch table**

Displays the input name, user-selected parameters, and the output name, where applicable, for all items to be processed by the ArcToolbox tool.

**button**

An icon that runs a command, macro or custom code when clicked. Buttons can be added to any menu or toolbar. When they appear in a menu, buttons are referred to as menu commands.
CAD
A computer-based system for the design, drafting, and display of graphical information. Also known as computer-aided drafting, such systems are most commonly used to support engineering, planning, and illustrating activities.

CAD dataset
See CAD feature dataset.

CAD drawing
The digital equivalent of a drawing, figure, or schematic created using a CAD system.

CAD feature dataset
The feature representation of a CAD file in a geodatabase-enforced schema. A CAD feature dataset is comprised of five read-only feature classes: points, polylines, polygons, multipatch, and annotation. ArcGIS supported formats include DWG (AutoCAD®), DXF (AutoDesk® Drawing Exchange Format), and DGN (the default Microstation file format).

caption
In ArcGIS, the text for a command that appears with the Text Only and Image and Text display types. As part of the user interface, captions are customizable by the user.

cardinality
1. The number of elements in a mathematical set.
2. A relationship between objects in a database, which describes the number of objects of one type that are associated with objects of another type. A relationship can have a cardinality of one-to-one, one-to-many, many-to-one, or many-to-many.

Catalog tree
In ArcCatalog, a hierarchical view of folder connections that provide access to GIS data stored on local disks or shared on a network, and allows users to manage connections to databases and GIS servers.

cell
1. The smallest unit of information in an image, raster, or grid. In a map, each cell represents a portion of the earth, such as a square meter or square mile, and usually has an attribute value associated with it, such as soil type or vegetation class. Cells are usually square or rectangular in shape, although hexagonal and circular areas have also been used.
2. A pixel.

color ramp
A range of colors used to show ranking or order among classes on a map.

column
The vertical dimension of a table. Each column stores the values of one type of attribute for all of the records, or rows, in the table. All the values in a given column are of the same data type (e.g., number, string, BLOB, or date).

COM
See Component Object Model (COM).

combo box
A user interface tool that combines the features of a text box and a dropdown list. For example, the Location combo box in ArcCatalog allows the selection of an item in the Catalog tree by typing its path or choosing its path from a dropdown list.
command
1. An instruction to a computer program, usually one word or concatenated words or letters, issued by the user from a control device, such as a keyboard, or read from a file by a command interpreter.
2. A menu, menu item, button, combo box, or text box on a toolbar.

Component Object Model (COM)
A binary standard that enables software components to interoperate in a networked environment regardless of the language in which they were developed. Developed by Microsoft, COM technology provides the underlying services of interface negotiation, life cycle management (determining when an object can be removed from a system), licensing, and event services (putting one object into service as the result of an event that has happened to another object).

composite relationship
A link or association between objects where the lifetime of one object controls the lifetime of its related objects. The association between highways and shield markers is a composite relationship, since shield markers can’t exist without a highway.

computer-aided design
See CAD.

Content Standard for Digital Geospatial Metadata
A publication authored by the Federal Geographic Data Committee (FGDC), that specifies the information content of metadata for a set of digital geospatial data. The purpose of the standard is to provide a common set of terminology and definitions for concepts related to the metadata. All U.S. government agencies (federal, state, and local) that receive federal funds to create metadata must follow this standard.

coordinate system
A fixed reference framework superimposed onto the surface of an area to designate the position of a point within it; a reference system consisting of a set of points, lines and/or surfaces, and a set of rules, used to define the positions of points in space in either two or three dimensions. The Cartesian coordinate system and the system of latitude and longitude used on the earth’s surface are common examples of coordinate systems.

coordinates
Values represented by x, y, and possibly z, that define a position in terms of a spatial reference framework. Coordinates are used to represent locations on the earth’s surface relative to other locations.

coverage
A data model for storing geographic features using ArcInfo software. A coverage stores a set of thematically associated data considered to be a unit. It usually represents a single layer, such as soils, streams, roads, or land use. In a coverage, features are stored as both primary features—points, arcs, polygons—and secondary features—tics, links, annotation. Feature attributes are described and stored independently in feature attribute tables.

coverage units
The units of the coordinate system in which a coverage is stored—for example, feet, meters, inches.

CSDGM
See Content Standard for Digital Geospatial Metadata.

dangle length
See dangle tolerance.
**dangle tolerance**
In ArcInfo coverages, the minimum length allowed for dangling arcs by the Clean process. Clean removes dangling arcs shorter than the dangle tolerance.

**dangling arc**
An arc having the same polygon on both its left and right sides and having at least one node that does not connect to any other arc. It often occurs where a polygon does not close properly, where arcs do not connect properly—an undershoot—or where an arc was digitized past its intersection with another arc—an overshoot. A dangling arc is not always an error—for example, it can represent a cul-de-sac in a street network.

**data**
Any collection of related facts arranged in a particular format; often, the basic elements of information that are produced, stored, or processed by a computer.

**data frame**
A container for layers in ArcMap. A dataset can be represented in one or more data frames. Many maps only need one data frame. Multiple data frames are often used to compare layers side by side or highlight a particular location or attribute.

**data source**
Any geographic data. Data sources may include coverages, shapefiles, rasters, or feature classes.

**data type**
The attribute of a variable, field, or column in a table that determines the kind of data it can store. Common data types are character, integer, decimal, single, double, and string.

**data view**
An all-purpose view in ArcMap and ArcReader for exploring, displaying, and querying geographic data. This view hides all map elements, such as titles, North arrows, and scalebars.

**database**
One or more structured sets of persistent data, managed and stored as a unit and generally associated with software to update and query the data. A simple database might be a single file with many records, each of which references the same set of fields. A GIS database includes data about the spatial locations and shapes of geographic features recorded as points, lines, areas, pixels, grid cells, or TINs, as well as their attributes.

**database connection**
A link to a database. Database connections have two states: connected to or disconnected from the database. Deletion of a database connection only deletes the connection itself, not the database or its contents. Creation of a database connection requires selection of a data provider for data retrieval. ArcCatalog provides two different types of database connections: ArcSDE, which allows users to work with a multiuser geodatabase, and OLE DB, which allows users to access nonspatial databases.

**database management system (DBMS)**
A set of computer programs that organizes the information in a database according to a conceptual schema and provides tools for data input, verification, storage, modification and retrieval.

**dataset**
1. A feature dataset in a geodatabase.
2. Any geographic data, such as a coverage, shapefile, raster, or a feature class, in a geodatabase. Also known as a data source.
**datum**

In the most general sense, any set of numeric or geometric constants from which other quantities, such as coordinate systems, can be defined. A datum defines a reference surface. There are many types of datums, but most fall into two categories: horizontal and vertical.

**DBMS**

See database management system (DBMS).

**decimal degrees**

Values of latitude and longitude expressed in decimal format rather than in degrees, minutes, and seconds.

**DEM**

See digital elevation model (DEM).

**destination**

1. A place to which something journeys or is sent.
2. In ArcGIS Spatial Analyst, the ending point for a path when using the Shortest Path function.
3. The secondary object in a relationship. For example, a table containing attributes that are associated with features in a feature class.

**digitize**

1. To encode geographic features in digital form as x,y coordinates.
2. The process of using a digitizer to encode the locations of geographic features by converting their map positions to a series of x,y coordinates stored in computer files. Pushing a digitizer button records an x,y coordinate. A digitized line is created by recording a series of x,y coordinates.

**digital elevation model (DEM)**

1. The representation of continuous elevation values over a topographic surface by a regular array of z-values, referenced to a common datum. Typically used to represent terrain relief.
2. The database for elevation data by map sheet from the National Mapping Division of the U.S. Geological Survey.

**digital terrain model (DTM)**

See digital elevation model (DEM).

**digitizer**

1. A place to which something journeys or is sent.
2. In ArcGIS Spatial Analyst, the ending point for a path when using the Shortest Path function.
3. The secondary object in a relationship. For example, a table containing attributes that are associated with features in a feature class.

**digitizing**

The process of converting the geographic features on an analog map into digital format using a digitizing tablet, or digitizer, which is connected to a computer. Features on a paper map are traced with a digitizer puck, a device similar to a mouse, and the x,y coordinates of these features are automatically recorded and stored as spatial data.

**directory**

An area of a computer disk that holds a set of datafiles and/or other directories. Operating systems use directories to organize data. Directories are arranged in a tree structure, in which each branch is a subdirectory of its parent branch. The location of a directory is specified with a pathname—for example, C:\lemur_habitat.
disk
A storage medium consisting of a round, flat, spinning plate coated with a magnetic material for recording digital information.

display type
The mode of command representation on a computer screen. The display type controls whether you see a command’s image, its caption, or both, when it appears on a toolbar or in a menu.

documentation
In ArcCatalog, text in an item’s metadata describing where the data came from, attribute definitions, and so on. Unlike properties, which are automatically derived from the data source, documentation must be manually entered using the ArcCatalog metadata editor.

double precision
The level of coordinate exactness based on the possible number of significant digits that can be stored for each coordinate. Datasets can be stored in either single or double precision. Double-precision geometries store up to 15 significant digits per coordinate (typically, 13 to 14 significant digits), retaining the accuracy of much less than one meter at a global extent.

double-coordinate precision
See double precision.

edit box
See text box.

enclosure
A file describing the contents of an item that is included or contained within the metadata. Enclosing files in metadata works the same way as enclosing files in an e-mail message.

event
1. An outcome or occurrence that happens when a user interacts with an application. For example, in a case where clicking a button triggers the closing of a form, the event is the closing of the form.
2. A geographic location stored in tabular rather than spatial form. Event types include address events, route events, xy events, and temporal events. Address events are features that can be located based on address matching with a street network or other address identifier, such as ZIP Codes or lot numbers. Route events are linear, continuous, or point features occurring along a base route system. Xy events are simple coordinate pairs that describe the location of a feature, such as a set of latitude and longitude degrees. Temporal events are used to describe observations through time of particular objects or groups of objects.

event location
See event.

extent
The coordinate pairs defining the minimum bounding rectangle (xmin, ymin and xmax, ymax) of a data source. All coordinates for the data source fall within this boundary.

feature
1. A group of spatial elements which together represent a real-world entity. A complex feature is made up of more than one group of spatial elements—for example, a set of line elements with the common theme of roads representing a road network.
2. A representation of a real-world object on a map. Features can be represented in a GIS as vector data—points, lines, or polygons—or as cells in a raster data format. To be displayed in a GIS, features must have geometry and locational information.

feature attribute table
See attribute table.
**feature class**
A collection of geographic features with the same geometry type (e.g., point, line, or polygon), the same attributes, and the same spatial reference. Feature classes can stand alone within a geodatabase or they can be contained within shapefiles, coverages, or other feature datasets. Feature classes allow homogeneous features to be grouped into a single unit for data storage purposes—for example, highways, primary roads, and secondary roads can be grouped into a line feature class named roads. In a geodatabase, feature classes can also store annotation and dimensions.

**feature dataset**
A collection of feature classes stored together that share the same spatial reference; that is, they must have the same coordinate system and their features must fall within a common geographic area. Feature classes with different geometry types may be stored in a feature dataset.

**Federal Geographic Data Committee (FGDC)**
An organization established by the United States Federal Office of Management and Budget responsible for coordinating the development, use, sharing, and dissemination of surveying, mapping, and related spatial data. The committee is comprised of representatives from federal and state government agencies, academia, and the private sector. The FGDC defines spatial data metadata standards for the United States in its Content Standard for Digital Geospatial Metadata and manages the development of the National Spatial Data Infrastructure (NSDI).

**FGDC**
See Federal Geographic Data Committee (FGDC).

**field**
1. A column in a table that stores the values for a single attribute.
2. The place in a database record, or in a graphical user interface, where data can be entered.

See also attribute, column.

**file**
A named set of computer records stored or processed as a unit on a drive, disk, or tape. A file generally resides within a directory and always has a unique extension name corresponding to its file type, such as .txt for a document or text file, or .exe for a program or executable file.

**file type**
Files that are not geographic data sources can appear in ArcCatalog if they have been added to the file types list. A file type consists of a description of the file’s format, such as Text Document, the file extension associated with this type of file, such as .txt, and the icon used to represent these files.

**folder**
A location on a disk containing a set of files and/or other folders. See also directory.

**folder connection**
In ArcCatalog, a top-level item in the Catalog tree that provides quick access to geographic data stored on local disks, including CD–ROMs, or shared on a network. Folder connections may provide access to individual folders.

**foreign key**
A column or combination of columns in one table whose values match the primary key in another table. A value in the foreign key can only exist if there is a corresponding value in the primary key, unless the value is NULL. Foreign key–primary key relationships define a relational join. See also primary key, relate, and relationship class.
format
A systematic and repeatable pattern or arrangement of computer data. A file format is the specific design of how information is organized in the file. For example, ArcInfo has specific, proprietary formats used to store coverages. DLG, DEM, and TIGER® are geographic datasets with different file formats.

freeze
To fix a column in place in a table for better viewing of the table’s contents. A frozen column will stay in place while the other columns scroll normally.

fuzzy tolerance
In ArcInfo, the distance within which coordinates of nearby features are adjusted to coincide with each other when topology is being constructed. Nodes and vertices within the fuzzy tolerance are merged into a single coordinate location, connecting previously separate features. Fuzzy tolerance is a very small distance, usually from 1/10,000 to 1/1,000,000 times the width of the coverage extent, and is generally used to correct inexact intersections. The fuzzy tolerance defines the resolution of a coverage resulting from the Clean operation or a topological overlay operation, such as Union, Intersect, or Clip. In geodatabase feature classes, this concept is replaced by cluster tolerance.

GDB
See geodatabase.

geodatabase
An object-oriented data model introduced by ESRI that represents geographic features and attributes as objects and the relationships between objects, but is hosted inside a relational database management system. A geodatabase can store objects such as feature classes, feature datasets, nonspatial tables, and relationship classes.

geographic coordinates
A measurement of a location on the earth’s surface expressed in degrees of latitude and longitude.

geographic data
Information about geographic features, including their shapes, locations and descriptions. Geographic data is the composite of spatial data and attribute data.

geographic information system (GIS)
An arrangement of computer hardware, software, and geographic data that people interact with to integrate, analyze, and visualize the data; identify relationships, patterns, and trends; and find solutions to problems. The system is designed to capture, store, update, manipulate, analyze, and display the geographic information. A GIS is typically used to represent maps as data layers that can be studied and used to perform analyses.

geometric network
A one-dimensional, nonplanar graph, composed of topologically connected edge and junction features, that represents a linear network, such as a road, utility, or hydrologic system.

geoprocessing
A GIS operation used to manipulate data stored in a GIS workspace. A typical geoprocessing operation takes an input dataset, performs an operation on that dataset, and returns the result of the operation as an output dataset. Common geoprocessing operations are geographic feature overlay, feature selection and analysis, topology processing, and data conversion. Geoprocessing allows for definition, management, and analysis of information used to form decisions.
Geospatial Data Clearinghouse
A decentralized system of servers on the Internet that contain metadata about available geographic data. Sponsored by the Federal Geographic Data Committee (FGDC), the clearinghouse functions as a detailed catalog service with support for links to spatial data and browse graphics. See also National Spatial Data Infrastructure (NSDI).

GIS
See geographic information system (GIS).

grid
A data format for storing raster data that defines geographic space as an array of equally sized square cells arranged in rows and columns. Each cell stores a numeric value that represents a geographic attribute, such as elevation, for that unit of space. When the grid is drawn as a map, cells are assigned colors according to their numeric values. Each grid cell is referenced by its x,y coordinate location. See raster.

grid cell
See cell.

group layer
In the ArcMap table of contents, a group of several layers that appear and act as a single layer.

HTML
See HyperText Markup Language (HTML).

HyperText Markup Language (HTML)
HyperText Markup Language. A coding language that is a subset of SGML (Standard Generalized Markup Language) and is used to create Web pages for publication on the Internet. HTML is a system of tags that define the function of text, graphics, sound and video within a document, and is now an Internet standard maintained by the World Wide Web Consortium (W3C).

identify
In ArcGIS, a tool that, when applied to a feature, opens a window showing that feature’s attributes.

image
A raster-based representation or description of a scene, typically produced by an optical or electronic device such as a camera or a scanning radiometer. Common examples include remotely sensed data—for example, satellite data—scanned data, and photographs. An image is stored as a raster dataset of binary or integer values that represent the intensity of reflected light, heat, sound, or any other range of values on the electromagnetic spectrum. An image may contain one or more bands.

index
A data structure used to speed the search for records in a database or for spatial features in geographic datasets. In general, unique identifiers stored in a key field point to records or files holding more detailed information.

INFO database
A tabular database management system used by Workstation ArcInfo software to store and manipulate attributes of a GIS dataset in Workstation ArcInfo format. INFO databases are stored inside a workspace folder with subdirectories containing files that represent the geometry and topology that make up a coverage.

instance
See service.
**IP address**
Internet protocol address. The identification of each client or server computer on the Internet by a unique number. IP addresses allow data to travel between one computer and another via the Internet, and are commonly expressed as a dotted quad, with four sets of numerals separated by periods.

**ISO**
International Organization for Standardization. A federation of national standards institutes from 145 countries that works with international organizations, governments, industries, businesses and consumer representatives to define and maintain criteria for international standards.

**item**
1. An element in the Catalog tree. Items include data sources, such as shapefiles and geodatabases, and nonspatial elements, such as folders.
2. A field or attribute.

**join**
The process of connecting two or more separate spatial entities. If two line segments are joined, they become one spatial object for further processing. See also relational join.

**key**
See primary key.

**key attributes**
See primary key.

**label**
Text placed next to a feature on a map to describe or identify it.

**latitude–longitude**
A reference system used to locate positions on the earth’s surface. Distances east–west are measured with lines of longitude—also called meridians—which run north–south and converge at the north and south poles. Distance measurements begin at Greenwich, England—the prime meridian—and are measured positively 180 degrees to the east and negatively 180 degrees to the west. Distances north–south are measured with lines of latitude—also called parallels—which run east–west. Distance measurements begin at the equator and are measured positively 90 degrees to the north and negatively 90 degrees to the south. Latitude and longitude measurements are recorded in degrees/minutes/seconds.

**layer**
1. A logical set of thematic data described, stored, and referenced together for display on a map. Geographic features within a layer share the same geographic extent, coordinate system, and attributes. In ArcGIS, a layer references geographic data stored in a data source, such as a coverage or geodatabase, and defines how to display the data. Layers are held in memory, and may be used as inputs to geoprocessing tools or saved as layer files with a .lyr extension.
2. A standalone feature class in a geodatabase managed with SDE 3.

**layout**
1. The arrangement or overall design of elements on a digital map display or printed map, possibly including a title, legend, North arrow, scalebar, and geographic data.
2. In ArcGIS, a presentation document incorporating maps, charts, tables, text, and images.
**layout view**
In ArcMap and ArcReader, the view for laying out a map. Layout view shows the virtual page upon which geographic data and map elements, such as titles, legends, and scalebars, are placed and arranged for printing. See also data view.

**library**
In ArcInfo, a collection of spatially related ArcStorm or Map Librarian layers. A library has a spatial extent that applies to all layers in the library.

**macro**
A computer program, usually a text file, containing a sequence of commands that are executed as a single command. Macros are used to perform commonly used sequences of commands or complex operations.

**map**
1. A graphic depiction on a flat surface of the physical features of the whole or a part of the earth or other body, or of the heavens, using shapes of photographic imagery to represent objects, and symbols to describe their nature; at a scale whose representative fraction is less than 1:1, generally using a specified projection and indicating the direction of orientation.
2. Any graphical representation of geographic or spatial information.
3. The document used in ArcMap to display and work with geographic data. In ArcMap, a map contains one or more layers of geographic data, contained in data frames, and various supporting map elements such as a scalebar.

**map document**
In ArcMap, the disk-based representation of a map that contains all the maps, tables, charts, layouts, and reports that are used for a particular application or set of related applications. Map documents can be printed or embedded in other documents. Map document files have an .mxd extension.

**map feature**
See feature.

**map projection**
See projection.

**map scale**
See scale.

**map template**
In ArcMap, a kind of map document that provides a quick way to create a new map. Templates can contain data, a custom interface, and a predefined layout that arranges map elements, such as North arrows, scalebars, and logos, on the virtual page. Map templates have an .mxt file extension.

**menu**
A list displayed on the computer screen that presents a selection of available commands from which a user can choose an operation to be performed.

**menu item**
An item in a list of commands displayed on a menu.

**metadata**
Information about the content, quality, condition, and other characteristics of data. Metadata for geographical data may document its subject matter; how, when, where, and by whom the data was collected; accuracy of the data; availability and distribution information; its projection, scale, resolution, and accuracy; and its reliability with regard to some standard. Metadata consists of properties and documentation. Properties are derived from the data source (e.g., the coordinate system and
projection of the data), while documentation is entered by a person (e.g., keywords used to describe the data).

**metadata element**
One piece of data within an item’s metadata.

**metadata profile**
A modification of an existing metadata standard to adapt to data and/or cultural issues. A profile modifies metadata elements in the base standard to better describe the data to the community that uses it. Metadata profiles allow communities to follow a metadata standard, while at the same time, enhancing the standard so that it is more appropriate for a particular use and/or locale.

**minimum bounding rectangle**
A rectangle, oriented to the x and y axes, that bounds a geographic feature or a geographic dataset. It is specified by two coordinate pairs: xmin, ymin and xmax, ymax. For example, an extent can define a minimum bounding rectangle for a coverage.

**multiuser geodatabase**
A geodatabase in an RDBMS served to client applications—for example, ArcMap—by ArcSDE. Multiuser geodatabases can be very large and support multiple concurrent editors. Supported on a variety of commercial RDBMSs, including Oracle®, Microsoft® SQL Server™, IBM® DB2®, and Informix®.

**National Spatial Data Infrastructure (NSDI)**
The framework of technologies, policies, standards, and human resources necessary to acquire, process, store, distribute, and improve the utilization of geospatial data in the United States. Established in 1994 and developed and coordinated by the Federal Geographic Data Committee (FGDC), the NSDI encompasses policies, standards, and procedures for organizations to cooperatively produce and share geographic data. The NSDI is being developed in cooperation with organizations from state, local, and tribal governments; the academic community; and the private sector.

**NSDI**
See National Spatial Data Infrastructure (NSDI).

**object class**
In a geodatabase, a collection of nonspatial data of the same type or theme. While spatial objects (features) are stored in feature classes in a geodatabase, nonspatial objects are stored in object classes.

**OGC**
Open GIS Consortium. OGC is an international industry consortium of 257 companies, government agencies, and universities participating in a consensus process to develop publicly available geoprocessing specifications. Open interfaces and protocols defined by OpenGIS Specifications support interoperable solutions that geo-enable the Web, wireless and location-based services, and mainstream IT, and empower technology developers to make complex spatial information and services accessible and useful with all kinds of applications.

**OLE DB provider**
Object Linking and Embedding database provider. A tool conforming to the OLE standard for sharing data between applications. Each OLE DB provider communicates with and retrieves data from a different database, but a user can work with the data retrieved by any OLE DB provider in a similar way.

**origin**
The primary object in a relationship. For example, a feature class containing points where measurements are taken; the measurements are stored in another table. See also relationship and destination.
overshoot
The portion of an arc digitized past its intersection with another arc. See also dangling arc.

pan
To move an onscreen display window up, down, or across a map image without changing the viewing scale. See also zoom.

password
A secret series of characters that enables a user to access a computer, datafile, or program. The user must enter his or her password before the computer will respond to commands. The password helps ensure that unauthorized users do not access the computer, file, or program.

path
In computing, the location of a computer file, given as the drive, directories, subdirectories, and file name, in that order.

path label
Describes the nature of the association between the objects in a relationship. The forward path label describes the relationship when navigating from the origin to the destination; for example, station points have measurements. The backward path label describes the same relationship navigating from the destination to the origin, which might be are taken at in this example; measurements are taken at stations.

PC ARC/INFO coverage
A coverage created with PC ARC/INFO.

personal geodatabase
A geodatabase that stores data in a single-user relational database management system (RDBMS). A personal geodatabase can be read simultaneously by several users, but only one user at a time can write data into it.

pixel
1. The smallest element of a display device, such as a video monitor, that can be independently assigned attributes, such as color and intensity. The term is an abbreviation for picture element.
2. The smallest unit of information in an image or raster map. Usually square or rectangular, pixel is often used synonymously with cell.

pixel type
See data type.

planar coordinate system
A two-dimensional measurement system that locates features on a map based on their distance from an origin (0,0) along two axes, a horizontal x-axis, representing east–west and a vertical y-axis, representing north–south.

port number
The TCP/IP port number on which an ArcSDE geodatabase service is communicating.

pre-7.0 coverage
Cov erages created with a version of ArcInfo prior to version 7 can’t be accessed by ArcCatalog and ArcMap until after the ConvertWorkspace command has been used to modify the coverage workspace.

precision
1. The closeness of a repeated set of observations of the same quantity to one another. It is a measure of the control over random error. Assessment of the quality of a surveyor’s work is based in part on the precision of their measured values.
2. Refers to the number of significant digits used to store coordinate values. Precision is important for accurate feature
representation, analysis, and mapping. ArcInfo supports single and double precision.

**preliminary topology**
In coverages, refers to incomplete region topology. Region topology defines region–arc and region–polygon relationships. A topological region has both the region–arc relationship and the region–polygon relationship. A preliminary region has the region–arc relationship but not the region–polygon relationship. In other words, preliminary regions have no polygon topology. Coverages with preliminary topology have red in their icons in ArcCatalog.

**primary key**
A column or set of columns in a database that stores a unique value for each record. A primary key allows no duplicate values and cannot be NULL. See also foreign key, relate, and relationship class.

**projected coordinates**
A measurement of locations on the earth’s surface expressed in a two-dimensional system that locates features based on their distance from an origin (0,0) along two axes, a horizontal x-axis, representing east–west and a vertical y-axis, representing north–south. A map projection transforms latitude and longitude to x,y coordinates in a projected coordinate system. See also geographic coordinates.

**projection**
A method by which the curved surface of the earth is portrayed on a flat surface. This generally requires a systematic mathematical transformation of the earth’s graticule of lines of longitude and latitude onto a plane. It can be visualized as a transparent globe with a light bulb at its center casting lines of latitude and longitude onto a sheet of paper. Generally, the paper is either flat and placed tangent to the globe—a planar or

azimuthal projection—or formed into a cone or cylinder and placed over the globe—cylindrical and conical projections. Every map projection distorts distance, area, shape, direction, or some combination thereof.

**projection file**
A file that stores the parameters describing a coordinate system.

**property**
An attribute of an object defining one of its characteristics or an aspect of its behavior. For example, the Visible property affects whether a control can be seen at run time. You can set an item’s properties using its Properties dialog box.

**pyramid**
In raster datasets, a reduced resolution layer that copies the original data in decreasing levels of resolution to enhance performance. The coarsest level of resolution is used to quickly draw the entire dataset. As the display zooms in, layers with finer resolutions are drawn; drawing speed is maintained because fewer pixels are needed to represent the successively smaller areas.

**query**
A request that selects features or records from a database. A query is often written as a statement or logical expression.

**query expression**
A type of expression that evaluates to a Boolean (true or false) value which is typically used to select those rows in a table where the expression evaluates to true. Query expressions are generally part of a Structured Query Language (SQL) statement:
Select fields From table Where expression
Select * From Streets Where “StreetName” = ‘Center’ And “StreetType” = ‘Rd’
**raster**
A spatial data model that defines space as an array of equally sized cells arranged in rows and columns. Each cell contains an attribute value and location coordinates. Unlike a vector structure, which stores coordinates explicitly, raster coordinates are contained in the ordering of the matrix. Groups of cells that share the same value represent geographic features. See also vector.

**raster band**
See raster dataset band.

**raster cell**
See cell.

**raster data model**
A representation of the world as a surface divided into a regular grid of cells. Raster models are useful for storing data that varies continuously, such as in an aerial photograph, a satellite image, a surface of chemical concentrations, or an elevation surface.

**raster dataset band**
One layer in a raster dataset that represents data values for a specific range in the electromagnetic spectrum, such as ultraviolet, blue, green, red, infrared, or radar, or other values derived by manipulating the original image bands. A raster dataset can contain more than one band. For example, satellite imagery commonly has multiple bands representing different wavelengths of energy from along the electromagnetic spectrum. See also band.

**raster model**
See raster data model.

**raster snapping**
See snapping.

**RDBMS**
Relational database management system. A type of database in which the data is organized across several tables. Tables are associated with each other through common fields. Data items can be recombined from different files. In contrast to other database structures, an RDBMS requires few assumptions about how data is related or how it will be extracted from the database.

**record**
1. A set of related data fields, often a row in a database, containing all the attribute values for a single entity. For example, in an address database, the fields, which together provide the address for a specific individual, comprise one record. In SQL terms, a record is analogous to a tuple.
2. A row in a table.

**relate**
An operation that establishes a temporary connection between records in two tables using an item common to both.

**relational database**
A method of structuring data as collections of tables that are logically associated to each other by shared attributes. Any data element can be found in a relation by knowing the name of the table, the attribute (column) name, and the value of the primary key. See also RDBMS, relate, key attributes, and relational join.

**relational database management system**
See RDBMS.
**relational join**
An operation by which two data tables are related through a common field, known as a key.

**relationship**
An association or link between two objects in a geodatabase. Relationships can exist between spatial objects—features in feature classes—nonspatial objects—rows in a table—or between spatial and nonspatial objects.

**relationship class**
Objects in a real-world system often have particular associations with other objects in the database. These kinds of associations between objects in the geodatabase are called relationships. Relationships can exist between spatial objects—features in feature classes—between nonspatial objects—rows in a table—or between spatial and nonspatial objects. While spatial objects are stored in the geodatabase in feature classes, and nonspatial objects are stored in object classes, relationships are stored in relationship classes.

**resolution**
1. The area represented by each cell or pixel in a raster.
2. The smallest spacing between two display elements, expressed as dots per inch, pixels per line, or lines per millimeter.
3. The detail with which a map depicts the location and shape of geographic features. The larger the map scale, the higher the possible resolution. As scale decreases, resolution diminishes and feature boundaries must be smoothed, simplified, or not shown at all—for example, small areas may have to be represented as points.

**row**
1. A record in an attribute table.
2. The horizontal dimension of a table composed of a set of columns containing one data item each.
3. A horizontal group of cells in a raster.

**scale**
The ratio or relationship between a distance or area on a map and on the corresponding distance or area on the ground, commonly expressed as a fraction or ratio. A map scale of 1/100,000 or 1:100,000 means that one unit of measure on the map equals 100,000 of the same unit on the earth.

**scalebar**
A map element that shows the map scale graphically.

**SDE**
Spatial Database Engine™ (SDE). A high-performance spatial database manager that employs a true client/server architecture to perform efficient spatial operations and manage large, shared, geographic datasets.

**server**
A computer in a network that is used to provide services, such as access to files or e-mail routing, to other computers in the network. Servers may also be used to host Web sites or applications which can be accessed remotely.

**service**
1. A collection of persistent, server-side software processes that provides data or computing resources for client applications. Examples include ArcSDE application server, ArcIMS application server, and DBMS server.
2. In Tracking Analyst, a real-time data stream accessed via a tracking connection.
**shapefile**
A vector data storage format for storing the location, shape, and attributes of geographic features. A shapefile is stored in a set of related files and contains one feature class.

**shortcut key**
A command’s shortcut key executes the command directly without first having to open and navigate a menu—for example, Ctrl + C is a well-known shortcut for copying a file in Windows.

**simple relationship**
A link or association between data sources that exist independently of each other.

**single precision**
Refers to a level of coordinate exactness based on the number of significant digits that can be stored for each coordinate. Single-precision numbers store up to seven significant digits for each coordinate, retaining a precision of ±5 meters in an extent of 1,000,000 meters. ArcInfo datasets can be stored as either single- or double-precision coordinates. See also double precision.

**single-coordinate precision**
See single precision.

**single-user geodatabase**
A personal geodatabase. It can handle a single editor and multiple readers.

**snapping**
An automatic editing operation in which points or features within a specified distance or tolerance of other points or features are moved to match or coincide exactly with each other’s coordinates.

**snapping tolerance**
In an ArcMap editing session, the distance within which the pointer or a feature will snap to another location. If the location being snapped to—vertex, boundary, midpoint, or connection—is within the distance you set, the pointer will automatically snap. For example, if you want to snap a power line to a utility pole and the snapping tolerance is set to 25 pixels, whenever the power line comes within a 25-pixel range of the pole it will automatically snap to it. Snapping tolerance can be measured using either map units or pixels.

**spatial data**
1. Information about the locations and shapes of geographic features and the relationships between them, usually stored as coordinates and topology.
2. Any data that can be mapped.

**SQL**
See Structured Query Language (SQL).

**Structured Query Language (SQL)**
A syntax for defining and manipulating data from a relational database. Developed by IBM in the 1970s, it has become an industry standard for query languages in most relational database management systems.

**stylesheet**
A file or form that provides style and layout information, such as margins, fonts, and alignment, for tagged content within an XML or HTML document. Stylesheets are frequently used to simplify XML and HTML document design, since one stylesheet may be applied to several documents. Transformational stylesheets may also contain code to transform the structure of an XML document and write its content into another document.
**subtype**
In a geodatabase, subtypes are used to break the features in a feature class into major categories. For example, the streets in a streets feature class could be categorized into three subtypes: local streets, collector streets, and arterial streets. Subtypes differentiate objects based on their rules. Default properties can be assigned to subtypes so that new features inherit the properties of their subtype. For example, a local street subtype might be defined so that whenever this type of street is added to the feature class its speed limit attribute is automatically set to fifty miles per hour.

**surface**
A geographic phenomenon represented as a set of continuous data, such as elevation or air temperature over an area, or the boundary between two distinct materials or processes. A clear or sharp break in values of the phenomenon (breaklines) indicates a significant change in the structure of the phenomenon, such as a cliff, not a change in geographic feature. Surfaces can be represented by models built from regularly or irregularly spaced sample points on the surface, or by contour lines, isolines, bathymetry, or the like.

**symbol**
A graphic representation of a geographic feature or feature class on a map. For example, line symbols represent arc features; marker symbols, points; shade symbols, polygons; and text symbols, annotation. Many characteristics define symbols including color, size, angle, and pattern.

**symbology**
The criteria used to determine symbols for the features in a layer. A characteristic of a feature may influence the size, color, and shape of the symbol used.

**table**
1. A set of data elements arranged in rows and columns. Each row represents an individual entity, record, or feature and each column represents a single field or attribute value. A table has a specified number of columns but can have any number of rows.
2. In ArcView GIS 3, one of the five types of documents that can be contained within a project file. A table stores attribute data.

**table of contents**
A list of data frames and layers on a map that show how the data is symbolized.

**tabular data**
Descriptive information, usually alphanumeric, that is stored in rows and columns in a database and can be linked to map features. See also table.

**TCP/IP**
Transmission Control Protocol (TCP). A communication protocol layered above the Internet Protocol (IP). These are a suite of nonproprietary communication protocols, or sets of rules, that allow computers to send and receive data over networks.

**template**
See map template.

**text box**
An entity that displays text entered by a user or derived from another source for editing purposes.

**thumbnail**
A snapshot describing the geographic data contained in a data source or layer, or a map layout. A thumbnail might provide an overview of all the features in a feature class or a detailed view of the features in, and the symbology of, a layer. Thumbnails are not
updated automatically; they will go out of date if features are added to a data source or if the symbology of a layer changes.

tic
Registration or geographic control points for a coverage representing known locations on the earth’s surface. Tics allow all coverage features to be recorded in a common coordinate system such as Universal Transverse Mercator (UTM). Tics are used to register map sheets when they are mounted on a digitizer. They are also used to transform the coordinates of a coverage—for example, from digitizer units (inches) to the appropriate values for a coordinate system (meters for UTM).

TIN
Triangulated irregular network. A vector data structure used to store and display surface models. A TIN partitions geographic space using a set of irregularly spaced data points, each of which has an x, y, and z value. These points are connected by edges into a set of contiguous, nonoverlapping triangles, creating a continuous surface that represents the terrain.

TIN dataset
A dataset containing a triangulated irregular network, a surface representation derived from irregularly spaced sample points and breaking features. The TIN dataset includes topological relationships between points and neighboring triangles.

TOC
See table of contents.

tolerance
A coverage has many processing tolerances—fuzzy, tic match, dangle length—and editing tolerances—weed, grain, edit distance, snap distance, and nodesnap distance. Stored in a TOL file, ArcInfo uses the tolerance values as defaults in many automation, editing, and processing operations. You can edit a coverage’s tolerances using its Properties dialog box in ArcCatalog.

tool
1. An entity in ArcGIS that performs specific geoprocessing tasks, such as clip, split, erase, or buffer. A tool can belong to any number of toolsets and/or toolboxes.

2. A command that requires interaction with the user interface before an action is performed. For example, with the Zoom In tool, you must click or draw a box over the geographic data or map before it is redrawn at a larger scale. Tools can be added to any toolbar.

toolbar
A set of commands that allow users to carry out related tasks. The main menu toolbar has a set of menu commands; other toolbars typically have buttons. Toolbars can float on the desktop in their own window, or may be docked at the top, bottom, or sides of the main window.

topology
1. In geodatabases, a set of governing rules applied to feature classes that explicitly define the spatial relationships that must exist between feature data.

2. The branch of geometry that deals with the properties of a figure that remain unchanged even when the figure is bent, stretched, or otherwise distorted.

3. In an ArcInfo coverage, the spatial relationships between connecting or adjacent features in a geographic data layer—for example, arcs, nodes, polygons, and points. Topological relationships are used for spatial modeling operations that do not require coordinate information.

4. The geometric relationships, determined mathematically, between connecting or adjacent features in a geographic dataset. Topology may include information about connectivity, direction,
length, adjacency, and polygon definition. Topology makes most types of geographic analysis possible because it allows analysis of spatial relationships between features.

**tuple**
A set of related values of attributes, often a table row, pertaining to a given item in a relational database. Analogous to a record in a table.

**UIControl**
A custom button, tool, text box, or combo box created with Visual Basic for Applications (VBA).

**undershoot**
An arc that does not extend far enough to intersect another arc. See also dangling arc.

**username**
The identification used for authentication when you log in to a geodatabase.

**VBA**
Visual Basic for Applications. The embedded programming environment for automating and customizing ESRI end-user applications, such as ArcMap and ArcCatalog. It offers the same powerful tools as Visual Basic (VB) in the context of an existing application and is the best option for customizing software that already meets most needs. By contrast, VB is a standalone tool for rapidly creating a special solution from scratch, be it an executable program, COM component, or an ActiveX control. An application that uses ArcMap or ArcCatalog may require the development of a COM component; consequently, in such instances, VB is the appropriate development environment.

**vector**
1. A coordinate-based data model that represents geographic features as points, lines, and polygons. Each point feature is represented as a single coordinate pair, while line and polygon features are represented as ordered lists of vertices. Attributes are associated with each feature, as opposed to a raster data model, which associates attributes with grid cells.
2. Any quantity that has both magnitude and direction.
See also raster.

**vector data model**
An abstraction of the real world in which spatial elements are represented in the form of points, lines, and polygons. These are geographically referenced to a coordinate system.

**vector model**
See vector data model.

**version**
In geodatabases, an alternative representation of the database that has an owner, a description, a permission—private, protected, or public—and a parent version. Versions are not affected by changes occurring in other versions of the database.

**view**
1. In ArcGIS, a way to see the contents of a selected item in the Catalog tree in ArcCatalog.
2. In ArcView GIS 3, one of the five types of documents that can be contained within a project file. A view is used for displaying, querying, and analyzing geographic themes. A view consists of a Table of Contents, which lists all the geographic themes contained in the view, and a map area on which geographic themes are displayed.
VPF feature class
See feature class.

W3C
See World Wide Web Consortium (W3C).

workspace
A container for file-based geographic data. A workspace can be a folder that contains shapefiles, an ArcInfo workspace that contains coverages, a personal geodatabase, or an ArcSDE geodatabase.

World Wide Web Consortium (W3C)
An organization that develops standards for the World Wide Web and promotes interoperability between Web technologies, such as browsers. Members from around the world contribute to standards for XML, XSL, HTML, and many other Web-based protocols.

eXtensible Markup Language (XML)
Developed by the World Wide Web Consortium (W3C), XML is a set of rules for designing text formats, designed to facilitate more standardized and structured documents. XML is a subset of the Standard Generalized Markup Language (SGML), the standard markup language for creating a digital document structure. XML is similar to HTML in that it uses markup symbols (tags) to encode information. But while HTML tells browsers how to display information on a Web page, XML defines values for the information. Also, users can create their own XML tags.

eXtensible Style Language (XSL)
A set of standards for defining XML document presentation and transformation. An XSL stylesheet may contain information about how to display tagged content in an XML document, such as font size, background color, and text alignment. An XSL stylesheet may also contain XSLT code that describes how to transform the tagged content in an XML document into an output document with another format. The World Wide Web Consortium (W3C) maintains the XSL standards. See also stylesheet, World Wide Web Consortium (W3C).

eXtensible Style Language Transformations (XSLT)
A language for transforming the tagged content in an XML document into an output document with another format. An XSL stylesheet contains the XSLT code that defines each transformation to be applied. Transforming a document requires the original XML document, an XSL document containing XSLT code, and an XSLT parser to execute the transformations. The World Wide Web Consortium (W3C) maintains the XSLT standard. See also stylesheet, eXtensible Style Language (XSL), World Wide Web Consortium (W3C).

XML
See eXtensible Markup Language (XML).

XPath
XML Path Language. XPath provides a way to address and match parts of an XML document and provides basic functions for manipulating values. Path notation, like the notation for defining a URL or the location of a file on disk, is used to navigate the hierarchical structure of an XML document and identify the part of the document that is of interest.

XSL
See eXtensible Style Language (XSL).

XSLT
See eXtensible Style Language Transformations (XSLT).
**zoom**
To enlarge and display greater detail of a portion of a geographic dataset.
Symbols

.rd files 231

A

Access keys 239, 243
defined 259
Active data frame 21
defined 259
Administrative and political boundaries as Content Theme 141
Agriculture and farming as Content Theme 141
AML 55, 259
Annotation 55, 56, 61, 62, 100
defined 259
Applications as Content Type 142
ARC Macro Language. See AML defined 259
ArcCatalog. See also Catalog tree editing metadata
with FGDC editor 144
with ISO editor 146
publishing metadata from 149
starting from ArcMap 38
from Windows 8, 38
status bar 39, 41, 243–244, 253
stopping 49
tabs 12, 39, 88, 100, 108
title bar 39, 41
views 12, 14, 18–19, 39, 88, 89, 100–102, 108, 279
window 39
ArcGIS Server administration 67
defined 67, 259
geocoding service 67
map image service 67
ArcGIS servers connecting 80
ArcID module 255
ArcIMS
ArcMap image service 66
feature service 66
image service 66
metadata service 66
ArcIMS server adding 78
ArcIMS servers connecting 79
ArcInfo Librarian 56, 73
defined 259
ArcMap. See also maps
data frame 21, 27, 263
data view 21, 263
layout 27, 269
layout view 27, 270
starting from ArcCatalog 166
table of contents 21, 21–22, 22, 32, 53, 167, 168, 277
using data in 4, 26, 162, 167
ArcMap image service 66
ArcSDE 40–41, 56, 65, 73–74, 275
ArcStorm database 56, 73
defined 260
ArcToolbox
tools in ArcCatalog 98, 238, 278
using data in 4, 162
Atmosphere climatology and meteorology as Content Theme 141
Attribute key defined 260
Attribute tables 55, 204–205, 210. See also feature attribute table
defined 260
Attributes adding 31, 118, 180, 204–205, 206
calculating defined values 31–33
defined 260
Attributes (continued)
deleting 31, 119, 181, 204–205, 208
indexing 182, 204–205, 209
modifying 204–205, 207

Authoring metadata
with FGDC editor 144
with ISO editor 146

Automation 251
defined 260

AUX 230
Auxiliary file 230

Band
defined 260

Bands
of rasters in a raster catalog 218

Batch mode operation 98
defined 260

Batch processing
defined 260

Batch table 98
defined 260

Biologic and ecologic
as Content Theme 141

Business and economic
as Content Theme 141

Buttons 234, 253
defined 260

CAD. See also data sources
dataset 61, 100
defined 261
drawing 61, 100, 261
feature classes 61, 100, 266
layer files 61

CAD feature dataset
defined 261

Cadastral and land planning
as Content Theme 141

Caption 239, 243, 245
defined 261

Cardinality 210, 211, 213
defined 261

Catalog tree
defined 8, 39, 40, 261
docking and undocking 43
hiding and showing 44
moving 43
refreshing its contents 40
resizing 39
selecting items in 9, 9–10, 40, 41, 164

CD–ROM 52, 72

Cell. See also raster: cell
defined 261

Clearinghouses
as Content Type 142

Color ramp 15
defined 261

Column. See also attributes
defined 261

COM 251, 254, 255, 261

Combo boxes 234, 253
defined 261

Commands. See also toolbars
access keys 239, 243, 259
adding
to ArcCatalog 254
to toolbars 238, 239, 240, 249
buttons 234, 253, 260
combo boxes 234, 253, 261
creating 251–252, 254
defined 234, 251, 262
edit boxes 234, 253, 265
events 234, 253, 265
menu items 234, 238, 240, 270
menus 234, 238, 239, 240, 243, 270
moving 241

Connecting
to ArcGIS servers 80
to ArcIMS servers 78, 79
to databases 56, 73–74, 74, 75, 76, 77
to folders 10, 10–11, 41, 52, 72
to GIS servers 77, 78

Connections
cutting a database 76

Content standard for digital geospatial
metadata 93, 136, 262, 271

Content Theme
categories
Administrative and political
boundaries 141

Agriculture and farming 141

Atmosphere, climatology, and
meteorology 141

Biologic and ecologic 141

Business and economic 141

Cadastral and land planning 141

Cultural, society, and demographic 141

Elevation and derived products 141

Environmental and conservation 141

Facilities and structures 141

Human health and disease 141

Imagery basemaps and land cover 141

Inland water resources 141
Content Theme (continued)
categories (continued)
Locations and geodetic networks 141
Military and intelligence 141
Oceans and estuaries 142
Transportation networks 142
Utility and communication networks 142
entering
in FGDC editor 145
in ISO editor 147
Content Type
categories
Applications 142
Clearinghouses 142
Downloadable Data 142
Geographic Activities 142
Geographic Services 142
Live Data and Maps 142
Map Files 142
Offline Data 142
Other Documents 142
Static Map Images 142
entering
in FGDC editor 146
Contents tab
defined 9, 12, 40, 88
Details view 13, 89
Individual Item view 14, 89
Large Icons view 12, 88
List view 13, 88
Overview tab 218
Selection tab 218
Thumbnails view 13, 89
Context menus 238, 240
Coordinate systems. See also items in ArcCatalog
coverages 192, 196–197, 198–199
defined 69, 184, 196, 262
geographic 69. See also latitude–longitude
managing 81
modifying a grid's 223
Coordinate systems (continued)
projected 69, 199. See also planar
coordinate systems
projection file 30, 69, 184, 190, 197, 273
raster dataset 223
rasters 185, 197
shapefiles 29–
30, 184, 185, 187, 188, 189, 190
TIN datasets 197
Coordinate Systems folder
defined 69
hiding and showing 11, 81
Coordinates
defined 262
geographic 267
projected 273
Coverage. See also data sources; VPF
adding attributes 204–205, 206
attribute tables 55, 192, 204–205, 260, 265
coordinate system 192, 196–197, 198–199
creating 192
defined 55, 262
deleting attributes 204–205, 208
extent 192, 200, 202
feature classes 55, 97, 192, 266
indexing attributes 204–205, 209
modifying attributes 204–205, 207
number of features 194
PC ARC/INFO 55, 272
pre-7.0 55, 272
precision 192, 194, 265, 272–273, 276
previewing 15, 100
relationship classes 55, 204, 210–211, 212–214, 275
tics 55, 192, 200, 201, 278
tolerances 194, 195, 203, 263, 267, 276, 278
topology 55, 192, 194, 195, 273, 278–279
units 203, 262
CSDGM 262
Cultural, society, and demographic
as Content Theme 141
Current record 17, 108
Custom
commands 251–252, 254
data sources 51, 93
metadata
editors 134
exporters 130
importers 130
D
Dangle length
defined 262
Dangle tolerance 194, 195
defined 263
Dangling arc
defined 263
overshoot 194, 272
undershoot 194, 279
Data
defined 263
geographic 267
spatial 276
tabular 277
Data frame 21, 27
defined 263
Data sources. See also items in ArcCatalog
converting to another format 98, 120
creating geographic from tabular 54, 121–122
custom 51, 93
defined 9, 51, 263
previewing 2–3, 14, 14–17, 17–18, 26, 100–102, 102, 108, 162, 220, 227
raster 216
Data type 33, 263
Database 73
defined 263
Database connections. See also items in ArcCatalog
connecting to and disconnecting from 76
creating 56, 73–74, 74, 75
database 73, 263
defined 9, 56, 57, 263
disconnected 52, 56, 76
IP address 73, 269
managing 56, 81
password 73–74, 272
port number 73, 272
server 73, 275
service 73, 275
username 73–74, 279
version 74, 279
Database Connections folder
defined 56
hiding and showing 11, 81
Database management system. See also RDBMS
Database management system (DBMS)
defined 263
Dataset. See data sources
defined 263
Datum 184, 199. See also coordinate systems
defined 264
DBASE tables. See also data sources
adding attributes 31, 180
creating 179
defined 54
deleting attributes 31, 181
indexing attributes 182
DBMS 264
Decimal degrees. See also latitude–longitude
defined 264
DEM 15, 58, 215, 264. See also raster
Destination 210, 212
defined 264
Details view
adding columns 93
changing columns 92
defined 89
moving columns 94
removing columns 94
resizing columns 90
sorting items 13, 91
Digital elevation model (DEM). See also DEM
defined 264
Digital terrain model (DTM)
defined 264
Digitize 200, 264
Digitizer 200
defined 264
Digitizing
defined 264
Directory 52. See also folders
defined 264
Disconnecting
from databases 76
from folders 11, 72
from GIS servers 77, 78
Disconnection
of a database 76
Disk 8, 52, 72
defined 265
Display type 243–244
defined 265
Documentation 18, 33–34, 132
defined 265
Double precision 192, 194
defined 265
Double-coordinate precision
defined 265
Downloadable Data 142
E
Edit boxes 234, 253
defined 265
Elevation and derived products
as Content Theme 141
Enclosures
adding 138–139
defined 265
saving to files 139
viewing 139
Environmental and conservation
as Content Theme 141
ERDAS IMAGINE files 230
Event location
defined 265
Events 234, 253
defined 265
Extensible Markup Language. See XML:
declared
Extensible Markup Language (XML)
declared 280
eXtensible Style Language (XSL)
declared 280
eXtensible Style Language Transformations (XSLT)
declared 280
Extensible Stylesheet Language. See XSL:
declared
Extent. See also minimum bounding rectangle
declared 192, 200, 265
of a raster dataset 216
setting 200, 202
F
Facilities and structures
as Content Theme 141
Feature attribute table 55, 192. See also attribute tables
defined 265
Feature classes. See also data sources
   CAD 61, 100
   coverage 55, 97, 192
   defined 266
   geodatabase 56, 57, 101
   previewing 15, 16, 100, 101
   VPF 62
Feature datasets 56, 57. See also data sources
   defined 266
Feature service 66
Feature services. See also Internet services
   creating metadata for 145
Features
   defined 266
Federal Geographic Data Committee. See FGDC
Federal Geographic Data Committee (FGDC)
   defined 266
FGDC 266. See also metadata
   Content Standard for Digital Geospatial Metadata 93, 136, 262
   Geospatial Data Clearinghouse 268
   metadata editor 33–34, 134, 135–136, 144
   NSDI 136, 271
   profiles 271
   stylesheet 124
   stylesheets 19–20
Field. See also attributes
Fields
   defined 266
File
   defined 52
File extensions 42, 52, 54, 55, 58, 84, 221, 222
File types. See also items in ArcCatalog
   adding to ArcCatalog 84
   defined 52, 54, 55, 266
   editing 85
   using registered 84, 85
Files
   defined 266
Geography view
creating thumbnails 24–25, 106
defined 14, 100
identifying 16, 105, 162, 268
panning 104, 272
stop drawing data 103
zooming 103, 104
Geometric networks 56, 57. See also data sources
defined 267
Geoprocessing defined 267
Geospatial Data Clearinghouse. See also NSDI defined 268
GIS 6, 268
GIS servers
connecting 78
connecting to and disconnecting from 77 defined 66
disconnected 78–79
managing 81
password 79, 80
URL 78
username 79, 80
GIS Servers folder
defined 66, 67
hiding and showing 81
GIS services
secure 66, 67, 79, 80
Graphs 53, 102. See also items in ArcCatalog
Grid cells
defined 268
Grid coordinate system
defining 223
Grids 58. See also raster defined 268
Group layers. See also items in ArcCatalog; layers
adding and removing layers 171
creating 171, 172
defined 53, 168–169, 268
previewing 16, 101–102
INFO tables (continued)
indexing attributes 209
modifying attributes 207
relationship classes 55, 210–211, 212–214, 275
Information
raster 216
Inland water resources
as Content Theme 141
Instance 268
International Standards Organization. See ISO
Internet servers. See also items in ArcCatalog
disconnected 52
password 272
username 279
Internet Servers folder
hiding and showing 11
Internet services. See also data sources
IP address 73
defined 269
ISO
defined 269
metadata editor 146
stylesheet 124
Item 269. See attributes; items in ArcCatalog
Items in ArcCatalog
copying 10, 97, 163
defined 9, 51, 269
deleting 97, 163
exploring 2, 9, 12–14, 40–42, 88–89
hiding and showing 11, 81
managing 4–5, 96
path 9–10, 40–41, 272
properties of item types 54, 82–83
renaming 10, 97
repairing 77, 174
selecting 9, 9–10, 40, 41, 164
sorting 13, 91
J
Joins 35, 174–175, 175, 176. See also relational join; relationship classes defined 269

K
Key 269
Key attributes 210, 269

L
Labels defined 269
Large Icons view 12, 88
Latitude–longitude 69. See also geographic coordinate systems defined 269
Layout view 27 defined 270
Librarian. See ArcInfo Librarian
Library 56, 62 defined 270
List view 13, 88
Live Data and Maps 142
Location combo box 9–10, 41, 72

Locations and geodetic networks as Content Theme 141

M
Macros adding to toolbars 249 creating 248, 253 defined 248–249, 270 editing 249 running 250 virus security 256
Map document defined 270
Map features 270
Map Files 142
Map image service 67
Map projection 270. See also projection
Map scale 270
Map template defined 270
Maps. See also items in ArcCatalog adding data to 21–22, 22, 26, 36, 162, 167 calculating attribute values 31–33 data frame 21, 27, 263 defined 53, 270 document 21, 53, 270 extent rectangles 27 graphs 53, 102 layout 27, 269 opening 21, 166 previewing 102 saving layers to files 22, 168 scale 275 scale bar 27 scalebar 275 table of contents 21, 22, 32, 53, 167, 168, 277 template 53, 270 zooming 27

Menu items access keys 239, 243, 259 adding to menus 238, 240 defined 234, 270
Menus access keys 239, 243, 259 adding commands to 238, 240 creating 239 defined 234, 270
Metadata elements defined 271
Metadata profile defined 271
Metadata service 66
Metadata Services
private documents 152
publishing 149
Metadata tab 12, 18–19. See also stylesheets
MetaIDChecker utility 143
Military and intelligence
as Content Theme 141
Minimum bounding rectangle. See also extent
defined 271
Multiuser geodatabase 56, 57
defined 271

N
National Spatial Data Infrastructure. See NSDI
National Spatial Data Infrastructure (NSDI)
defined 271
NSDI 136, 271. See also Geospatial Data
Clearinghouse

O
Object class. See also tables
defined 271
Object Linking and Embedding Database
provider. See OLE DB providers
Oceans and estuaries
as Content Theme 142
ODBC 75. See also OLE DB providers
Offline Data 142
OGC 271. See also OpenGIS
OLE DB providers 56, 75
defined 271
Online help. See Help
Open Database Communication. See ODBC
Open GIS Consortium. See OGC
OpenGIS 56, 75. See also OGC
Origin 210, 212
defined 271
Other Documents 142

P
Overshoot 194
defined 272
Overview tab 218
Owner 56

P
Pan 104
defined 272
Password 73–74, 79, 80
defined 272
defined 272
Path labels 210, 213
defined 272
PC ARC/INFO coverages 55
defined 272
Personal geodatabase 12, 56, 57, 96
defined 272
Pixel. See also raster: cell
raster data 215
Pixel types
defined 272
Pixels
defined 272
Planar coordinate systems. See also projected
coordinate systems
defined 272
Port number 73
defined 272
Pre-7.0 coverages 55
defined 272
Precision 192, 194, 265, 276
defined 272–273
Preliminary topology
defined 273
Preview tab
defined 12, 14, 100–102, 108
Geography view 14, 100
Table view 14, 108

Q
Query 53, 127, 210
defined 273
raster catalog 217
Query expression
defined 273
Querying
the geodatabase raster catalog 219
Raster. See also data sources
bands 58, 101, 274
catalogs 58, 101
cell 227, 274
coordinate systems 185, 197
dataset 58, 101, 274
defined 274
formats 58, 82, 83, 221, 222
information 216
model 274
previewing 15, 101, 220
pyramids 227, 273
Raster catalog
in a geodatabase 217
bands 218
Contents tab 218
geography 218
metadata 218
properties 218
querying 219
viewing 218
Raster data 215
auxiliary file 230
coordinate system 223
display resampling 231
extents 216
properties 216
spatial reference 216
statistics 216
Raster data model
defined 274
Raster dataset
calculating statistics 229
default band display 220
formats 221
statistics 229
statistics file storage 229
Raster dataset band
defined 274
Raster display
multiband 220
Raster model 274
Raster snapping
defined 274
Rasters
compressed 230
performance tuning 231
RDBMS 55, 56, 73–74, 75
defined 274
Read-only rasters 231
Record. See also row
defined 274
Red x 66, 67
Reduced Resolution Dataset
.rrd 227
Reference data 65
Relate 204, 210. See also relationship classes
defined 274
Relational database. See also RDBMS
defined 274
Relational database management
system 274. See RDBMS
Relational join. See also joins
defined 275
Relationship 56, 210
defined 275
Relationship classes. See also items in ArcCatalog
cardinality 210, 211, 213, 261
composite 211, 212, 262
coverage 55, 204, 210–211, 212–214
creating 212–214
defined 55, 210–211, 275
destination 210, 212, 264
foreign key 210, 214, 266
geodatabase 56, 57
key attributes 210, 269
origin 210, 212, 271
path labels 210, 213, 272
primary key 210, 214, 273
Relationship classes (continued)
simple 210–211, 212, 276
using 176
Resolution 227
defined 275
Route event 275
Row. See also record
defined 275
S
Scale
defined 275
Scalebar 27
defined 275
SDE. See also ArcSDE
defined 275
Search Results folder
defined 68
hiding and showing 11, 81
Searches
defined 4, 25–26, 68, 153
exploring the results 26, 162, 163, 164
managing 81
search criteria
data’s geographic location 156, 157
dates in metadata 158, 159, 160
item’s name 154
item’s storage location 154
item’s type 154
keywords in metadata 25–26, 161
looking in ArcCatalog 154
looking in the file system 154–155
redefining 155, 163
saving 155
starting a search 25–26, 155, 163
stopping a search 26, 155
Security 256
Selection tab 218
Server 73
defined 275
Shapefiles. See also data sources
adding attributes 31, 180
calculating attribute values 31–33
coordinate system 29–30, 184, 185, 187, 188, 189, 190
creating 178
defined 54, 276
deleting attributes 31, 181
indexing attributes 182
previewing 15, 100
spatial index 183
Shortcut keys
assigning 246
defined 246, 276
removing 247
resetting 247
Shortcuts 26, 68, 155, 162, 163, 164. See also items in ArcCatalog; searches
Simple relationship 210–211, 212
defined 276
Single precision 192, 194
defined 276
Single-coordinate precision 276
Single-user geodatabase 12, 56, 57
defined 276
Snapping 203
defined 276
Snapping tolerance 203
defined 276
Spatial data 276. See also geographic data
Spatial Database Engine. See SDE
Spatial reference 223
SQL 276
Static Map Images 142
Statistical data storage 230
Statistics
for raster data 216
grid 229
raster dataset 229
calculating 229
Status bar 39, 41, 243–244, 253
Structured Query Language. See SQL
Structured Query Language (SQL)
defined 276
Stylesheets. See also XSL
available 124, 127
changing 19–20
defined 276
FGDC 124
FGDC ESRI 124
Geography Network 125
ISO 124
setting the default 127
XML 125
Subtypes 101
defined 276
Surface 14
defined 277
Symbol
defined 277
Symbology 23, 35–36, 53, 100–102, 173
defined 277
T
Table of contents 21, 22, 32, 53, 167, 168
defined 277
Table view
adding columns 118
calculating statistics 113
current record 17, 108
defined 14, 108
deleting columns 119
display properties 109
exploring contents 17, 108
exporting records 120
finding values 116, 117
freezing columns 17, 18, 109–110, 112
indexed columns 108, 109
moving columns 18, 111, 112
refreshing values 108
Table view (continued)
resizing columns 17, 110
selecting columns 18, 115
sorting records
by many columns 18, 115
by one column 114
Tables. See also dBASE tables; Geodatabases:
tables; INFO tables; Table view; VPF:
tables
defined 277
raster catalogs 58, 101
using in maps 32
Tabular data. See also data sources; tables
defined 277
TCP/IP
defined 277
Template 277
Text boxes 277. See also edit boxes
Text files 54, 82. See also data sources
Thumbnails
creating 24–25, 100, 106
defined 14, 100, 277–278
viewing 2, 13, 14, 40, 89, 106
Thumbnails view 13, 89
Tics
adding 192, 200
defined 55, 200, 278
deleting 201
updating 201
TIFF
viewing file format 221
TIN. See also data sources
coordinate systems 197
datasets 278
defined 278
previewing 101
Title bar 39, 41
TOC 278
Tolerances
dangle 194, 195, 263
defined 203, 278
Tolerances (continued)
  fuzzy 195, 267
  setting 195, 203
  snapping 203, 276

Toolbars. See also commands
  adding commands 238, 239, 240, 249
  creating 236
  defined 234, 251, 278
  docking and undocking 43, 234
  grouping commands 243
  hiding and showing 235
  large icons 237
  moving 43, 234
  moving commands 241
  removing commands 241
  renaming 236
  resetting 238, 242
  resizing 235
  showing ToolTips 237

Tools
  ArcToolbox 98, 238
  batch mode operation 98, 260
  batch table 98, 260
  commands 234, 238, 253
  defined 279

ToolTip 45, 237, 243–244, 253

Topology
  coverages 192, 194, 195, 273
  defined 55, 278–279

Transportation networks
  as Content Theme 142

Tuple
  defined 279

U

UAI files 230
UIControls 251, 253
  defined 279
Uncompressed rasters 230

Undershoot 194
  defined 279

Universal Resource Locator. See URL

Unrestricted access image files 230

URL 78. See also Internet servers

User interface elements 234

Username 73–74, 79, 80
  defined 279

Utility and communication networks
  as Content Theme 142

V

Validation 140

VBA 248, 251, 254, 256
  defined 279

Vector 100
  defined 279

Vector data model
  defined 279

Vector model 279

Vector Product Format. See VPF

Version 74
  defined 279

Viewing a raster catalog 218

Views
  defined 39, 279
  Details view 13, 89
  Geography view 14, 100–102
  Individual Item view 14, 89
  Large Icons view 12, 88
  List view 13, 88
  Metadata view 18–19
  Table view 14, 108
  Thumbnails view 13, 89

Visual Basic for Applications. See VBA

VPF. See also data sources
  coverages 62
  database 62
  defined 62

VPF (continued)
  feature classes 62
  libraries 62
  previewing 100
  tables 62

W3C 280

Workspace 10, 193. See also folders
  defined 280

World Wide Web Consortium (W3C)
  defined 280

XML 280
  defined 18
  elements 93–94
  files. See also items in ArcCatalog
  metadata 64, 134
  stylesheet 125
  viewing 64, 124

XPath
  defined 280

XSL 18, 64, 280

XSLT 280

Z

Zoom
  defined 281
  in 27, 103
  out 103
  to the data’s full extent 104